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Welcome

Welcome to Aldus Persuasion-a comprehensive desktop presentations
program for use with Macintosh System 6 .0.5 or higher (version 7 .0 is
recommended) . This manual is intended for use with your Persuasion
program . For installation instructions, use the separate guide, Aldus
Persuasion Getting Started . If you are new to Persuasion or want to
review its exciting capabilities, we recommend that you work through
the two tutorial lessons, also in Getting Started.

The unique power of Persuasion comes from its ability to format your
slides automatically . It does this through the use of Persuasion
AutoTemplates which format text and data from an outline .

You'll find Persuasion to be an invaluable tool whether you're giving
a formal presentation to a large audience or you're reviewing ideas
during an informal discussion with co-workers . Whatever your situa-
tion, Persuasion provides you with the means to organize your ideas
and produce visual aids that get your message across . With the support
that Persuasion offers-professional-quality slides, overheads, hand-
outs, and speaker notes-you can deliver your presentation with more
confidence and ease than ever before .

Welcome to Aldus Persuasion ∎ 3
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Learning and using Persuasion
Aldus Persuasion is easy to learn and use, yet it gives you complete
flexibility and control to create sophisticated presentations . The docu-
mentation set contains :

•

	

The Aldus Persuasion Getting Started, consisting of installation
instructions and two tutorial sessions

•

	

The Aldus Persuasion User Manual, consisting of seven procedural
chapters that describe how to use Persuasion to create
your presentations

•

	

The Aldus Persuasion AutoTemplate Guide, a handy guide to
Persuasion's AutoTemplates

•

	

The Aldus Persuasion AutoTemplate Gallery Card, a card showing
a thumbnail illustration of each AutoTemplate

•

	

The A/c/us Persuasion Guide to Transferring Presentations, consist-
ing of procedures for transferring files between Persuasion for the
Macintosh and Persuasion 2 .1 for Windows

•

	

Persuasion Help, an online reference system that provides quick
access to information about Persuasion commands and procedures,
with cross-references to related topics

To learn Persuasion, you can take any of several approaches :

•

	

If you're a hands-on learner, start with "Learning Aldus
Persuasion" in Aldus Persuasion Getting Started . The first tutorial
session, Lesson 1, shows you how to create a simple presentation
and is very short ; Lesson 2 introduces you to more of Persuasion's
exciting features .

•

	

If you're an expert computer user and want a quick-entry route to
understanding Persuasion, work through the lessons in "Learning
Aldus Persuasion," and then use Persuasion's context-sensitive
online Help to navigate through the program . See instructions in
the next section for using Help .



[lieu'
VOutline

Above all, experiment . Persuasion is a powerful tool, easy enough to
allow you to learn the basics quickly, but powerful enough that simply
reading about it will never teach you all there is to know .

using Persuasion Heap
If you're in the middle of creating your presentation and need to jog
your memory about how to accomplish a task, Persuasion gives you
quick answers via Persuasion Help . You can use either context-sensi-
tive Help, or you can use the "Help . . ." command on the Apple menu .

To use context-sensitive Help :

1 . Press the Help key, or hold down the Command key and press the question

mark (?)key .

2. Position the question-mark cursor on the menu command, dialog box,

or area of the main Persuasion window for which you need information

and click .

Persuasion displays a screen of information specific to the area
you selected .

Welcome to Aldus Persuasion ∎ 5
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To go to Persuasion Help :

1 . Choose "Help . . ." from the Apple menu .

Z . Click one of the buttons on the right :

Aldus Persuasion 2.1

r

k

t

b
r

S

Using Help

Commands

Topics
. . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . .. . . .

Quit Help

Online

	

©1985-1992
Aldus Gcporauom .Help

	

All rights ~serred .

•

	

"Using Help" explains how to use the online reference system .

•

	

"Commands" displays an alphabetized list of commands from
which you can choose to learn more about commands and how
to fill in dialog boxes .

•

	

"Topics" displays a list of topics from which you can choose
to read either command or procedure help screens .

3. Double-click an item from the list, or click it and then click "Select ."

Persuasion displays the help information to the left of the buttons .
In addition, a More Help pop-up menu at the bottom of the window
provides additional information on related topics .

4. Choose another item from the More Help pop-up menu . Or, use the buttons

on the right to view other topics or commands .

5 . When you are finished, click "Quit Help" to return to your presentation .



Canadian English defaults
to "US Letter."

A note about terminology

Throughout the Persuasion program and documentation, the term
"slide" is used generically . It refers to the individual frames you work
with on the Macintosh screen, whether your final product will be 35mm
slides, overhead transparencies, an on-screen presentation, or printed
versions of your slides .

For a listing of terms used throughout the documentation, see the
Glossary at the end of this manual .

For International and Canadian English users

The U.S ., International English, and Canadian English versions of
Persuasion software come with the same editions of the printed and
online documentation . If you're using the International or Canadian
English versions of Persuasion, you may notice some differences
between the documentation and the software . The following sec-
tions describe the differences you'll see in those versions .

Dialog boxes
Defaults and measurement options in five of the International and
Canadian English dialog boxes differ from boxes shown in the
documentation .

LaserWriter Page Setup

	

5 2

Paper: Q US Letter
Q US Legal

Reduce or
Enlarge :

Orientation

I

100

® 114 Letter Q Tabloid
Q B5 Letter

%

	

Printer Effects :

International English defaults to "A4 Letter ."

•

	

Font Substitution?
® Text Smoothing?
•

	

Graphics Smoothing?
•

	

Faster Bitmap Printing?

OK

Cancel

Options

Help

Welcome to Aldus Persuasion ∎ 7



"Slide shape" and "Outline
margins" settings are in mm .

"Object shadow offset" is in mm .

"Major division units" are in cm;
the "Centimeters" option
appears first in the list .

"Width" and "Height" options
are in mm .
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I

Fractional character spacing :
® On (better for printings ',:I) Off (better for eHport)

Preferences

Default slide master :

	

Master 1

	

Cancel
Pointer in slide view : C) Normal R O Precision

Drawing options :

	

Show rulers

	

Show ruler lines
Custom rulers

	

Show page breaks
fl Hide big PI[ :Ts

	

Fine background fill
2 .0 Colors

Terrt shadow offset : ) Small C) Medium

Object shadow offset : 3 .00

	

mm down,

	

3.00

	

mm right

1v large

Arrow keys : ® Persuasion 1 .0 (1 Word processing

Custom rulers

--Major division units : ® Centimeters
C) Points/PiHels
C) Inches

Units per major division :

Increment numbers by :

Minor divisions per major division :

1

1

OK

8

Cancel

Round corners

Proportional resizing : C)' On ® Off
Width :

	

0mm C) 2mm C 4mm
Q 6mm CD 8mm C ) 1 Omm C=) Points :

Height : ® Same as widtho Omm 02mm Q 4mm
t) 6mm

	

8mm Q 10mm Cti' Points :

OK

Cancel

Presentation setup OK

slide Screen

	

CancelSlide shape : ) Overhead 0 35mm

( Custom : 253 .00 by 184 .84 mm

Outline

	

in
Page . . .

margins mm :

left 32 .8 Right 28.0

Top 24.6 Bottom 24.4

Handouts :

	

CT:' 1 Q 2 C 3 'I:' 4 ) 6 slides per page



Functionality
Several functional differences exist between the U .S ., the International
English, and the Canadian English versions of Persuasion . In the Inter-
national and Canadian English versions :

•

	

the spell checker uses the UK version of the Proximity/Merriam-
Webster Linguibase .

•

	

the title, subtitle, notes/text, and body/text/placeholder ruler mea-
surements are in centimeters .

•

	

the title, subtitle, notes/text, and body/text/placeholder tabs appear
at centimeter increments .

•

	

the currency symbol default depends on the system you're using .
For example, the Canadian system default is $, and the British
system default is £ .

•

	

the International English paper size default is "A4 Letter ;" the
Canadian English version defaults to "US Letter ."

Welcome to Aldus Persuasion ∎ 9





Chapter 1: Persuasion Basics





Chapter 1: Persuasion Basics

Persuasion

Aurora Presentation

If you have looked over the Introduction to "Learning Persuasion"
and worked through at least Lesson 1 in Aldus Persuasion Getting
Started, you're already familiar with the process of creating a presenta-
tion. This chapter deals with some of the basic tasks involved in work-
ing with Persuasion-starting Persuasion, beginning a presentation,
naming and saving a presentation, and quitting or closing Persuasion .

Starting Persuasion
You can start Persuasion in one of two ways :

•

	

From the Persuasion application at the Finder

•

	

From a document

•

	

To start the Persuasion application :

1 . Locate the Persuasion folder, and double-click to open it .

•

	

2. Double-click the Persuasion icon .

'

	

Persuasion's desktop appears, displaying the Persuasion start-up
~ r f

	

screen. You can now choose "0 en . . ." from the File menu to o enp

	

p
an existing presentation or AutoTemplate .

•

	

To open a Persuasion document :

1 . Locate the presentation or AutoTemplate file .

2. Double-click the icon (or name) of the file .

Either your presentation opens to the place where you were when
you last saved it, or an untitled copy of an AutoTemplate appears in
Outline view .

Chapter 1 : Persuasion Basics • 13
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Starting a presentation
Most of the time you'll create a presentation by opening a copy of an
AutoTemplate (a set of slide masters only) . Occasionally you will start
from scratch and create everything yourself-from the slide masters on .

You can begin a presentation in Persuasion in one of three ways :

•

	

Start with any existing AutoTemplate or presentation by choosing
"Open . . ." from the File menu . Then modify it to create the presenta-
tion you want .

•

	

Start with the default AutoTemplate file by choosing "New" from
the File menu . The AutoTemplate you selected during installation
as the default, if any, is stored in the System folder as "Persuasion
Prefs." (If you did not select a default AutoTemplate, choosing
"New" is the same as choosing Shift + "New" below .)

•

	

Start completely from scratch by pressing Shift as you choose
"New" from the File menu to override whatever is in the "Persua-
sion Prefs" file. This gives you a blank presentation containing
Persuasion's original application defaults, as listed in Appendix A
of this manual .

Once you have started your presentation, you may want to change its
medium. Although you may like the design of one AutoTemplate that
is set up for overheads, you may want to reformat it to produce 35mm
slides. In this case, you can have Persuasion automatically adjust the
design elements and other objects to reformat the AutoTemplate or
presentation before you add your contents .

File
New
Open .. . 8(;0
Close
Data sheet 1

Save s
Save as . . .
Revert

File
New ;#;N
Open . . . 0
Close
Data sheet 1

Save :S
Save as . . .
Revert



Starting a presentation from an A utoTemplate
To begin a presentation, you typically open a copy of an AutoTemplate,
unless you are starting a presentation from scratch . By opening a set of
slide masters, a number of details have already been decided for you,
such as slide size .

Every AutoTemplate is set up to create overheads, 35mm slides, or an
on-screen presentation . Refer to the Aldus Persuasion AutoTempiate
Guide for an overview of the AutoTemplates that come in the Persua-
sion package, and choose an AutoTemplate set up for the medium you
want .

Before you open the AutoTemplate you have chosen, make sure that
you have used the Choosey desk accessory to select an output device
appropriate to the medium . For example, you might choose a printer
for overheads or a film recorder for 35mm slides .

To create a presentation using an AutoTemplate :

1 . Select the output device in the Chooser that you'll use to produce

your presentation .

2 . Choose "Open . . ." (Command + 0) from the File menu .

3 . Locate the AutoTemp late you want to open in the AutoTemplates folder .

Open presentation

	

OK

Open :

• ob39
• oh 40
• ob41
• oh 42
• oh 43
• oh 44
• oh 45
• oh 46
• oh 47
0 ob4$ I
•

	

ob49

+v,' Original +i) [. opy

Cancel
. . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . .

Desktop

Hard Drive

This Ls a Ti& Flsr lds .

e

Show thumbnail

As you click an AutoTemplate name, a miniature of its default slide
master appears in the preview box if "Show thumbnail" is checked .

4. Double-click its icon or filename .

In a few seconds, an untitled copy (not the original) of the
AutoTemplate appears in Outline view .

Chapter 1: Persuasion Basics ∎ 15
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Starting from the default AutoTemplate
You open the default AutoTemplate when you choose "New" from
the File menu . AutoTemplate 0B37 was installed as the default
AutoTemplate during installation unless you specifically chose a dif-
ferent one. AutoTemplate 0B37 is a simple black-and-white design for
overheads . If you chose a different AutoTemplate as the default during
installation, you can find out whether it is set up for overheads, 35mm
slides, or on-screen presentations once you open it by choosing "Page
setup . . .," clicking "OK," and looking at "Slide shape" in the "Presen-
tation setup" dialog box .

Choosing "New" is similar, then, to choosing "Open . . .," except the
default AutoTemplate is already specified and opens automatically .

To create a presentation using the default AutoTemplate :

1 . Select the output device in the Chooser that you'll use to produce

your presentation .

2. Choose "New" (Command + N) from the File menu .

An untitled copy of the default AutoTemplate opens in
Outline view .

Starting a presentation from scratch
When you start a presentation from scratch-that is, without an
AutoTemplate-your first step is to create an AutoTemplate. You start
a blank presentation without slide masters by holding down Shift and
choosing "New" from the File menu . The entire process of creating
an AutoTemplate from scratch is described in Chapter 6, "Creating
Masters ."



Reformatting a presentation or AutoTemplate
When you find an AutoTemplate you like, but it is set up for a different
medium than you want, you can reformat it to the desired medium .
Persuasion will automatically adjust the design elements and text on
the masters to fit the new slide size .

Before you reformat a presentation, it's a good idea to understand how
changing the slide size changes the area you are working with .

To reformat a presentation and automatically adjust graphics
or text :

1 . Open the AutoTemplate or presentation whose slide size you want

to change .

2 . Choose "Page setup . . ." from the File menu, and then click "OK" in the

printer-specific dialog box .

The dialog box that appears is specific to the output device you've
selected in the Choosey .

3 . In the "Presentation setup" dialog box, choose the medium that you want :

Overhead, 35mm slide, or Screen, and then click "OK."

Fractional character spacing :

® On (better for printing) C) Off (better for enport)

Chapter 1 : Persuasion Basics ∎ 17

File
New 81 N
Open. . . 8B0
Close
Data sheet 1

Save
Save as . . .

Import . . .
Rut oTemp1ates . . .
[Hp0rt . . .

Presentation setup

	

OK
Page setup . . .
Print . . .

	

P
Slide show . . .

Slide shape : ® Overhead

C) Custom :
Q 35mm slide :? Screen Cancel

10 .14 by 7 .60 inches

Preferences . . .
Page . .

Outline margins in inches :

left 1 .17 Right 1 .15
Quit

Top 0 .97 Bottom 0.96

Handouts : C) 1 'D 2 C) 3 ® 4 t' 6 slides per page
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Adjust graphics

Page size of slides has changed .
OK 3

Cancel

Adjust graphics :
•

	

Slides

Options :
•

	

Moue objects
r Scale objects Q Scale teat sizes

Q Maintain aspect ratio

"Slides," "Notes and handouts," or both options are active
if affected by the format change .

5 . Click "Move objects" or "Scale objects" as desired .

"Move objects" causes all elements on the slide to be treated as a
unit and moves it to the center of the new slide shape . Objects and
text are not resized. If additional space is left around the edges of
the new slide, any background fill is extended to fit . However, if the
new slide size is smaller than the old one . objects that extend beyond
the boundaries of the new slide will be cropped when the slide
is produced.

"Screen" size

sirrr!!Itrr~r~

C

rrrrrkrr*aMrliri∎r!!rrrrrarffrrrrrrrr!!arrlr
•ar!

Cfr•

	

~ .

r

4 . Check "Slides" or "Notes and handouts" in the "Adjust graphics" dialog

box to have Persuasion automatically adjust graphics and/or text .

As soon as you check one or both of the "Adjust graphics" options,
the "Move objects" and "Scale objects" options become available .

"Move objects" moves all elements to the
center of the new slide shape, while the
background fill extends beyond the edge
of the smaller "Screen" size .



36 points

Original overhead

"Scale objects" provides two options : "Scale text sizes" and "Main-
tain aspect ratio ."

•

	

Check "Scale text sizes" to have Persuasion scale the text the
same percentage as the slide, then convert the scaled text to the
closest available point size displayed in the "Size" submenu from
the Text menu .

•

	

Check "Maintain aspect ratio" to have Persuasion scale all ele-
ments (including text bounding boxes) the same percentage as the
slide while maintaining the original aspect ratio (ratio of height to
width). Note that if you do not check the "Maintain aspect ratio"
option, elements will be scaled to the new aspect ratio of the
slide, which may cause some distortion .
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"Scale text sizes" scales the text to the closest
available font size . "Maintain aspect ratio" scales
elements proportionally from the "Overhead" size
to the smailer "Screen" size .

6 . Click "OK" to implement the changes you specified . Click "Cancel" to

close the dialog box without implementing any of the format changes you

specified in either the "Presentation setup" or "Adjust graphics"

dialog box .

Note : Changes you make to graphics or text using the "Adjust graph-
ics" dialog box cannot be undone . If you are not certain about the
results of the adjustment, click "Cancel" in the "Adjust graphics"
dialog box to cancel all format changes made in the "Presentation
setup" dialog box . Then save your presentation (Command + S)
before experimenting with adjusting the graphics and/or text . If
you don't like the changes, you can revert to the previously saved
version .
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Page setup . . .
Print . . .
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Slide show . . .
Preferences . . .

. . .
Quit
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Naming and saving a presentation
Persuasion has two commands for saving :

•

	

"Save as . . ." saves your document for the first time (or under a new
name) and gives you the opportunity to save your work as either a
presentation or an AutoTemplate . Technically, the only difference
between a presentation and an AutoTemplate is the way they auto-
matically open : double-clicking a presentation name opens the ori-
ginal; double-clicking an AutoTemplate name opens a copy of it .

•

	

"Save" (Command + S) saves further changes to your presentation
or AutoTemplate .

The very first action you should take upon creating a presentation or
AutoTemplate is to save it under its new name . This immediately ac-
complishes two things :

•

	

Your new file is distinguished from the old presentation or
AutoTemplate from which you started .

•

	

Your new filename is displayed in the title bar of the
Persuasion window .

To save your presentation for the first time or to rename it :

1 . Choose "Save as . . ." from the File menu .

2 . In the text box, type the new name for your presentation .

If you want to save your work as an AutoTemplate, consider using
"AutoTemplate," "AT," or other identifier in the name so that you
can recognize it as an AutoTemplate, and save it in the
AutoTemplates folder .

Save presentation as

	

OK

Persuasion Files i
EETf€ir istr€ ti€a€

." lns1 E E:t€3r ( is€ ~
ztt1 E31ir Ej
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rt€ I S~~I I E 1
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b

Untitled 1

Cancel
. . . . . . . . . . . . .. . . . . . .. . . . . . . . . . . . . . . . . . . ...

Desktop

o Hard Drive

Save as : Q Presentation

	

0AutoTemplate

0 Interchange File

File
New ~BN
Open . . . i1B0
Close
Data sheet 1



File
New
Open . . .
[10 se
Data sheet

. . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . .. . . . .. . . . . . . . . .. .
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, 5
Save as . . .

Import . . .
Export . . .

. . . .. . . . . . . . . . .. . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . .. . . . . . . . . .. .
Page setup . . .
Print . . .

	

BiiP
Slide show . . .
Preferences . . .

. . . . .. . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . .. . . . . . . . . .. . . . . . . . ..
Quit

Tip,

You can go back to working on
the last saved version of your
presentation at any time by
using "Revert" from the File
menu .

3 . Click "Presentation" to save your work as a presentation ; click

"AutoTemplate" to save it as an AutoTemplate . Then click "OK ."

The basic difference between a presentation and an AutoTemplate is
the way they open (as explained at the beginning of this section) .

To save your presentation any time during the working session :

Choose "Save" (Command +S) from the File menu .

Persuasion updates the presentation file on disk with any changes
you have made .

Closing
When you are ready to stop working on your presentation, you should
close it.

To close your presentation :

1 . Choose "Close" from the File menu . Or, click the close box in the upper-

left corner of the Persuasion window .

If you have not made changes since you last saved, Persuasion
closes the window .

2. If you have made changes, Persuasion asks whether to save the changes

before closing . Click "Yes," "No," or "Cancel ."

If you close the only open document, you will return to Persuasion's
desktop, where you can start a new document, open another, or quit
Persuasion. Otherwise, the window behind the one you closed becomes
the active window.
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Quitting

To leave Persuasion, use the "Quit" command

To quit Persuasion :

1 . Choose "Quit" (Command + Q) from the File menu .

If you have not made changes since you last saved, Persuasion re-
turns you to the Finder .

2 . If you have made changes, Persuasion asks whether to save the changes

before quitting . Click "Yes," "No," or "Cancel ."

Understanding default settings

Every presentation you open has a particular set of defaults . These
defaults may be either presentation defaults or application defaults :

•

	

Presentation defaults are any settings saved with a particular presen-
tation or AutoTemplate that you open by double-clicking its icon
or by choosing "Open . . ." from the File menu .

•

	

Application defaults are any settings saved in a presentation with the
specific name, "Persuasion Prefs," which you open by choosing
"New" from the File menu .

If the "Persuasion Prefs" file is removed or overridden (Shift + "New"),
the new presentation opens with the original application defaults . For a
list of these defaults, see Appendix A in this manual .

Tool defaults are different from either presentation defaults or applica-
tion defaults . Tool defaults are a collection of attributes for a particular
tool that override presentation defaults only as long as you are using
that tool . As soon as you select a different tool, the presentation de-
faults go back into effect .



Setting presentation defaults
Presentation defaults are settings that apply to a single presentation .
Presentation defaults include :

•

	

options you set using the "Preferences . . ." command .

•

	

options on menus and in dialog boxes that you set using the pointer
tool with nothing selected .

•

	

To set presentation defaults in the "Preferences" dialog box :

1 . Choose "Preferences . . ." from the File menu .

Preferences

Default slide master :

Pointer in slide view :

Drawing options :

TeHt shadow offset :

Object shadow offset :

Arrow kegs :

TeHt 1

•

	

Normal k a Precision

•

	

Show rulers Show ruler lines
•

	

Custom rulers ® Show page breaks

•

	

Hide big PICTS Fine background fill

•

	

2 .0 Colors

•

	

Small Q Medium

0 .125

0 large

inches down, 0 .125 inches right

OK

Cancel

•

	

Persuasion 1 .0 Q Word processing

2. Click the "Default slide master" pop-up menu to display a list of the mas-

ter slides in the presentation. Choose the one that you want to serve as the

basis for new slides you create . Or, choose "None" so that no master is

assigned automatically to the new slides .

You can also change the default master slide in Slide Sorter view .
For more information, see Chapter 2, "Outlining ."

Nnne

Preferences

	

Beckgrnund
Title background

Default slide master :

	

Title

Pointer in slide view :

	

TeHt 1

	

?cision
TeHt 2

Drawing options : Graphic 1
Org Chart
Graphic 2

TeHt shadow offset :

Object shadow offset :

Arrow keys :

® 2 .0 Colors

•

	

Small 0 Medium

10 .125

] Show ruler lines
] Show page breaks
] Fine background fill

0 large

inches down, 0 .125 inches right

OK

Cancel

•

	

Persuasion 1 .0 Q Word processing
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3 . For "Pointer in slide view," click "Normal" or "Precision ." "Precision"

gives you the pointer with crosshairs at the tip for more precise work

with objects .

4. Choose "Drawing options" to change Persuasion's drawing

environment :

•

	

Click "Show rulers" to display vertical and horizontal rulers in
Slide view .

•

	

Click to check "Show ruler lines" to display non-printing lines in
Slide view that correspond to the major divisions in the rulers .
(Major divisions are marked by a more finely dotted line than
the minor divisions .)

I . ..LLL1LJLJ.L1d.	.1.IJJJ.J

h

5

h

h

4

4

4

•

	

Click to check "Custom rulers" to display the "Custom rulers"
dialog box .

Custom rulers

Major division units :

	

Inches
Centimeters

C) Points ;''PiHels

Units per major division :

Increment numbers by :

1

1

Minor divisions per major division :

Con cel

- Number of units of measure
displayed between major
divisions on the rulers

-- Number of subdivisions
indicated on the rulers



• Click to check "Show page breaks" to display non-printing lines
that indicate how slides print as "tiles," or separately printed
pages, when enlargement is specified in the "Page setup"
dialog box .

Non-printing lines show where an enlarged slide "breaks" into
separately printed pages . This slide is enlarged to 200% as
specified in the "Page setup" dialog box .

•

	

Click to check "Hide big PICTS" to speed up screen display by
substituting a rectangle for a PICT . (See Chapter 3 for more
information .)

Persuasion displays a rectangle instead of a
PICT to speed up screen display .

•

	

Click to check "Fine background fill" to display smooth back
ground fills in Slide view . (This may affect performance .)

•

	

Click to check "2.0 Colors" to use the standard color grid from
Persuasion 2 .0. Certain colors in the standard grid have been
changed for Persuasion 2 .1 .
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5 . For "Text shadow offset," click "Small," "Medium," or "large" to specify

how far shadows are cast from text .

Clicking "Large" offsets the text shadow as specified in the "Object
shadow offset" option below .

L~r ges~aowoffset

Note : This setting only affects display and output to QuickDraw
devices (including film recorders) .

6 . In the "Object shadow offset" text boxes, type values to specify the dis-

tance shadows are cast from the bottom and right edges of objects .

Negative numbers shift the offset in the opposite direction .

Down .125 inches (3mm)
Right . 125 inches (3mm)



7 . For "Arrow keys," click "Persuasion 1 .0" or "Word processing" for the

way you want the arrow keys to operate :

The "Word processing" option also lets you extend a selection rather
than move the insertion point by holding down the Shift key while
you use the shortcuts .

8. Click "OK."

You can change these defaults at any time, and Persuasion will save the
preferences you select with the presentation .
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To moue "Persuasion 1 .0" "Word processing"

Insertion point one Right arrow Right arrow
character forward

Insertion point one Left arrow Left arrow
character backward

Insertion point one Not available Option + right arrow
word forward

Insertion point one Not available Option + left arrow
word backward

Insertion point to end Option + right arrow Command + right

of paragraph arrow

Insertion point to Option + left arrow Not available
beginning of paragraph

From Outline view to Command + left arrow Command + >
Slide view to Notes view

From Notes view to Command + right arrow Command + <
Slide view to Outline view
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To set other presentation defaults with the pointer tool :

1 . Select the pointer tool .

2 . With nothing selected, choose the menus and commands you want to

change, and then specify new default settings in the submenus or dialog

boxes that appear .

Remember, anything you choose will be saved with the presentation .

Setting application defaults in "Persuasion Prefs"
You can change the application defaults to suit your needs . To specify
your own application defaults for new presentations, you can create a
presentation with the settings you prefer and then save the presentation
as "Persuasion Prefs" in your System folder . The settings last saved in
"Persuasion Prefs" become the application defaults applied to new
presentations .

For example, if you prefer to begin by working directly on slides rather
than in the outline, you can save and then close the "Persuasion Prefs"
file from Slide view . As long as "Persuasion Prefs" is stored in the
System folder, new presentations will open in Slide view when you
start a new presentation .

If you override "Persuasion Prefs" (Shift + "New"), new presentations
open with the original application defaults in effect . See Appendix A
for a complete list of the original application defaults .

To change "Persuasion Prefs" :

1 . Open a new or existing presentation .

2 . Specify the menu and dialog box settings you want the presentation to

have as defaults that open when you choose "New ."

3 . Choose "Save as . . ." from the File menu .

4. Choose your hard drive . If your hard drive isn't listed, click the "Desktop"

(or "Drive") button until it is .

5 . Double-click the System Folder, and then double-click the Aldus folder .



R
A

0
0

S

e

T
f- Current tool default display

-Presentation tool default display

6 . In the text box, type Persuasion Prefs, choose "AutoTemplate" for the

"Save as . . ." option, and then click "OK."

Note : Spelling and spacing must be exact .

Replace existing
"Persuasion Prefs" ?

Yes L N O

7 . Click "Yes" in the "Replace" message box .

8. Close the presentation .

Until you change your "Persuasion Prefs" file, all files opened by
choosing "New" will have the settings just saved in "Persuasion Prefs ."

setting tool defaults
Setting tool defaults before you draw is simply an alternative to apply-
ing attributes later to a drawn object .

t To set a tool default :

1 . Select any drawing tool or the text tool .

The current tool defaults are displayed above the presentation
defaults at the bottom of the toolbox . At this point, before you
select other attributes, they are the same attributes as the
presentation defaults .

2 . Select from the Effect or Text menu the various attributes you want

the object created with the selected tool to have .
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You can easily reset the text

tool's attributes to match that

of a particular text block
(placeholder or independent
text) by clicking the text tool in

that text block . Then as you

continue to work with the text

tool, it will carry the same

attributes as that text block .

Like all other tool defaults, they

will be lost as soon as you

choose another tool .
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You can see at a glance in the toolbox what the presentation defaults
are for drawing tools and what their current tool defaults are . Until you
set temporary tool defaults, the current tool defaults appear to be the
same as the presentation defaults .

Fill pattern and color	

Line style, pattern, and color--

Horizontal line attributes ----

Vertical line attributes -

J

Current tool default display

Presentation tool default display
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Chapter 2: Outlining

You typically create a presentation in Persuasion by typing or import-
ing an outline into Outline view . You can also enter text directly on
slides in Slide view (text that will simultaneously flow back to the
outline) . You should work in the view that is most comfortable for you,
and be aware that each approach has its advantages and disadvantages .

Basically, it's a good idea to start your work in Outline view to estab-
lish a clear sense of your presentation's structure . Then move to Slide
view to adjust and enhance each slide in turn .

Understanding Outline view

In Persuasion, you create your slides by typing the text of your presen-
tation in outline form . You simply type your ideas as headings and
subheadings, using different indent levels exactly as you would in a
conventional outline . Each main heading becomes a slide title, signal-
ing a new slide . Each subheading becomes slide text, a subtitle, or part
of an organization chart on the slide . You can also type speaker notes
in the outline that flow to the speaker notes page for that slide .

How are outline headings transformed into slides? The answer, in a
word, is masters . A slide master is a model slide that contains the ele-
ments in the position, color, and alignment you want to appear on all
the slides to which you assign it . You can put graphic objects on slide
masters, but the most important, active ingredients on masters are
placeholders .
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Slide text

Text placeholder

Text on a slide
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Placeholders are the link between what's in the outline and what's on
a slide . A title placeholder, for example, contains instructions for
positioning and formatting the slide title that you typed in your outline .
Placeholders serve two purposes : they reserve places for titles, text,
charts, and organization charts on the slide, and they contain formatting
instructions, such as chart type or text attributes .

Outline

∎ ∎ ∎ ∎ ∎ I I I I I I ∎ ∎ ∎ ∎ ∎

This is a Title Placeholder.
This is a text placeholder .

Change the font and style for each level

Resize and reposition the box

Change tabs and indents

Slide master

∎ ∎ ∎ ∎ ∎ I I U I I I I ∎ ∎ ∎ ∎

U

Aurora

A Nee Kayaking Experience

U

Slide

_~ Lesson 1

	

~_
0 (Aurora New Product Presentation

I O Aurora

	

O
n A New Kayaking Experience

	

oz Aurora Kayaks

3

° Lightweightt but tough
° Mid-range in price
° A promising investment
Fabric Characteristics

s

° Light
° Strong
° Developed by WSR

II The New Line
I Price Performance

e

° Higher price than fiberglass
° Lower price than graphite
° Similar technological advantages

L~ Overall Performance
° Investment = $800,000
° NPV profits = $1 2 million
° Payback period = Two years



Holder of slides icon

Subtitle icon
Slide title icon
Slide text icon ----

Main notes icon -----
Notes text icon	

There are five types of headings in the Persuasion outline ;

•

	

Holder of slides-a heading that appears and is used only in Outline
view . Use it to organize your presentation into major sections or to
add comments to yourself or others who may use the presentation .

•

	

Slide title-a heading that Persuasion uses to generate an indivi-
dual slide in the presentation . Initially, all first-level headings are
slide titles .

•

	

Subtitle-a heading that contains text for a subtitle on a slide .

•

	

Slide text-the placeholder text on a slide, either bulleted points or
organization chart text. The text placeholder formats up to six head-
ing levels of slide text.

•

	

Notes-a heading that contains your notes for giving the presenta-
tion . You can print notes as part of the outline, or you can print a
speaker notes page for each slide .
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Entering the outline
You can enter the text of your presentation in Outline view . Simply
type your thoughts as they occur to you, indenting as you see fit .
Don't worry too much about structure-you can always come back
later and rearrange .

You can also import your outline from another source, such as a word
processor or other outlining application . For example, you may already
have your outline in a word-processing file used for a report or pro-
posal . You can import it, and then rearrange it into the various heading
levels that would be appropriate .

Typing the outline
when you open a copy of an AutoTemplate or start from scratch,
Persuasion displays an empty outline . The empty outline contains one
holder of slides and one empty slide title with the number "1" in the
left margin .

Untitled 1

9 0 Slide

Untitled presentation
O

Editing the holder of slides heading ("Untitled presentation") is optional .



0 Untitled presentation
O Aurora

O

Until

To type the outline :

1 . In the text box to the right of the slide icon, click an insertion point, and

then type text for the slide title .

2 . Press Return .

An empty slide title heading appears with a "2" in the margin .

3 . Follow these rules to continue typing your outline . Unless otherwise noted,
these rules assume your insertion point is at the end of the line .

To

Create a new heading at the same level

Move an empty heading one level lower (right)

	

Tab

Move an empty heading one level higher (left)

	

Shift +Tab

Delete an empty heading

To create a new heading

At the same level below a
selected heading

Do this

Press Command + Return, or choose
"New heading" from the Outline menu
(Command + H) .

Press

Return

Start a new line within the same heading

	

Shift + Return

Delete text left of the insertion point

	

Delete

Command +X

Demote (move right) a heading with the

	

Command + Tab
insertion point anywhere in it

Promote (move left) a heading with the

	

Command + Delete
insertion point anywhere in it

When the insertion point is anywhere in a heading, you can create
new heading levels by following these rules :

One level higher below the

	

Choose "New heading left" from the Outline
selected heading or its peers menu (Command + L) .

One level lower immediately

	

Choose "New heading right" from the Outline
below the selection menu

	

menu (Command +R) .
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Subtitle #12New headi

New headin 1? € s><€£
New heading right
Add notes

R
M

Hide body tent B
Hide notes F
Auto subtitles

Eupand all

Collapse all

Subtitle icon
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Creating a subtitle

In Outline view, there are two ways to create subtitles : manually and

automatically . For a subtitle to appear on a slide, a subtitle placeholder

must exist on the slide master assigned to that slide . AutoTemplates

AA through LL have subtitle placeholders on every slide master . For

more information about adding subtitle placeholders to a slide master,

see Chapter 6, "Creating Masters ."

•

	

To create a subtitle manually :

1 . Click an insertion point in the first body text heading below the slide title .

If the insertion point is positioned in any heading other than the

first body text heading, the "Subtitle" command on the submenu

will be dimmed .

Note : There may be a notes heading between the slide title and the

body text heading .

2 . Choose "Set heading as" from the Outline menu, then choose "Subtitle"

from the submenu .

The body text icon changes to a subtitle icon .

7
Aurora Pres

U O'reral1 F'erfurrriance

A FromiSi ny Investment
Irwestment = $a?OCa,COCi

•

	

PJF' ... prufits - $1 .~ mi11i 'ri
•

	

Fat bar_:k: penird =To years
•

	

i F'roiiuc:ti on Tern

The subtitle is located immediately below notes if there
are notes-otherwise, it's right below the slide title .

•

	

To create a subtitle automatically :

Choose "Auto subtitles" from the Outline menu .

Any new outline heading subsequently created in the position imme-

diately below a slide title (or its notes) is automatically a subtitle if

that slide's master already has a subtitle placeholder . If you assign a

new master, Persuasion determines whether or not that master has a

subtitle placeholder and converts outline headings accordingly . No

headings are changed when "Auto subtitles" is turned off .

Note: Automatic conversion does not apply to outline headings that

have been manually set using "Set heading as" or to nested slide

titles (a slide title located immediately subordinate to another

slide title) .



More about subtitles

If you drag a subtitle to another position in the outline, the subtitle loses

its subtitle status .

Like titles, subtitles consist of a single paragraph on a slide and a single

heading in the outline. Text headings subordinate to a subtitle will have

question marks for icons and will not appear on the slide until they are

moved to a non-subordinate position .

Aurora Prese

D Overall Performance
d A Promising Investment

? Investment - $800,000
? NPV profits - $1 .2 million
? Payback period . Two years

I

	

Production Team

Question marks indicate that subtitles cannot have subordinate text . If you drag the headings
with question marks to a non-subordinate position, their text will appear on the slide .

Adding notes

You can add notes directly to the outline . The notes do not appear on

your slides, of course, but can be printed either as part of the outline or

as separate notes pages, one for each slide. The notes pages are format-

ted by the notes master. For more information on the notes master, see

Chapter b, "Creating Masters ."
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Add notes

Hide body tent
Hide notes
Auto subtitles

Errpand all

Collapse all
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Tip :

To remove a single notes text
heading, position the cursor in
that heading, and then choose
"Cut" from the Edit menu
(Command + X) .

Notes text icons
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To add notes to the outline :

1 . In Outline view, click an insertion point in a slide title or any of its sub-

headings, and then choose "Add notes" from the Outline menu .

If the slide title has no notes, Persuasion places a main notes icon
and a notes text icon immediately below the slide title heading . If
the slide title already has notes, Persuasion adds a new, empty notes
text icon below the last one . The main notes icon is located at the
same level as the body text icons for that slide . You cannot drag or
select the main notes icon, but you can double-click it to expand or
collapse all its notes . All notes text icons for that slide are subordi-
nate to the slide's main notes icon .

z

s

Aurora Presentat

O Overall Ferformance

- Explain initial outla~~
e

2. Type notes text .

3 . Press Return to start a new notes text heading, or choose the "New head-

ing" command from the Outline menu (Command + H) .

To remove notes from the outline :

1 . In Outline view, select the slide title whose notes you want to remove .

The cursor must be positioned in the slide title ; for multiple slides,
the slide titles must be selected .

2 . Choose "Remove notes" from the Outline menu .

Persuasion removes all of the notes from the selected slide, or if
multiple slide title headings are selected, from all selected slides .

Describe sporting goods trend
`~ A Fromising Investment

im,'estrnent = $6OC',QC:'O
° NPV profits = $1 .2 million

Faybacl: period = Two years
FroductIon Team

Main notes icon

Outline
Set heading as

New heading 8~H
New heading left #'L
New heading right #'R



Working with notes in Outline view
If a slide has notes, the notes are always the first heading under the
slide title . You cannot drag any other outline heading to a position
between a slide title and its main notes icon . However, you can drag
any heading to a position between the main notes icon and any of its
notes text icons . Doing so converts that heading into notes text and
inserts it at that point .

7

8

7

s

Aurora Presentat

L1

O

n

Overall Perforrnarn:e
0

9 Explain initial outlay
Describe sporting goods trend

A Promising Irrdestment
Investment = $BC~Q,Q00
NF''d profit;, _ $1 . million
Fayback: period = T,vo years

p Production Teamn

0

Aurora Presentat

Overall Perforrriane:e
0

9 Explain initial outlay
Paybar_:k: period = Tic' years
Describe sporting goods trend

A Promisirig Investmerit
Investment = $OQQ , Qijr
NF'd profits = $1 .2 million

Production Team

9
0

You can drag body text to a position under the main
notes icon to make it notes text .

Similarly, dragging a notes text heading to a slide without notes
converts that notes text heading to a standard body text heading .

If you cut text from a note or any other heading, and then paste that
text elsewhere in the outline, the text will take on the status of the new
heading . For example, text cut from a note, then pasted into a slide
title becomes slide title text .
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Importing the outline
If you've prepared an outline in another word-processing application,
you can save it as a text-only file (ASCII) and import it to Persuasion .
Or, you can import an outline prepared in either Acta 2 .01 or MORE
1 .0, 1 .1, or l .lc. (Persuasion does not read MORE files from versions
1 .2 or higher .)

If your text-only file has tabbed indents from the left margin, or if you
are importing an Acta or MORE file, the outline levels will be retained
by Persuasion. However, because it is saved as a text-only file, other
formatting instructions, such as font, type size, or type style, are
not recognized .

Note : Use tabs, and not hard returns, to preserve indents and levels
within an imported text-only file . Persuasion translates hard returns as
a new heading .

To import an outline :

1 . In Outline view, click in the empty heading where you want the imported

outline to start .

If the insertion point is in a heading containing text, the imported
text begins a new heading . If the empty heading has subordinates,
the imported text begins immediately below the subordinate text .

2 . Choose "Import . . ." from the File menu .

Import

I Outline Files '

U New Presentation Tent
D Status teat
U Work outline

OK k

[anCel

Desktop

I' Hard Drive

3 . In the list box, select the name of the file you want to import .

4 . Click "OK."



Modifying the outline
Outlines are made to be modified in a variety of ways, from changing
the text within a heading to changing the location, type, or level of a
heading . Before you can modify the outline in any of these ways, you
need to select the text or heading you want to change .

Editing text in a heading
You can edit the text within a heading using standard Macintosh editing
commands and techniques to cut, copy, paste, insert, and replace .

To delete text :

1 . Double-click a word, or drag to select the text you want to delete .

4 The Ne v Line
Aurora I : Single, 30 lbs, 1?'
Aurora II : Double, 5f? 1b_, 22'

2 . Choose "Cut" (Command + X) or "Clear" (Delete) from the Edit menu .

If you plan to paste the text somewhere else, choose "Cut" to trans-
fer the text to the Clipboard .

•

	

To insert or replace text :

1 . Click where you want to add new text . To replace existing text, double-click

to select a word, or drag to select more than one .

2 . Type the new text, or choose "Paste" (Command +V) from the Edit menu

to insert from the Clipboard .
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Selecting headings
Before you can move or delete a heading or change its type or level,
you must select it. You can select a single heading, a range of headings,
or a variety of non-adjacent headings .

A rectangle surrounding the text block indicates that a single heading is
selected. When multiple headings are selected, a short vertical bar next
to the icon indicates that the heading is selected . The first selection in a
range is called the anchor and is identified by both the rectangle around
the text and the vertical bar next to its icon .

1

2

4

Aurora Prese
Aurora New Product Presentation

~~Aurora
•

	

I A New Kayaking Experience
~IAurora Kayaks

•

	

Lightweight but tough
I• Mid-range in price

° IA promising investment
Irabric Characteristics

Light
•

	

Strung
•

	

Developed by WSR
The New Line
•

	

Aurora I : Single, 30 lbs, 17'
•

	

Aurora II : Double, 50 lbs, 22'



To select

A single heading

To deselect

All headings but one

A single heading from

a selection

Do this

Click its icon or in its text .

Non-adjacent headings

	

Click an icon, hold down Shift, and then click
additional heading icons .

A range of adjacent headings

	

Click an icon at one end of the range (the an-
chor), hold down Shift + Option, and then click
the icon at the other end . Or, drag a box around
the icons of the headings you want to select .

A range of headings at a

	

Click an icon ; hold down the Shift, Option, and
certain level

	

Command keys ; and then click the same level
heading at the other end .

All the text in a heading

	

Click in a heading, and then choose "Select all"
(Command + A) from the Edit menu .

All the subordinate

	

Click in a heading, and then choose "Select all"
headings at one level

	

(Command +A) from the Edit menu twice .

All headings in the outline

	

Choose "Select all" (Command + A) from the
Edit menu successively .

Do this

Click in that heading .

To deselect a specific heading, you usually repeat the action that origi-
nally selected it .

Hold down Shift, and then click the icon for

that heading .

A range of headings

	

Hold down both Option and Shift, and then
beginning adjacent to

	

click an icon .
the anchor
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Cutting and pasting headings
You can delete any heading or any selection of headings you want from
the outline, therefore deleting an entire slide or selection of slides . The
hierarchy of all headings in a selection is maintained during cutting and
pasting. If you have explicitly set a heading's type (e .g ., slide title or
subtitle) using the "Set heading as" command from the Outline menu,
that heading will retain its setting no matter where it is pasted, as long
as the heading type is permissible for the location .

•

	

To delete a heading and its subordinates :

1 . Click anywhere in the heading to select it .

2. Choose "Cut" (Command + X) from the Edit menu . If you don't plan to

paste the heading and its subordinates somewhere else, choose "Clear"

(Delete) from the Edit menu .

Persuasion deletes the selected heading and any subordinate head-
ings, moving the insertion point to the heading above the one you
just deleted .

Note : Cutting a slide title heading presents an alert box to warn you that
the action of cutting " . . .will delete one or more graphics ." In other
words, cutting a slide title heading deletes the entire slide .

•

	

To delete a heading without its subordinates :

1 . Click anywhere in the heading to select it .

2. Hold down the Option key, and choose "Cut" (Command +X) or "Clear"

(Delete) from the Edit menu .

•

	

To paste a selection :

1 . Click in the heading located immediately above the place where you want

the selection from the Clipboard to ga .

2 . Choose "Paste" from the Edit menu (Command +V) .

After being cut to and pasted from the Clipboard, subordinate headings
are no longer selected .



Moving headings
As you review your outline, you may find you need to rearrange some
of the ideas on a slide, or even take an idea from one slide and move it
to another. Persuasion makes this easy for you-simply point and drag
the heading you want to move .

t To moue a heading to a new position :

1 . Point to the icon of the heading you want to moue, and then hold down the

mouse button .

As you hold down the mouse button, the pointer turns into a small
pointing hand .

2 . Drag the heading to its new position .

A small black bar appears as you drag across each valid
insertion point .

3. When the heading is where you want it, release the mouse button .

If you are dragging the heading to a different level, it may change its
type to reflect the new position . For example, if you drag a slide text
heading to the far left position, it becomes a slide title heading .

Remember that Persuasion always retains the relationships between the
selected heading and its subordinate headings, so that when you move
a heading, its group of subheadings moves along with it .

If you want to leave subheads behind, hold down the Option key and
then drag, cut, or copy a heading . Note, however, that you cannot leave
headings without an immediately superior heading . If you try to drag or
cut a heading that would result in this situation, Persuasion alerts you .

Invalid selection for option-drag .
Some subheads would be left
with no new parents .

OK
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Dragging a multiple selection
Dragging multiple headings to a new location causes the entire selec-
tion to be inserted at the new location. Again, the hierarchy of all head-
ings in the selection is maintained during dragging, but heading type
may not be. Unless you have set a heading's type (e.g ., slide title or
subtitle) using the "Set heading as" command from the Outline menu,
the heading changes to fit the location to which it is dragged .

1

z

3
4

I:'

Aurora Prese
o Aurora New Product Presentatian

~~ Aurora
° A New k.ayakang Experience

Lightweight but tough fabric
Mid-rarige ire price

_ ° A proniisirig irwestrnerit
~-~ Fabric Characteristics

Light
Strong
Developed bu 'rd :F

n fire Ne' r Line
I:JIPricc F'erfor-rna ri ce

~Hi ghier price than fiberglass
Lower price than graphite
Similar technological advantages

The entire selection-Slides 3, 4, and 5-will be inserted at
the horizontal black bar .

Changing heading levels
Once you've entered an outline, it's easy to raise or lower the heading
levels of individual headings or groups of headings. You can drag
headings to a different location to change the heading level, or you
can use the techniques below .

To change the level of an individual heading :

1 . Click anywhere in the heading to select it .

ro

11

II Interriational Appeal
Li Market Share

O Joe Grey Pres .
~' Joan White

•

	

Market Research
•

	

Adriin .
° ~Ari ne Brag,n

•

	

Firiance
K: en Bro rrri

	

k
Gesiqn

•

	

Tech_ Research
~~ New Dire_.tions



2 . Choose "Move left" (Command + [) or "Move right" (Command + ]) from

the Text menu .

O Joe Grey Fres .
° Joari ''hi te

•

	

f1ark:et Research
•

	

Admin .
k: en Brown
•

	

Design
Tech . Research

,nine Browri
Finan_.e

	

k
U New Directions

io

11

12

"Move left" changed the selected heading
and its subordinate heading to a slide .

"Move left" changes the selected heading to the next higher level in
the outline hierarchy for example, from a second-level heading to
a first-level heading .

"Move right" changes the current heading to the next lower level in
the outline hierarchy-for example, from a second-level heading to
a third level heading .

Note : When you change the level of an individual heading, any head-
ings subordinate to it are also shifted .

You can easily move a group of subheads to the left by using the "Pro-
mote subheads" command .

To promote a group of subheadings :

1 . Select the heading above the group of subheadings you want to promote .

De .eloprnent Rersonriel9

G Joe Grey, Dept . Head
G

G

G

loan White
Market Research R

•

	

Admin .
Anne Bro r'n
• Finance
Hen BrJ vri
° Design

Tech . Research

All items subordinate to the selected slide will be promoted .

Chapter 2: Outlining ∎ 49



50 ∎ Aldus Persuasion User Manual

2 . Choose "Promote subheads" from the Outline menu .

9

1

a

Ci Development Fersonnel
I• loe Grey, Dept . Head
_•

	

Ioori dhite
•

	

Mark:et Research k
•

	

Adrri iri .
•

	

Anne Brown
Finance

F' en Brown
Design

•

	

Tech . Research

Now Joan White, Anne Brown, and Ken Brown are all at the same level as Joe Grey .

Persuasion moves all the subheadings under the selected heading
one level to the left .

Changing heading type
You know how to type slide titles and text, and how to add notes and
subtitles . But you can easily change the heading type of any heading
with the "Set heading as" command . For example, you may want to
change the initial text heading under each title into subtitles .

To change heading types :

1 . Select the entry in your outline that you want to change .

The simplest way to select an entry is to click anywhere in the text
of that entry .

O Aurora
•

	

A Ne •v Kayaking E, perier i ce
L Fabric Characteristics

•

	

Light
strong

•

	

Developed by ' •/ SR
i~ The New Lirie

•

	

Ai.irora I : Sirigle, 30 lbs, 17' lerigth~
•

	

Aurora II : Double, 5Cr lbs, 22' length
Frice F'erformar,r_:e



Outline
Set headin! as
1' € € t€s ~}

. . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . .
New heading
New heading left
New heading right
Add notes
lig?€€~€3€3~? €1€3~4?S

. €311€ 13~£x 4€'1~'€ ; I(II

	

%: :

Slide title

	

€1
Subtitle
I3€~€4€~ ~$~f€t

	

` ;~

2. Choose "Set heading as" from the Outline menu, then choose "Holder of

slides," "Slide title," "Subtitle," or "Body text" from the submenu .

The options available depend on the type and location of the heading
you are trying to change . For example, body text can always be
changed to a slide title, but a body text heading immediately
under a slide title can also be changed to a subtitle .

3

a

O The New Line
4

Aurora II : Double, 50 lbs, 22' length
Price Performance

Nesting slides
If you have more information than can fit on one slide, you can break
it up into several slides quite easily . Nesting slides-that is, creating
subordinate slide titles-creates an overview slide with each of its
main points becoming the title of a separate slide .

To nest slides :

1 . Select the body text headings that you want to make into the titles of sepa-

rate slides .

Aurora I : Single, 30 lbs, 17' length

1 0 Aurora
A New Kayaking Experience

°IFabric Characteristics
•

	

Light
° Strong
•

	

Developed by WSR
•

	

I The New Line
•

	

Aurora 1 : Single, 30 lbs, 17' length
•

	

Aurora II : Double, 50 lbs, 22' length
•

	

Price Performance
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2 . Choose "Set heading as" from the Outline menu, and then choose "Slide

title" from the submenu .

O Aurore
A New Kayaking Experience

Fabric Characteristics
Light

° Strong
° Developed by WSR

Q~The New Line
° Aurora 1 : Single, 30 lbs, 17' length
° Aurora II : Double, 50 lbs, 22' length

pl Price Performance

1

2

3

4

The bulleted text items on this slide become the slide titles of the
three subsequent slides .



Collapsing and expanding the outline
When you're working on a long presentation, you may want to collapse
headings in Outline view to get a better idea of the overall organization
of your outline . Or, you may want to collapse headings so you can
easily rearrange them (and all they contain) by dragging them to new
locations . Or, you may want to collapse all but the slide titles and the
notes to create a presentation script .

You can collapse or hide headings by either clicking icons or
using commands .

Using the heading icon
The simplest way to collapse all of a heading's subordinates is to
double-click the icon for that heading . The resulting darkened icon
indicates that the heading contains collapsed headings . To open or
expand a collapsed heading, double-click its darkened icon .

1

2

3

4

a Aurora Kayaks
Aurora
•

	

A New Kayaking Experience
Aurora Kayaks
•

	

Lightweight but tough
•

	

Mid-range in price
° A promising investment

O Fabric Characteristics
Light
Strong

•

	

Developed by WSR
O The New Line

1
z
3

4

a Aurora Kayaks
Aurora

0 Aurora Kayaks
O Fabric. Characteristics

•

	

Light
•

	

Strong
Developed by WSR

O The New Line

If you double-click the darkened icon, the collapsed headings are displayed again .
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Using the lower-left icons
You can use the icons in the lower-left corner of your window to create
a presentation script of slide titles and notes by hiding all body text and
subtitles . Or, you can create a slide title sorter by hiding all text, sub-
titles, and notes .

The small icons at the lower-left corner of the screen indicate whether
or not notes or body text (including subtitles) are hidden . If an icon
is half-obscured, the part of the outline it represents is hidden . You
can toggle between the hidden state and the visible state by clicking
these small icons .

B Slide 2

To hide all body text and subtitles :

Click the body text icon in the lower-left corner of the window, or choose

"Hide body text" from the Outline menu .

Persuasion hides all body text and subtitles from view, leaving only
slide titles and notes text visible . When you give your presentation,
you can refer to this script for your notes about each slide .

To hide all notes :

Click the notes text icon in the lower-left corner of the window, or choose

"Hide notes text" from the Outline menu .

Persuasion hides all notes text, leaving slide titles, subtitles, and
slide text visible .



Using the Collapse and Expand commands
You can control the number of levels that are displayed in your
outline by using the various Collapse and Expand commands from
the Outline menu .

•

	

To collapse a heading or several levels of headings :

1 . Select the heading whose subheadings you want to collapse .

2 . Choose "Collapse selection" (Command + K) from the Outline menu .

A darkened icon to the left of a heading indicates that it has
been collapsed .

•

	

To expand a headinc

1 . Select the heading you want to expand .

2 . Choose "Expand selection" (Command + E) from the Outline menu .

All the immediately subordinate headings of the selected slide are
displayed, leaving all deeper levels of subheads collapsed or dis-
played as they were when the selected heading was collapsed .

Persuasion also gives you the choice of collapsing all text, notes, and
subtitle headings at once, which reduces the outline to slide titles only
for easy sorting .

•

	

To collapse all text, notes, and subtitle headings

Choose "Collapse all" from the Outline menu, or hold down Command and

double-click the holder of slides icon .

r iu uis

	

uir

Choose "Expand all" from the Outline menu, or hold down Option and

double-click the holder of slides icon .

An intermediate approach to collapsing the outline is to display the top
two levels, while hiding deeper levels .
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To collapse all subheadings except immediately subordinate ones :

Select a heading with two or more levels of subordinates, and choose

"Show subs only" from the Outline menu (Command + double-click

heading icon) .

"Show subs only" displays only the immediately subordinate head-
ings of the selected heading, hiding all deeper levels of subheads .
This works regardless of whether the selected headings are fully
collapsed or fully expanded .

To expand all subordinates for a selected heading :

Select the headings you want to expand, and choose "Expand subs" from

the Outline menu (Option + double-click the heading icon) .

"Expand subs" displays all the subordinate headings at every level .

Assigning slide masters
Once your outline is typed and organized, look at the resulting slides
and assign an appropriate slide master to each . You can assign slide
masters in Slide view, Slide Sorter view, or Outline view .

Because you're using an AutoTemplate, each slide in your outline
is linked automatically to a default slide master . For Persuasion's
AutoTemplates, the "Text 1" master is the default . If you create your
own AutoTemplate, the first slide master you create will be the default .
You can change the default slide master in any AutoTemplate .



Changing the default slide master
Frequently, one slide format is appropriate for most of the slides in the
presentation. For example, if your presentation is mostly text, you can
use an all-text master as the default master . For a presentation with
mostly charts, you may prefer a chart master as the default .

To change the default slide master :

1 . Choose "Preferences . . ." from the File menu .

Preferences

Default slide master :

Pointer in slide uiew :

Drawing options :

Tent shadow offset :

Object shadow offset :

Arrow keys :

Text 1

( Normal k Q Precision

•

	

Show rulers Show ruler lines
LI Custom rulers ® Show page breaks
0 Hide big PICTS 0 Fine background fill
•

	

2 .0 Colors

•

	

Small Q Medium

0 .125

C) Large

inches down, 0 .125 inches right

OK

Cancel

•

	

Persuasion 1 .0 C) Word processing

2. Click "Default slide master," and then choose the master you want as the

default from the pop-up menu .

Persuasion uses this new default slide master to format any new
slides you create, as well as any existing slide that you have not
already printed or viewed in Slide, Slide Sorter, or Notes view, as
well as in the slide show . The new default master will not be as-
signed to any slide to which you have already assigned a master.
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Assigning masters in Outline view
When you are familiar with the slide masters in the AutoTemplate that
you're using, and you're clear about the purpose of the individual slides
in your presentation, you can assign slide masters in Outline view using
the Master pop-up menu in the lower menu bar .

Working entirely in Outline view is a speedy way to create a presenta-
tion. But if you need to look at your slides to decide which slide mas-
ters to assign to them, use the Slide view and Slide Sorter view options .

To assign slide masters from Outline view :

1 . Click anywhere in the text or title of the slide to which you are assigning a

slide master .

2. Choose the slide master you want from the Master pop-up menu in the

lower menu bar .

Aurora Presentation
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Adding an organization chart
You can turn any slide text into an organization chart by assigning the
Org Chart master to it . Adding an organization chart can be an effective
way to enhance your presentation by giving the audience an overview
of the structure of your company or by illustrating the proposed distri-
bution network for a new product .

You add an organization chart in Persuasion by typing the information
in the outline . An organization chart slide master links the levels in the
outline directly to the levels of the chart . You can have a maximum of
10 levels :

•

	

The first-level heading is the title of the organization chart slide .
The title will be formatted by Persuasion, just as any other title in
your presentation .

•

	

The second-level heading represents the top level in your organiza-
tion chart .

•

	

Headings on subsequent levels represent the lower levels of your
organization chart. The number of headings per level, as well as
the number of levels, is limited primarily by what looks good on
the slide .

To add an organization chart :

1 . Create a new slide title, and type the title of your organization chart .

2 . Type the levels of your organization chart as headings and subordinate

headings .

Since your organization chart starts with one box at the top, you
should only have one second-level heading . Other than that, all other
rules for entering, modifying, and rearranging text in general apply
to organization chart text .

9 Development Personnel
,Joe Grey Fres .
°

0

0

Joan White
•

	

Market Research
Adrnin .

Anne 5r':' n
•

	

Finance
I erg Ernwn

° Desigri
Tech . Research

Outline view of an organization chart
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3 . Choose "Org Chart" from the Master pop-up menu in the lower menu bar

to assign a slide master containing an organization chart placeholder .

Slide view of an organization chart

Using the slide sorter
Slide Sorter view is a graphic representation of your outline . Miniature
versions of all your slides are displayed in one window-much like a
light table for viewing slides . Any changes you make in the slide sorter
are reflected in the outline . The correspondence between the outline
and the slide sorter is emphasized in the shortcut for going to Slide
Sorter view : Hold down Option and click the Outline view icon at the
upper-right edge of the window .

The slide sorter is primarily useful for rearranging slides and assign-
ing masters, although you can also apply transition effects there . For
information on applying transition effects, see Chapter 7, "Producing
a Presentation ."

Rearranging slides
Just as you can select and drag headings in the outline, you can select
and drag slides in the slide sorter . Each selected slide has handles . You
select a slide in the slide sorter by clicking it . To select more than one
slide, hold down Shift and click the additional slides you want, or drag
a selection box around the slides you want to select .



Sorter
,/Normal size
66''. normal
33% normal
20%4 normal

. . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Nested slides -

To rearrange slides in the slide sorter :

1 . Choose "Slide sorter" from the View menu . Or, press Option and click the

Outline icon in the upper-right corner .

In the slide sorter, nested slides are slightly offset .

2 . If you want, change the number of slides you can see on your screen by

choosing an option from the Sorter menu in the upper menu bar "Nor-

mal," "66%," "33%," or

By reducing the size of the slides, you can display more of them
on the screen. The number of slides displayed on your screen also
depends on your monitor, as well as the orientation of your slides
(wide or tall) .
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3. Select one or more slides that you want to move .

4 . Press the mouse button and drag until the vertical bar is where you want to

insert the slides .

Slide r

	

Te:yt 1

	

Tr .~ri_itian

The vertical bar appears only where it's valid to insert the selected slide .

5. Release the mouse button to place the slides in the new position .

Persuasion rearranges the slides, maintaining subordinate relationships
as defined in the outline . When you select several slides at once (con-
secutively or not) and drag them to a new place, they are inserted
together in their original order . For example, selecting Slides 2, 5, and
9 (hold down Shift) and putting them after Slide 4 gives a new order
of l, 3, 4, 2, 5, 9, 6, 7, 8, lo, except the slides are now numbered
consecutively .



v/asrer pc : up menu

If you choose a slide master
from the Master pop-up menu
when no slide is selected, you
change the default master for

subsequent slides . Existing
slide master assignments do
not change .

Assigning masters in Slide sorter view
In Slide Sorter view, you can change slide master assignments for
several slides at once .

To assign a slide master in Slide Sorter view :

1 . Select the slides to which you want to assign a new slide master .

Point and click to select a single slide ; hold down the Shift key as
you click to select additional slides, or drag to select adjacent slides .

2 . Choose the slide master you want from the Master pop-up menu in the

lower menu bar .

The "Title" slide master was chosen to format this multiple selection of slides .
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Formatting the outline
Since there may be times when you want to print and distribute your
outline, Persuasion lets you format the outline text either by defining a
new style for a particular heading level, or by applying text attributes
locally (to a range of characters or to a multiple-heading selection) .

Persuasion outlines have text styles predefined for 15 levels of outline
headings . All 15 styles are preset to the same font, size, and style .

Applying text attributes by heading level
Styles are applied to outline text by level . That is, when you apply a
text attribute (other than superscript or subscript) to a certain outline
heading using the "Outline styles . . ." command, all other headings at
the same level take on the same formatting . Notes text is an exception
to this rule: you define a single style for all notes text, regardless
of level .

Text formatting applied to the outline is not transferred to the asso-
ciated slides . For example, you could format all slide titles in your
outline to be Helvetica Italic, but the titles that appear on the slides
themselves will appear in whatever font and style you applied on the
slide master placeholder or to the text on the slide itself . Superscripts
and subscripts, however, do transfer from outline to slide,
and vice versa .



Tetrt
Font 1
Size 1
Style 1
Color 1
>Ii

	

r r fz

	

9

Tent format . . . ~€T

Reapply style

	

O

Outline styles . . .
Define formats . . .

Tip :

In Outline view, select one or
more headings, and then hold

down Option while you choose

a text attribute from the Text

menu. Persuasion applies the

text attribute to all headings at
the same level as the selected
headings, and that attribute

becomes part of the defined

outline style for the selected

levels .

To define a text style for outline headings :

1 . In Outline view, select a heading at the level for which you want to define

a style .

2 . Choose "Outline styles . . ." from the Text menu .

Define outline styles for selected levels

font :

Size :

[trample :

Geneva

12

Style : 0 Plain
Bold

Color : Black

Q Italic

	

Q Outline
Underline Q Shadow

The quick brown fox ._ .

Cancel

- Sample box

3 . In the dialog box, choose the font, size, color, and style that you want to

apply to the heading level you've selected .

The sample box displays some text with the font attributes you've
specified, so you can see how the text will look when you apply
the style .

4 . Click "OK" to apply the style you've defined .

Persuasion applies the text attributes to all headings at the same
level as the selected headings . Text attributes that are applied
locally will be retained .

I
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Applying text attributes locally
When you select text in an outline, you can apply any text attributes by
selecting font, size, and so on, from the Text menu . Text attributes that
are applied locally affect only the selected text .

When a heading with locally applied text attributes is dragged to a new
position in the outline, the local text attributes are retained, but all other
attributes in that heading are altered to reflect the style of the new head-
ing level. (This is also true of cutting and pasting .)

Reapplying styles
The effect of the "Reapply style" command in the Text menu depends
upon what is selected :

•

	

If a section of text is highlighted within a single heading, the text
style for that heading level is reapplied to the selected text only .

•

	

If no text is highlighted but an insertion point is clicked, new text
typed after the "Reapply styles . . ." command will assume the style
of that heading level .

•

	

If multiple headings are selected, the text style is reapplied to all
selected headings .

Applying a style to notes text in Outline view
You can change the default text style for outline notes by using the
"Outline styles . . ." command on the Text menu (or the keyboard short-
cut-hold down the Option key while selecting the text attribute) . If
you define a text style for outline notes text, that style applies to all
notes in the outline regardless of heading level .



Using Find/Change

Persuasion lets you search for and replace words in all parts of a pre-
sentation: slides, notes, outline, or any combination. Any changes made
in your outline will automatically flow to your slides, and any changes
made in text on your slides formatted by placeholders will flow to
your outline .

To find and replace a word :

1 . Choose "Find/Change . . ." (Command +5) from the Edit menu .

Find/Change

Find :

Change to :

Search : Outline ® Slides fl Notes
RII slides/notes

	

C) Current only

Cancel
. . . . . . . . . .. . . . . . . . . . . . . . . . . . .

Q Whole words Q Match case

2 . In the "Find" text box, type the word you want to find .

3 . In the "Change to" text box, type its replacement .

4. Check whether you want to search for only whole words and whether you

want to search for words that have the same upper- and lowercase letters .

5. Select the parts of your presentation you want to search .

Your choices are outline, slides, notes, all slides and notes, current
selection only, or any combination .
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6. Click "Find" to search for the first occurrence and highlight it, so that you

can type over or change it. Or, click "Change all" to search for and change

all occurrences .

If you chose "Find" from the dialog box, you can then choose from
several options in the Edit menu to continue to find and change
occurrences of the word :

To

Find the next occurrence

Choose

"Find again" (Command + 6)

Change the current occurrence "Change" (Command + 7)

Change the current occurrence "Change then find" (Command + 8)

and find the next

Using the spell checker
You can use Persuasion's built-in spell checker to find and correct
misspelled words in any part of your presentation-even in charts and
tables . Persuasion checks for misspellings and provides a list of
suggested corrections .

To check the spelling in your presentation :

1 . Choose "Spelling . . ." (Command +9) from the Edit menu .

If you have moved the Persuasion dictionaries folder to any location
other than the Aldus folder within the System Folder, Persuasion
will ask you to locate Webster .lex or CollinsUK .lex when you use
the spell checker .

2. Check which part of your presentation you want to search for misspellings .

Your choices are outline, slides, notes, all slides and notes, current
selection only, or any combination .



3 . Click "Start" to begin spell checking .

Spelling

Unknown:

	

Kayaking

Change to :

Suggestions :

Kicking

Kicking
Caking
Calking
Caddying

1

ignored

Close

Change

Add . . .

Search : ® Outline ® Slides EJ Notes
0 All slides/notes Q Current only

4. Change or ignore the unknown word, or add it to your user dictionary :

To

Change the word

Do this

Enter a correction in the "Change to" text box . Or,
select the word you want in the "Suggestions"
box, and then click the "Change" button .

Leave the word as is

	

Click the "Ignore" button .

Add the word to the

	

Click the "Add . . ." button . In the "Add word to
user dictionary

	

user dictionary" dialog box, choose the options
you want .

Note : Persuasion's user dictionary does not allow you to make cor-
rections to existing words in it . Be sure to keep a backup copy of
your user dictionary. If you type a word incorrectly, you can replace
the current dictionary with an earlier version .

5. Repeat Step 4 for each word that Persuasion indicates as "Unknown ."

6. Continue through the various parts of your presentation until your check

is complete . If you want to stop the spell check at any point, click the

"Close" button .
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Exporting an outline
You can export your entire outline or any selected portion of it in Per-
suasion . You can also export one or all of your slides .

To export an outline :

1 . If you want to export only a portion of your outline, select the portion you

want to export .

2. Choose "Export . . ." from the File menu .

[Hport

	Soles Presentation "I

Sales outline

Export :

® Outline

	

QOutline selection
CJ All slides

	

€ ;

	

xr i

® i< €c€,fir€} € € P€II

	

I ilfi~ 0 I x ; tx F €al€3 r5

OKk

Cancel

TENT

Desktop

o Hard Drive

Format :

3 . To export the entire outline regardless of the selection, click "Outline ." To

export only the currently selected headings and their subordinates, click

"Outline selection ."

4. In the text box, type a name for your saved outline .

Make sure the format you've selected is appropriate .

5. Click "OK ."

Your outline is exported as a text-only file and saved under the
filename you typed .
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Chapter 3: Working on Slides

Although you can create your presentation in Slide view, you usually
turn to Slide view when you are ready to work on the graphic aspect
of your presentation. Once you have formatted a slide by assigning
the appropriate slide master, you can add to or change anything you
want on the slide-even the attributes and formatting provided by
the placeholders .

When you work on slides, you are basically working with objects .
Objects can be text blocks, drawings, charts, tables, or imported
graphics . Once you create or import these objects, you can format
them, manipulate them, and enhance them in a variety of ways .
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Assigning slide masters in Slide view
In Slide view, you can change slide master assignments one slide at a
time from the Master pop-up menu in the lower menu bar . Changing
the slide master assignment reformats your slide according to the
design attributes of the slide master .

To assign a slide master in Slide view :

1 . Display the slide whose master you want to change .

2. Choose the slide master you want from the Master pop-up menu in the

lower menu bar .

D

Aurora Presentation

s

Slide

Gall erg . . .
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . .. . . . . . . . . . . . . . . .
None
Background
flIr

'Teet 1
Teat 2
Graphic 1
Org Chart
Graphic. 2.... . . .... . ... . . . . . . . . .... . . . .... .
A4s1gn mrfpr #n 51ide

Price Performance

I

Higher price than fiberglass

Lower price than~xaphite

rr technological advantages

er- 1

5

You can also assign masters using the "Gallery . . ." command on the
Master pop-up menu in the lower menu bar . "Gallery . . ." lets you
preview your slide with different masters assigned before you make
a selection .



Gallery

None
Berkgrnund
Title berkgrnund
Title

/Text 1
Text 2
Graphic 1
Org [:hart
Graphic 2. . . . . . . . . . . . .. . . . . . .. . . . . . . . . .. . . . . .. . . ... . . . . . . . .. . . . . . ... . . .. . .
(Assign master to slide

r To assign a slide master using "Gallery . . ." :

1 . Display the slide whose master you want to change .

2. Choose "Gallery . . ." from the Master pop-up menu in the lower menu bar .

Sample box

3. Choose the slide master you want to assign from the pop-up menu in the

"Master" box .

In the sample box, Persuasion displays a miniature of the slide,
formatted according to the slide master's design attributes . Repeat
Step 3 to preview master formats until you find the one you want
to assign to your slide .

4. Click "OK ."
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Adding text to slides
You can type text directly onto slides . In this section, you'll learn how
to add two types of text to slides : placeholder text and independent text .
Placeholder text is typed within the boundaries of a placeholder's con-
trol ; independent text is typed outside the control of a placeholder .
Placeholder text appears in the outline, and independent text does not .

Typing new text on slides
In Persuasion, you can add text to your slides in one of two ways :

•

	

As slide title, subtitle, or body text controlled by a placeholder .
This text flows back to your outline .

•

	

As an additional text block independent of a placeholder, such as
a callous to a chart or a label on a graphic . This text does not flow
back to your outline .

A slide title is placeholder text that flows to the outline ; an independent text block
does not flow to the outline .

ndependent
ext block



t To add placeholder text :

With the text tool, select the text governed by the title, subtitle, or body text

placeholder and replace it with your own text .

Dummy placeholder text appears on all new slides so that you can replace it with
your own title, subtitle, or body text .

Before you type independent text, you can give the text tool attributes
that will be applied to the text you type by either :

•

	

Setting temporary text tool defaults

•

	

Setting presentation defaults for text

You set temporary text tool defaults by selecting the text tool and then
choosing attributes from the Text menu . Once another tool is selected,
you revert to presentation defaults. However, if the defaults you want
are the same as those of some existing text, simply click the text tool
in that placeholder or independent text to give the text you are going
to type those attributes .
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You set presentation defaults for text by choosing the attributes you
want from the Text menu using the pointer tool without anything se-
lected. These text attributes are saved in the presentation and will not
affect your existing text . These attributes are in effect whenever you
choose the text tool until you change them by :

•

	

resetting them with the pointer tool .

•

	

setting temporary tool defaults .

•

	

applying a defined text format .

•

	

clicking in the text of a placeholder or a text block .

For more information on text tool or presentation defaults, see
Chapter l, "Persuasion Basics ."

To add an independent text block to a slide :

1 . In Slide view, select the text tool .

2 . If you want, choose text attributes from the Text menu to set temporary

tool defaults.

3 . Click where you want the text block to begin, or click and then drag to

establish the width of the text block .

Rulers appear when you click an insertion point with the text tool if you have
chosen "Show text ruler" from the Text menu .



you are going to type text
inside a-square or a rectangle ;
oubie-click the text toot inside
he shape where you want the
ext block to begin; Persuasion
i l fit the text block 'aside the

All independent text blocks have a predetermined right margin un-
less you click and then drag to establish a different one . Persuasion
creates a text block based on the alignment checked in the
"Alignment" submenu of the Text menu .

4 . Enter your text .

Persuasion automatically wraps words to the width of the text block,
creating new lines as needed .

•

	

To modify the width of an existing placeholder or independent text

block, do one of the following :

•

	

Select the text tool, click an insertion point in the text block, hold down the

Command key, and then drag either side to the width you want .

•

	

Or, select the text with the pointer tool, and drag one of its handles to

resize it as you would any other object .

The text in the block reformats automatically .

Editing text on slides
You edit text in Persuasion the same way you edit text in many other
Macintosh applications .

•

	

To edit placeholder text or independent text :

1 . With the text tool, select the text you want to edit :

To select

	

Do this

Aword

	

Double-click inside the word, or drag to highlight
the word .

A range of text

	

Drag to highlight the text .

A large amount of text

	

Click at one end of the text, then hold down the
Shift key and click at the other end .

2 . Cut, copy, or paste (Edit menu) text as you do in the outline .

For more information on editing in the outline, see Chapter 2,
"Outlining .
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Formatting text
To format text on a slide, you must first select the range of text you
want to work with either placeholder or independent text-by select-
ing the text with the pointer tool or highlighting it with the text tool .
Then you can choose commands from the Text menu to assign
attributes or formats . Persuasion provides a large variety of style
attributes and special effects for text . You can apply them by :

•

	

applying attributes one at a time from the Text menu .

•

	

defining a combination of attributes and special effects as a text
format and then applying that format from the Text menu .

Applying attributes from the Text menu
If you need to change a style attribute in only a few places, it's just as
easy to do so directly from the Text menu .

To change text attributes

1 . Select the text whose attributes you want to change .

2. Choose one or more of the Text menu commands that follow .

Font
Size

	

1
Style

	

1
Color

	

1



Size 9
fl0

14
X18

24
30
36
48
60
72

96
Other . . .

Style •

	

Plnin 4
Bold

	

4 B

Underline

	

4 €U

00~~8©0

	

4~0

DdOdOQ 4)S
Superscript 4 H
Subscript

	

4 :I

Font

Your choice of font depends on how you intend to produce your pre-

sentation. To ensure font availability, you should first select the output

device you'll eventually be using for your presentation .

Size

The most common point sizes are available in the "Size" submenu .

The numbers shown in outline style are sizes for which there are screen

fonts. You can set a custom size by choosing "Other . . ." at the bottom

of the submenu and setting the size you want in the "Other text size"

dialog box .

-14-point Times

24-Do/nt Times

36-point Times

Style

Eight type styles are available : Plain, Bold, Italic, Underline, Outline,

Shadow, Superscript, and Subscript . Each of the first six styles illus-

trates its effect in the submenu. For example, "Bold" appears in

bold type .

Note : On a QuickDraw output device, you can control the distance

a shadow is cast from text using the "Preferences" dialog box . For

more information about setting text shadow offset, see Chapter 1,
"Persuasion Basics

."

Color

The working set of colors is available from the submenu . You can

apply a custom color or a color from the standard grid by choosing
"Other

. . .," clicking the cell you want, and then clicking "OK." For

more information about applying color, see Chapter 5, "Using Color."

Ocean us

Oceanus-

Oceanus
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Alignment
The text within a text block can be aligned left, center, right,
or justified .

Lorem ipsum dolor
sit amet,
consectetuer
adipiscing elit, sed
diam nonummy nibh
euismod

Aligned left

Lorem ipsum dolor
sit amet,

consectetuer
adipiscing elit, sed
diam nonummy nibh

euismod

Aligned center

Line spacing . . .
You can adjust the spacing between lines or paragraphs by entering
appropriate percentages for each in the "Line spacing" dialog box .
The settings can be as low as 50% and as high as 500% .

Lorem ipsum dolor
sit amet,

consectetuer
adipiscing elit, sed

diam nonummy nibh
euismod

Aligned right

Lorem ipsum dolor sit
amet, consectetuer
adipiscing elit, sed
diam nonummy nibh
euismod

Justified

OK

Cancel

Line spacing

line spacing : 100 of normal

Paragraph spacing : a of normal100



To

A good rule of thumb to follow
is to set the paragraph spacing
to a larger percentage than the
line spacing . Remember that if
the lines are too close to-
gether, they will be hard to
read at a distance .

For example, if you want the lines in your paragraphs to be single-
spaced, choose 100% for line spacing . If you want a double space
between paragraphs, choose 200% for paragraph spacing .

Pr1C'e Perfoimanc.e

•

	

Higher pi7ice than fiberglass
•

	

Lower price than graphite
•

	

Similar technolo2 cal
advantages

Line spacing and paragraph spacing at 100%

•

	

. U ∎ . . ∎ ∎ . • ∎ . U U ∎ ∎

Price Performance

•

	

Hig ier price than fiberglass

•

	

Lower price than graphite

•

	

Similar technologic al
advantages

a

Line spacing at 75% and paragraph spacing at 200%
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Bullet marks
You can show or hide bullet marks that have been applied to body text
by your slide master. Select the bulleted text or placeholder, and then
choose the "Bullet marks" command from the Text menu to show
bullet marks ; choose it again to remove the checkmark and hide
bullet marks .

. . . . . . . . . . . . . . . .

Price Performance

I.
•

	

Hikherprivt tliaii 1il_ei lass

•

	

L.o'rver prix. than Kraphite
•

	

Similar teehnolo ical advantages

U

Note : Your slide master defines the font or type of symbol used for the
bullets . To change these, select the bulleted text or placeholder, go to
Master view, and choose the "Define bullet marks . . ." command from
the Master menu . For more information about defining bullet marks,
see Chapter 6, "Creating Masters ."

Defining and applying text formats
If you are using the same combination of text attributes on multiple
slides, consider defining and naming those attributes permanently with
the "Text format . . ." and "Define formats . . ." commands from the Text
menu. These commands allow you to identify frequently used text style
attributes much the same way you would identify frequently used slide
designs as slide masters .



To create, edit, rename, or delete a text format :

1 . Choose "Define formats . . ." from the Text menu .

Define teat formats

Rename:

c

tOK D
Cancel

New

S

	

.. . :.idti .

2. Define a new format or edit an existing format as follows :

To

Create a new format Click the "New" button to display the "Text format"

dialog box. Choose font, size, and color, name the
new format, and then click "OK ."

Edit an existing format

	

Select the format you want to edit from the list
box, and then click the "Edit . . ." button to display
the "Text format" dialog box . Change font, size,
and color, and then click "OK ."

Do this

Tent format

	

OK

Font :

Size :

EHample :

Times

36

Style :

	

Plain
0 Bald

Color: Black

Italic:

	

Outline
Q Underline

	

Shadow

The quick brown

Cancel

3. Rename a format in the "Define text formats" dialog box by selecting the

format name in the list box and then typing the new name in the "Rename" box .

4 . Remove a format by selecting the format name in the list box and then

clicking "Remove ."

5. When you're finished defining, editing, renaming or deleting text formats

in the "Define text formats" dialog box, click "OK."
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Once you have defined one or more text format combinations, you can
apply them by choosing "Apply format" from the Text menu .

To apply a defined text format :

1 . Select the text block you want to change with the pointer tool, or highlight

the text using the text tool .

2. Choose "Apply format" from the Text menu, and then choose the name of

the format you want from the submenu .

formatting paragraphs with tabs and indents
Persuasion allows you to set tabs for text in any kind of text block just
as you would in any word-processing program . You press the Tab key
to move the text to the next tab setting on the ruler .

Indent markers, on the other hand, govern the heading levels in body
text placeholders . You can set indents in the placeholder text that will
correspond to heading levels when the text flows back to your outline .
You can move text to the next indent level using the "Move right" and
"Move left" commands from the Text menu .

(If your text ruler is not showing, choose "Show text ruler" from the
Text menu.)

L

Investment

	

$800 000
•

	

Venture capital
•

	

Outside investors
NPV profits

	

$1 .2 million
•

	

Payback period Two years. . .

	

. . .

	

. . .

	

. . . . :
The six indent markers correspond to the six heading levels allowed in the outline .

	t eft tab

-- DeciinaI tab

Text

Font 1
Size 1
Style. 1
[:olor 1
Alignment 1



For body text and body text placeholders, each indent marker cone-
sponds to a different level of text, one indent marker for each of the
six potential levels of text under the title . If you see less than six indent
markers for the body text or body text placeholder, then one or more of
the markers are overlapping others . Multiple indent markers will also
be seen on the text ruler for independent text . However, only the first
indent marker-the one at the left edge of the ruler-is actually used .
The other five indent markers on the text ruler for independent text
are not used.

To clear tabs in the text ruler :

Point to the tab marker you want to clear, and then drag it out of the ruler area .

To set tabs in the text ruler :

Point to one of the tab markers in the lower-right corner, and then drag it to

where you want it .

	 :
Add a tab by dragging it from the corner to the ruler .

If you set a tab with the left tab marker, your text will align to the
left. If you set a tab with the decimal tab marker, your text will align
to the decimal point .

To reset tabs in the text ruler :

Point to the tab marker you want to reset, and then drag it to its new position .

Reset a tab by dragging it to a new position in the ruler .
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To adjust indents in the text ruler :

Drag the indent marker to where you want it .

You can adjust the upper and lower portion of the indent marker
separately. Drag the upper portion to set the first line indent ; drag
the lower portion to set the indent for the rest of the paragraph .
Bullet markers are not governed by the ruler-only the text is .

Note : When an insertion point is at the beginning of a new heading
in a body text placeholder, Command + Tab and Command + Delete
demote and promote headings, respectively .

Drawing and importing objects
Visual images often convey concepts better than text does . Whether
you'd like to support your point with basic graphics or enhance your
overall message with more sophisticated effects, you can get what you
want by using Persuasion's drawing tools or by importing art from
other programs .

Drawing with Persuasion fools
The drawing tools in Persuasion let you create a broad range of graph-
ics directly on your slides. The following procedures describe how to
use these tools .

Remember, you can specify the attributes you want your object to have
before you draw it by setting either presentation defaults or tool de-
faults . For more information about setting defaults, see Chapter l,
"Persuasion Basics."

You can draw lines freely or you can "standardize" them by holding
down the Shift key while you draw . The Shift key constrains different
tools in different ways .



To draw a line or arc :

1 . Select the tool you want .

To draw

	

Use the

A vertical or horizontal line

	

Perpendicular-line tool

A diagonal line

	

Diagonal-line tool

A curve

	

Arc tool

A line at 45° angle

	

Shift key + diagonal-line tool

An arc in a quarter circle

	

Shift +arc tool

2. Click where you want the line to start, and then drag to draw, releasing

the mouse button where you want the line to end .

To retain the desired effect, you must release the mouse button
before you release the Shift key .

Line drawn with diagonal-line tool Line constrained to 45°

For information on reshaping an arc, see "Resizing and reshaping
objects" later in this chapter .

To draw a rectangle or an ellipse :

1 . Select the square-corner, round-corner, or ellipse tool .

2. Click where you want a corner of the shape to start, and then drag in any

direction .

U

r

.1
U
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Using the Shift and Option keys in combination with the square-corner,
round-corner, and ellipse tools affects the way the drawing tool works .

Note : To retain the effect of the modifier keys, you must release the
mouse before you release the modifier keys .

To draw a freeform line or shape :

1 . Select the freeform tool .

2 . Click where you want the line or shape to start, and then drag to draw the

freeform object .

To draw a line with multiple segments or a polygon :

1 . Select the polygon tool .

2 . Click where you want the line or shape to start, and then click where you

want that segment to end . Continue clicking to add segments .

3 . Double-click to end a line or shape .

For information on reshaping a polygon, see "Resizing and reshaping
objects" later in this chapter .

To draw a Select this tool Do this

Square from Square- or Hold down Shift, and then drag .
its corner round-corner

Rectangle from Square- or Hold down Option, and then drag .
its center round-corner

Square from Square- or Hold down both Shift and Option,
its center round-corner and then drag .

Circle Ellipse Hold down Shift, and then drag .

Ellipse from Ellipse Hold down Option, and then drag .

the center

Circle from Ellipse Hold down both Shift and Option,
the center and then drag .



You can change the magnify-
ing toot into the reduction tool
by holding down the option
key when the magnifying tool
is selected . Release the option
key to return to the magnifying
tool .

Enlarging and reducing the view
When you are drawing and manipulating objects, it often helps to zoom
out or zoom in on your work . You can change your magnification of a
slide by using the magnifying and reduction tools in the toolbox . The
location where you click the tool becomes the center of the enlarged
or reduced view .

•

	

To enlarge your view :

Select the magnifying tool from the toolbox, and then click on the portion

of the slide you want to enlarge .

You can view your slides at up to 400% magnification by clicking
additional times . From "Fit in window," you can click with the mag-
nifying tool three times to enlarge it respectively to 200%, 300%,
and 400% .

•

	

To display your work at the size it will print :

Choose "Actual size" from the Draw menu .

To ensure printing and imaging accuracy, proof your work in
this view .

•

	

To reduce your view :

Select the reduction tool, and click anywhere on the slide .

When you close a presentation, the level of magnification that you last
worked in is saved with the presentation .
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Importing graphics
Persuasion lets you import graphics from other programs and from the
clip art provided in the Art of Persuasion, taking advantage of graphics
that already exist, such as your company logo . Persuasion accepts
graphics in EPS, PICT, Windows Metafile, and PICT II formats .
(See "Importing color graphics" in Chapter 5, "Using Color .")

7rrea oraonl

Import

	

OK R

0 aurora Iogo .eps

Cancel

Drive

Hard Drive

t To import a graphic :

1 . Go to the slide to which you want to import the graphic .

2. Choose "Import . . ." from the File menu .

3 . In the list box, locate and select the file that you want to import .

4. Click "OK."
The graphic is imported to the center of the slide . You can drag it to
a new position or resize it if you wish .

Note : If you're running Persuasion under System 7 .0, you can subscribe
to EPS and PICT formats on slides, note pages, handouts, and masters .



Manipulating objects
Objects are the basic components of your slides . Text blocks, graphics,
any kind of chart, or any individual element within a chart are all
treated as objects . Placeholders on masters are also objects, but with
a difference : they link the outline to the slides . Nevertheless, they can
be moved, resized, and enhanced like any other object .

Most objects or groups of objects (text and graphics that you've com-
bined into one object using the "Group" command from the Draw
menu) can be manipulated in the following ways :

•

	

Selected and subselected

•

	

Grouped and ungrouped

•

	

Cut, copied, or pasted

•

	

Moved

•

	

Resized and reshaped

Selecting and subselecting
Before you can modify or enhance anything-a graphic, text in a text
block, a chart-you must select it . You select most objects with the
pointer tool; however, you select portions of text with the text tool .

If you want to modify only a portion of an object, you can often
subselect the part you want to change by double-clicking it . Typically,
you do not need to ungroup several objects to select one of the objects
or a portion of one of the objects .

The following table shows the options you have for selecting objects,
both graphics and text blocks .
'-
To select

	

Do this using the pointer tool

A single object

	

Click the object .

A portion of an object

	

Double-click the portion you want to subselect

within a group .

Two or more objects

	

Hold down Shift while you click each object, or
drag a selection box around the objects .

All objects on a slide

	

Choose "Select all" from the Edit menu .

Chapter 3: Working on Slides ∎ 93



94 ∎ Aldus Persuasion User Manual

The "Select all" command from the Edit menu operates in different
ways depending upon which tool is selected and how many times you
choose the command :

*•.awe)iR6Y~3. 7ew4utrai~~m;wmytzc+vane$v. t!r,Y.\ia3; ;v, .+ .'.t~y'~pAaigN •aM2A7,1FR41 .S.+

	

-

	

-

	

-ia•~ OCI'47w~•f+ARaf~ .r 7i~e~±iMF~wrua4wif5M`8swewl-- .

To select

	

Do this using any drawing tool or text tool

All objects on a slide

	

Choose "Select all" (Command +A) once .
drawn with a specific tool

All objects on a slide

	

Choose "Select all" (Command +A) twice .

Do this using the text tool

Drag-select the characters .

To select

Characters

Words

To cancel a selection :

Click a blank part of the slide .

Double-click a word, and then drag to select
more words .

A range of text

	

Click at one end of the text, and then hold down
the Shift key and click at the other end .

All text blocks on a slide

	

Choose "Select all" (Command + A) .

All text in a text block

	

Click the text block, and then choose "Select all"
(Command +A) .



Subselecting
Subselecting is a handy technique to use with charts, organization
charts, and other groups of objects . You can use the "Group" com-
mand from the Draw menu to combine various objects so that you
can manipulate them as a single unit . Even so, you can still subselect
individual elements in the group without ungrouping it .

Charts and organization charts drawn by Persuasion are groups com-
posed of smaller objects ; you do not have to ungroup them to subselect
portions of them . For example, a pie chart is an object comprising sev-
eral smaller objects-the individual "slices ." If you want to modify just
one slice within the pie chart, you can subselect that slice .

Eight handles appear around a selected object . . .

Here are some items you can subselect within a chart or
organization chart :

•

	

Linked logical subsets of information, such as all the labels in a
chart, all the column headings in a table, or all the boxes on one
level of an organization chart

•

	

Any graphic part of a data series, such as the top or side of a bar or
column in a chart

•

	

Any line, including grid lines and axes, the column boundaries in a
table, or the lines connecting boxes in an organization chart

To subselect

A subset of objects

One object

or around a subselected portion of the object .

Do this using the pointer tool

Double-click an object in the subset .

Double-click one or more times, until the object is
selected .
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Moving objects
You can reposition objects on a slide to achieve better visual balance .

To move an object :

1 . Select the objects you want to move .

2 . Point to the center of the selection, and then drag to where you want it .

Or, if you want to move the object horizontally or vertically only,
start dragging and then hold down the Shift key .

If you move several selected objects at one time, the relative positions
of the objects within the group will be maintained .

Grouping objects
With Persuasion, you can treat two or more objects as a single object
by grouping them . By grouping objects you can freeze them in relation
to one another and work with them in unison. For example, you might
group your company logo with the text block containing your
company's name so that they can be moved as a unit .

You can also group together successive groups of objects . For example,
you can group two objects together, then group them together with a
third object, and so on . Any ungrouping or subsequent regrouping is
carried out according to the hierarchy in which the objects were origi-
nally grouped. Thus, you can move through multiple levels of
ungrouping or regrouping .



. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Align to grid

	

81 H
Grid snap on

	

Y
. . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

To

You do not need to ungroup an
object to edit the text associ-
ated with it.

To group objects :

1 . Select at least two objects you want to group .

.

Each object is selected individually .

2. Choose "Group" from the Draw menu .

∎

	

∎

.

∎

	

∎

All objects are combined into one group, and the group is selected .

Repeat Steps 1 and 2 to create as many groups as you want . You can
even group "grouped" objects-that is, you can use the "Group" com-
mand to create groups within a group . Groups remain intact even if you
save or close the presentation .

You can group together independent objects added to a slide, but you
cannot include in the group any object that is connected to the outline
by a placeholder . For example, you can group independent text blocks,
graphics drawn in Persuasion, and imported text or graphics . However,
you cannot group titles, subtitles, or text linked to the outline ; charts or
tables ; or organization charts .

r To ungroup objects :

1 . Select the group .

2. Choose "Ungroup" from the Draw menu .

Repeat Steps 1 and 2 as needed. Persuasion can ungroup any selected
group or groups . Any changes (for example, color or fill pattern)
applied while the objects were grouped are retained .

∎

.

∎

∎
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Ungrouping imported graphics
Some imported graphics must be ungrouped to be modified . When a
PICT graphic is ungrouped, its elements are converted into Persuasion
elements . After a PICT graphic is ungrouped, you can move it, resize it
or change other attributes such as font or type . If you import a PICT
graphic with a fill or line pattern and then ungroup it, Persuasion may
apply its own pattern from the "Line pattern" or "Fill pattern"
submenus .

You cannot use the "Undo" or "Regroup" commands, however, to
convert the ungrouped image back into a PICT graphic. If you want
the object in PICT format, delete the ungrouped version and import
the original PICT graphic again .

If a PICT graphic contains objects that cannot be converted into
Persuasion objects (e .g., rotated text, smoothed polygons), Persuasion
will not be able to ungroup the PICT graphic .

This PICT graphic can be ungrouped because

	

This PICT graphic cannot be ungrouped because it
it is created from shapes that can be

	

is a scanned image containing no objects that
converted into Persuasion objects .

	

could be created in Persuasion .

Persuasion can ungroup any Persuasion object on a slide that was ex-
ported in PICT format . If you apply colors in Persuasion to an object
displayed on a black-and-white monitor, then export the slide contain-
ing the object as a PICT graphic and open it later on a color monitor,
Persuasion will display the object in the colors available on the color
system .

Note: On a Macintosh Plus, SE, Classic, or Portable, the PICT graphic
will only include eight colors, no matter what kind of Macintosh and
monitor it is ultimately displayed on .



Ungrouping charts and organization charts
In general, ungrouping charts and organization charts is not a good
idea-there's little to gain from it and a lot to lose . An ungrouped
chart or organization chart loses its links to the outline or data sheet
and becomes a set of disconnected graphic objects . It is not necessary
to ungroup a chart or organization chart to modify or enhance it ;
you can simply subselect the part you want to change .

If you ungroup an organization chart, and then decide you would prefer
to have a linked organization chart rather than a graphic object, delete
all the chart elements on the slide, then click the Slide view icon at the
upper-right edge of the window to have Persuasion redraw your chart
for you .

Although you do not need to ungroup a chart or table to make modifi-
cations to it, you may decide to do so . Any changes you make while
the chart or table is ungrouped are not retained if the chart or table
is replotted or redrawn using the "Redraw chart" command from the
Chart menu . For more information on replotting and redrawing charts,
see "Replotting a chart" and "Redrawing a chart" in Chapter 4,
"Charting."

Regrouping
Once you have made changes to the ungrouped objects, consider using
"Regroup," instead of "Group ." Persuasion restores the most recent
grouping, saving any changes that were made while the objects were
ungrouped. You can continue to use "Regroup" to fully restore all
levels of a grouping .

P Yu restore the must recently Uetiried group one level at a time :

Choose "Regroup" from the Draw menu .

You do not have to have any of the objects selected to use
"Regroup"-Persuasion remembers which ones were in the
previous group until you close the presentation .
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Cutting, copying, and pasting
Editing in Persuasion often involves the Clipboard, a place where Per-
suasion temporarily stores the object you've cut or copied . By using
commands from the Edit menu, you can cut or copy objects to the Clip-
board, and then transfer them to another slide or to another presenta-
tion. The last item cut or copied remains on the Clipboard until you cut
or copy something else . When you paste an object-a graphic or a text
block-to a slide, Persuasion places it in the center of the slide . You
can also paste a text block at an insertion point made using the text tool .

Choose this command

	

To

Cut

	

Remove the selection from the slide, but save a
copy of it to the Clipboard

Copy

	

Copy the selection to the Clipboard without
removing it from the slide

Clear

	

Remove the selection without copying it to the

Clipboard

Paste

	

Paste the contents of the Clipboard onto a slide or
at an insertion point

Note: EPS graphics, if copied or moved to another slide, are converted
to PICT format, which may not match the original when printed .

Rotating and flipping objects
Rotating turns an object in 90-degree increments .

Flipping inverts an object either vertically or horizontally .



Editions

	

1 Subscribe To . . .

Create Publisher. . .

1 To rotate or flip an object :

1 . Select the objects you want to rotate or flip .

2. Choose "Rotate/Flip" from the Draw menu . Then choose from the options

in the submenu : "Rotate left," "Rotate right," "Flip horizontal," or "Flip

vertical ."

Publishing and subscribing
If you are using System 7 .0, you can take advantage of Persuasion's
new publish/subscribe capability . With this capability, you can publish
a Persuasion slide as a separate, linked file called an edition file. Once
you publish an edition file, you can subscribe to the edition file from as
many other documents as you want, which means that you can import
that edition file into the other documents . Any changes made in the
original file and updated in the edition file will also appear in the sub-
scriber documents . You subscribe to a Persuasion edition file from
another Persuasion file or from any other software program that
supports the subscribe feature .

Publishing an edition file
You can publish an entire slide in PICT format . The edition file con-
tains all of the graphic or text elements that appeared on the slide when
you created the edition file .

To publish an edition file :

1 . Choose "Create publisher . . ." from the "Editions" submenu on the

Edit menu .

The slide file you're publishing appears in the "Preview" area
in the dialog box .

2. Leave the default name that appears or type a new name for the

edition file .

3 . Select the folder in which you want to save the edition file .

4. Click "OK" to create the edition file .
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Setting publisher options
Once you create an edition file, you can specify whether changes you
make to the original file are automatically made in the edition file or
whether those changes are only made when you choose to update the
edition file . You set publisher options in the original file .

Note: You always work in the original file that publishes the edition
file or in the files that subscribe to the edition file .

~. To set publisher options :

1 . Open the original file that published the edition file .

You may, as a rule, want to set publisher options as soon as you
publish an edition file . If you just published the edition file and the
original file is still open, skip Step 1 and start with Step 2 .

2. Choose "Publisher options . . ." from the "Editions" submenu on the

Edit menu .

3. Select one of the following options for "Send editions" to determine when

Persuasion will update the published edition :

•

	

Select "On Save" if you want Persuasion to update the edition
file every time you save changes in the original file .

•

	

Select "Manually" if you want to control when Persuasion
updates the edition file with changes you've made to the orig-
inal file . If you select this option, you must choose "Publisher
options . . ." from the "Editions" submenu, and then click "Send
Edition Now" every time you want to update the edition file .

Publisher to : Marketing

Send Editions ;	

o, On Save
±_;' Manually

	

Send Edition Now

L. to t E iitior,

	

r'edr,e . d au = .epternt er- 2` , 1 ?91 1 i 14 .1 Ci

~, Cancel Publisher

~, Cancel ,~

The dialog box displays the last date and time the subscriber was
updated ("Latest Edition") and the last date and time changes were
made to the edition file ("Last Change") .

4. Click "OK."



Deleting edition files
You can delete edition files by using the "Publisher options . . ."
command.

~To delete an edition file :

1 . Open the original file that published the edition file .

2. Choose "Publisher options . . ." from the "Editions" submenu on the

Edit menu .

3. Click "Cancel Publisher ."

When you click "Cancel Publisher," you not only break the link
between the original file and the edition file, you delete the edition
file itself . If any files are subscribing to that edition file, however,
they will retain the edition file information .

Subscribing to an edition file
Persuasion can subscribe to edition files that have been created by
Persuasion or other programs and published in EPS or PICT format.

To subscribe to an edition file :

1 . Choose "Subscribe to . . ." from the "Editions" submenu on the Edit menu .

2 . Locate the edition file you want .

Only edition file names and Macintosh folders appear in the file list
in this dialog box. If a folder doesn't contain any edition files, then
no files appear in the list . When an edition file is highlighted, a
preview image of that edition file appears in the "Preview" area .

3. Click the edition file and then click "Subscribe," or double-click the edition

file to subscribe to it .

Setting subscriber options
Once you've subscribed to an edition file, you can determine whether
the subscriber is updated every time changes are recorded in the edition
file or only when you decide to update the subscriber, or you can cancel
a subscriber .
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To set subscriber options :

1 . Select the subscriber in your Persuasion file .

2 . Choose "Subscriber options . . ." from the "Editions" submenu on the

Edit menu .

3 . Select one of the following options for "Get Editions :" to determine when

Persuasion will update the subscriber:

•

	

Select "Automatically" if you want Persuasion to update the
subscriber automatically every time you modify the edition file .

•

	

Select "Manually" if you want to control updates to the sub-
scriber. If you select this option, you must select the subscriber,
choose "Subscriber options . . ." from the "Editions" submenu, and
then click "Get Edition Now" every time you want to update the
subscriber .

Subscriber to :

Get Editions :	

® Automatically
Q Manually

Technical Support

Get Edition Now

Latest Edition :

	

Wednesday, September 25, 1991 10 :14 :10

. . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Cancel Subscriber

Open Publisher

Cancel

The dialog box displays the last date and time the subscriber was
updated ("Latest Edition") and the last date and time changes were
made to the edition file ("Last Change") .

4. Click "OK."

Cancelling a subscriber :

1 . Open the file that contains the subscriber .

2 . Choose "Subscriber options . . ." from the "Editions" submenu on the

Edit menu .

3 . Click "Cancel Subscriber ."

When you click "Cancel Subscriber," you not only break the link
between the original file and the edition file, you delete the edition
file itself . If any files are subscribing to that edition file, however,
they will retain the edition file information .



Modifying a subscriber
Automatically updating edition and subscriber files isn't the only
advantage of the new publish/subscribe capability . You may be work-
ing in a Persuasion file and decide that you need to make some quick
changes to a subscriber . You can launch the application that produced
the original file, change the original file and the edition file, and then
return to your file without quitting Persuasion .

To make changes to a subscriber :

1 . Select the subscriber in your Persuasion file .

2. Choose "Subscriber options . . ." from the "Editions" submenu on the

Edit menu .

3. Click "Open Publisher."

If you're subscribing to a Persuasion edition file, then the original
Persuasion file opens . If you're subscribing to an edition file created
in another program, then that program launches and the original
file opens .

4. Modify the original file, and then choose "Save" from the File menu .

5 . If you're in another program, close the publishing program or choose

"Persuasion 2 .1" from the application menu to switch back to Persuasion .

If you're in Persuasion, close the original file or switch back to the illustra-

tion file that contains the subscriber .

The application menu icon appears in the upper-right corner of your
computer screen .

6. If you're updating the subscriber manually, choose "Subscriber options . . ."

from the "Editions" submenu on the Edit menu, and then click "Get

Edition Now ."

7. Click "OK."

The subscriber now reflects the changes you made to the
original file .
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Duplicating
The "Duplicate" command copies an object and immediately pastes the
copy-slightly offset from the original-onto your slide, bypassing the
Clipboard. This is an excellent method for quickly copying an object
many times .

To duplicate an object :

1 . Select the objects you want to duplicate .

2. Choose "Duplicate" (Command + D) from the Edit menu . .

Duplicate slightly offset .

3. Drag the duplicated objects to the preferred position .

Duplicate dragged to new position .

Note : Persuasion allows you to duplicate any type of object, including
charts, tables, and text blocks. However, be aware that the duplicated
object does not always retain all the information of the original . For
example, if you duplicate an imported EPS graphic, the duplicate be-
comes a simple PICT graphic . Duplicated charts and tables become
graphics that are no longer tied to the data sheet . And duplicated
placeholder text does not maintain its tie to the outline .



Power-duplicating
"Power-duplicating" an object means that you can control the direction
and distance of the offset for subsequent duplications of the object .
Repetitive effects, such as a checkerboard or dashed lines, are easily
created by power-duplicating .

To "power-duplicate" an object :

1 . Select the pointer tool

2. Select the object you want to duplicate .

3. Choose "Duplicate" (Command + D) from the Edit menu .

4 . Without deselecting the copy, drag it to the desired position .

5. Choose "Duplicate" (Command + D) from the Edit menu .

As long as the object remains selected, "Duplicate" will repeat
the move each time it creates a new copy .

- Object that you want to duplicate

Object plus duplicate dragged to its new offset position

- Offset automatically repeated in
additional duplicates

This "checkerboard" effect is created by drawing two squares-one white and
one black-grouping them, and then duplicating them .
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Resizing and reshaping objects
You can change the size and shape of any object-imported or other-
wise-by dragging one of its handles using the pointer tool . In addition,
you can resize subselected objects that are part of a group, except in
charts or organization charts . You can round the corners of any rect-
angle, including the boxes in an organization chart or the bars in
a chart .

To resize an object :

1 . Select the objects that you want to resize .

2. Drag any handle to resize .

When you grab a corner handle, the pointer becomes a
four-headed arrow .

Pressing either of the keys below after starting to drag constrains
resizing in these ways :

•

	

The Shift key maintains the proportions of the object
during resizing .

•

	

The Option key resizes from the center of the object .

Note : To retain the desired effect, you must release the modifier key
after you release the mouse button .
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Reshape poly
1
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Persuasion gives you the ability to reshape polygons and arcs after you
have drawn them. This allows you to refine a shape without having to
redraw it.

To reshape a polygon :

1 . Select the polygon you want to reshape .

∎

Selected polygon

2. Choose the "Reshape poly" command from the Draw menu .

If any object other than a polygon or arc is selected, the command is
dimmed. (If an arc is selected, the command is displayed as
"Reshape arc .")

When you choose "Reshape poly," a handle appears at each vertex
of the polygon .

v

The polygon looks like this after
"Reshape poly" is chosen .

Chapter 3: Working on Slides ∎ 109



110 ∎ Aldus Persuasion User Manual

3 . Drag a handle or a line to change the shape of the polygon .

Curve selected

You drag a handle to change the shape .

	

Reshaped polygon .

4. To add another handle, click anywhere on one of the polygon's lines .

5 . To delete a handle, drag it on top of another handle .

6 . When the polygon is the shape you want it, click in the window far away

from the polygon to make the handles disappear .

To reshape an arc :

1 . Select the arc .

2. Choose "Reshape arc" from the Draw menu .

3. Drag one of the two handles to lengthen or shorten the arc along its origi-

nal curve .

Dragging to reshape

4. When the arc is the shape you want it, click in the window far away from

the arc to make the handles disappear .



To round the corners of a square or rectangle :

1 . Using the pointer tool, select the square or rectangle you want to change .

You can choose an organization chart or chart, as well as any drawn
square or rectangle .

2. Choose "Round corners . . ." from the Draw menu .

Round r•o rners

Proportional resizing : (1 :' On ® Off

Width :

	

0"

	

::) 118"

	

} 3116''
C; 1i'4' ( 5116" c 3/8' ('Points :

Height: ® Same as width
s O "

	

i 118''

	

C'3/16''
0 114" C) 5116" {v' 318" 1Points :

OK

Cannel

3. To keep the corners proportional to the size of the rectangle when resizing,

click "On" for "Proportional resizing ."

4. Select a dimension (click inch options or type a point size) for the width

and height of the corners :

To change to

Square corners

5. Click "OK."

Organization chart with round corners

Select

Production Team

"0" for width and height

Even round corners

	

The same values for width and height

Elongated corners

	

Different values for width and height

Note: If you print your slides on a PostScript device, the corners will
print as though the width and height were the same .

Sin Grxr

	

5usenBIock
FTrJyxri[Ci

	

°I

	

b
p

	

A9Ald[YC :

	

h`

Wf'~4 yY' VV.' f•

	

W '1k1V'fWV~'

J~ACu iIciCE ;*~ Erttk~n

	

hierroZ••rrua ~ Jillhrd»'rr

	

IerryFatw'

.040'~NW~P~~i4 •000

Bi ILW AI! '
LkSi$lW

<, Y„IA r t ,, ~•

Chapter 3: Working on Slides ∎ 111



Tip :

The text ruler is different
from Persuasion's rulers .
The text ruler appears
when you click an insertion
point with the text tool and
"Show text ruler" is
checked in the Text menu .
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Aligning and layering objects

A well-designed slide is more than a matter of style . A presentation that
is visually consistent and orderly is easy for your audience to under-
stand and remember. You can organize objects on your slides by :

•

	

Using rulers to position objects on the slide

•

	

Aligning objects to each other

•

	

Centering objects on the slide

•

	

Controlling how objects overlap

•

	

Assigning objects to different layers to control the order in which
objects appear in a slide show

Llsiiig rulers drill ruler Iiiies
Persuasion's two rulers-one down the left side of the window and one
across the top-help you place objects precisely . When the rulers are
displayed, the intersection of their tick marks establishes an invisible
grid based on the measurement system you have chosen by clicking
"Custom rulers" in the "Preferences . . ." dialog box (File menu) .
For more information about choosing a measurement system, see
Chapter 1, "Persuasion Basics ."

The dotted lines in the rulers indicate the
exact position of the pointer at all times .



The rulers make it easy to align and position objects . For one thing,
you can track the movement of the pointer in the rulers by watching the
dotted lines there. For another, if the ruler lines are displayed, you can
use them to position objects . Finally, you can have Persuasion "snap"
objects to the invisible grid whether or not the ruler lines are displayed .
(The invisible grid is an extension of all the minor and major divisions
in the ruler, whereas the ruler lines that display are extensions of the
major divisions only .)

To display the rulers or the ruler lines :

1 . Choose "Preferences . . ." from the File menu .

Preferences

Default slide master :

Pointer in slide view :

Drawing options :

TeRt shadow offset :

Object shadow offset :

Rrrow keys :

Tent 1

•

	

Normal k
Show rulers

	

Show ruler lines
•

	

Custom rulers . Show page breaks
•

	

Hide big PICTS Fine background fill
•

	

2.0 Colors
® Small C) Medium

	

large

0 .125 inches down,

Precision

0 .125

OK

Cancel

inches right

•

	

Persuasion 1 .0 Word processing

2. Click to check "Show rulers" or "Show ruler lines" under "Drawing

options" in the "Preferences" dialog box .

To hide rulers or ruler lines, click to uncheck "Show rulers" or
"Show ruler lines ."

3. Click "OK."

To snap objects you draw, moue, or resize to the nearest increment

of the ruler grid :

Choose "Grid snap on" from the Draw menu .

Objects already drawn are unaffected by choosing "Grid snap on ."
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Aligning and centering objects
If you don't want to trust your hand and eye to align objects, you can
align and center them precisely by using :

•

	

the "Align objects . . ." command to align objects with each other .

•

	

the "Align to grid" command to align objects with the nearest
grid intersection .

•

	

the "Center on slide" command to center objects vertically and hori-
zontally on the slide .

Aligning objects with each other
"Align objects . . ." becomes available when you have more than one
object selected-a graphic, a text block, or a chart . You can hold down
Shift and click objects to add them to your original selection .

To align objects with each other :

1 . Select at least two objects to be aligned .

2. Choose "Align objects . . ." from the Draw menu .

Align objects

Un/Down: cTop
C) Center
c Bottom

OK

Cancel

Leftr'Right : (I) Left C, Center

	

Right



3 . In the "Align objects" dialog box, select either "Up/Down" (vertical) align-

ment, "Left/Right" (horizontal) alignment, or both .

Up/Down "Top" aligns the topmost handles of all the selected objects .

"Center" vertically aligns the centers of all the selected
objects .

"Bottom" aligns the bottom handles of all the selected objects .

Left/Right

	

"Left" aligns the left handles of all the selected objects .

"Center" horizontally aligns the centers of all the selected
objects .

"Right" aligns the right handles of all the selected objects .

Top

4. Click "OK."

For information on aligning text within a text block, see "Applying
attributes from the Text menu" earlier in this chapter .

Aligning objects to the grid
You can also align an object or a group of objects to the grid . The grid
is a series of invisible, non-printing horizontal and vertical lines that
intersect. (Some of the grid lines may be displayed if you check "Show
ruler lines" in the "Preferences" dialog box .) Persuasion sets up the grid
based on what you enter in the "Custom rulers" dialog box, which you
can go to from the "Preferences" dialog box . For example, if you set
the major division to be an inch and the "Minor divisions per major
division" to 8, Persuasion will align an object to the closest '/8-inch
intersection. Persuasion displays the major intersections of the grid if
you check "Show ruler lines" in the "Preferences" dialog box .

Center Bottom Left Center Right
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Tip :

If you are drawing multiple
objects that you want aligned
to the grid, consider setting
"Grid snap on" from the Draw
menu before you draw, thereby
avoiding repeated use of "Align
to grid ."
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To align objects to the grid :

1 . Select the objects to be aligned .

2. Choose "Align to grid" from the Draw menu .

Persuasion aligns by repositioning the upper-left handle of the object
to the closest grid intersection .

Note : For a text block, the baseline of the first line of text will align
vertically to the grid .

Centering objects on slides
You can center an object vertically or horizontally on the slide with the
"Center on slide" command .

To center an object :

1 . Select the objects you wish to center .

2 . Choose "Center on slide" from the Draw menu, and then from the

submenu, choose "Up/Down" for vertical centering or "Left/Right" for

horizontal centering .

Before vertical centering After vertical centering

Note : Persuasion centers multiple selections or grouped objects from the
center of the selection box that encloses them, without changing the
arrangement of the objects in the selection .



Controlling ho w objects o verla p
Objects are stacked on a slide in the order in which they are created or
modified . When you work with two or more overlapping objects, the
object most recently added or modified appears on top of the other
objects . You can change the way objects overlap, or the stacking
order, by using commands from the Draw menu .

To change how objects overlap :

1 . Select the object you want to change .

2. Choose "Send" from the Draw menu . Then choose from the options on
the submenu :

Option

To front

Forward

To back

Backward

Shortcut

Command + F

Command +_

Command + B

Command +-

Result

Moves the object in front
of all other objects .

Moves the object forward
one level .

Moves the object in back
of all other objects .

Moves the object back-
ward one level .
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Assigning objects to layers
Think of layers as transparencies stacked on top of one another to form
a single slide . By using multiple layers, you can :

•

	

Create slide builds . You can assign slide objects-such as a title,
text block, or chart-to different layers . When you print the slide
with the "Builds" option checked in the "Print" dialog box, or when
you run Persuasion's slide show with a value greater than 0 in the
"Delay between layers" option in the "Slide Show" dialog box,
information is revealed on a slide one layer at a time . This creates
a "building up" effect to create a complete slide .

•

	

Manage your drawing tasks on complex slides . By distributing ob-
jects over many layers, you can more easily select and modify only
the objects you want to work with, while assuring that the rest of the
graphic is not modified at the same time .

The easiest way to create slide builds for text, charts, and organization
charts is by setting builds to occur automatically through placeholders .
You should never use both automatic placeholder and manual layering
for the same object because combining manual layers with automatic
builds may create unexpected layering results . For more information
about setting slide builds in placeholders, see Chapter 6, "Creating
Masters ."

Moving objects to different layers
In Slide view, you can move objects to any layer using the Layer menu
on the lower menu bar . You can even move selected text within a text
block to a different layer .



The selected object is on Layer 1 and is
being moved to layer 2 .

(Layer 2 13 I

-Current drawing layer

4

:: :e drawing layer

Layer of selected
object

Layer of selected object

Tip

A quick way to set the current
drawing layer is to choose a
layer from the Layer pop-up
menu with nothing selected .

To assign layers to objects :

1 . Select the objects that you want to assign to a layer .

The layer the objects are currently on is displayed in the box to the
right of the Layer pop-up menu in the lower menu bar .

2. From the layer pop-up menu in the lower menu bar, choose the layer to

which you want them assigned .

3. Repeat Steps 1 and 2 as needed .

New text and graphics are created on the current drawing layer. If you
assign objects to the highest layer number currently available, Persua-
sion automatically adds more layers to the menu . The current drawing
layer is established by selecting a layer with the pointer tool when
nothing is selected on the slide .

Note: When you group objects that are on different layers, Persuasion
sends the group to the lowest of the object layers . For example, when
you group objects that are on the first, second, and third layers, Persua-
sion sends the group to the third layer . If you subsequently ungroup the
objects, they remain on the lowest object layer .

Changing layer attributes
Persuasion allows you to control which layers are active for modifica-
tion or to make layers visible or invisible .

To make layers active or visible :

1 . Choose "Set . . ." from the Layer menu in the lower menu bar .

Set layer visibility

Drawing layer : 3

Active layers : () All

	

Drawing layer only

C)'From 1

	

to 30

Visible layers : Q RII C) Active layers only

OK

Cancel
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2 . In the "Set layer visibility" dialog box, use these options to make layers
active or visible :

To

	

Do this

Make a layer active Type the number of the "Drawing layer" you want
to affect, and click "Drawing layer only" for "Active
layers ."

Make several layers

	

Click "All," or click "From _ to _" and type the
active

	

layer numbers you want to make active .

Make a layer

	

Make the layers active (as above), and then click
(or several) visible

Make all layers visible

3. Click "OK."

When you select an object on an active and visible layer and then move
to an invisible layer, the range of visible layers is extended to include
the layer to which you moved . For example, if the first, second, and
third layers are visible and active, and you select an object on the sec-
ond layer and move it to the fifth layer, Persuasion makes layers one
through five visible .

Enhancing graphics

"Active layers only" for "Visible layers,"

Click "All" for "Visible layers ."

You can enhance objects you have drawn in the following ways :

•

	

Applying special effects and color to their lines

•

	

Filling them with patterns and color

•

	

Adding shadows to them-plain, colored, or patterned



Applying special effects to lines
You can add special effects to any line or shape drawn with a
Persuasion drawing tool .

To add a special effect to a line or shape :

1 . Select the lines or shapes you want to change .

2. Choose one or more of the Effect menu commands described below .

Line style
You choose line weight from one of three columns in the submenu .
The lines at the top of each column indicate whether the line weight is
for horizontal lines, vertical lines, or for both. The dashed pattern at the
top of the submenu applies a line weight of "None" as a line pattern .
To make a dashed line, apply one of the dashed line patterns to the
object. In addition to line weight, you can choose again from the bot-
tom of the submenu to add one or two arrowheads to the selected line .

Line pattern
Fill pattern 1
St < i

Line color 1
Fill color 1
Shadow color 1
Line background 1
Fill background

	

1

Set colors . . .
Define colors . . .

Any object with lines can have a line weight applied .

Horizontal and vertical line weight

	Vertical line weight only

--Horizontal line weight only

00
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Effect
Line style
Line pattern 1
Fill pattern 1
Shadow 1

Line color 1
Fill color 1
Shadow color 1
Line background 1
Fill background 1

Set colors . . .
Define colors . . .
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Line pattern
Thirty-nine line patterns are available in the submenu . The wider the

line established with "Line style," the clearer the line pattern will be

on your slide. If you import a PICT graphic with predefined fill or line

patterns and then ungroup it, Persuasion may apply its own pattern

from the "Line pattern" submenu .

Note : Many line patterns do not image on high-resolution film record-

ers . Contact your local slide service bureau or film recorder manufac-

turer before using them .

. . .	. . . . . . . . . . .

	

.. . . .	

Line color

When you choose a color from this submenu, you are applying color

to the foreground of the line pattern, that is, to the part that appears in

black in the "Line pattern" submenu. You can also choose "Other . . ." to

display the "Select line color" dialog box, where you can select colors

from the Persuasion color grid .

Line background

When you choose a color from this submenu, you are applying color

to the background of the line pattern, that is, to the part that appears in

white in the "Line pattern" submenu. You can also choose "Other . . ." to

display the "Select line background color" dialog box, where you can

select colors from the Persuasion color grid .

For more information about applying color from the color grid, see

Chapter S, "Using Color ."



Filling objects with patterns and colors

The patterns and colors that you add to the inside of closed objects are

called fills. Fills can be evenly colored or graduated from one color to

another .

•

	

To change a fill pattern, color, or background :

1 . Select the objects you want to fill .

2. Choose one or more of the Effect menu commands described below.

Fill pattern

Forty-two patterns are available in the submenu, including "None ."

There are three graduated fill patterns at the bottom ; if you use them,

remember that the larger the object, the smoother the graduation of

the fill .

Note: Many fill patterns do not image on high-resolution film recorders .

Contact your local slide service bureau or film recorder manufacturer

before using them .

Effect
tine style 1
Line pattern 1
Fill pattern None

tine color
Fill color
Shadow color
Line background
Fill background

Define colors...
Set colors . . .

IIIII

	

._

II

urin

.,

A rectangle was drawn, a circle with no line pattern
was drawn on top of the rectangle, and each was filled
with a different pattern .

u

You can create a variety of effects by
combining different filled shapes .
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fill color
When you choose a color from this submenu, you are applying color
to the foreground of the fill pattern, that is, to the part that appears in
black in the "Fill pattern" submenu . You can also choose "Other . . ." to
display the "Select fill color" dialog box, where you can select colors
from the Persuasion color grid .

Fill background
When you choose a color from this submenu, you are applying color
to the background of the fill pattern, that is, to the part that appears in
white in the "Fill pattern" submenu . You can also choose "Other . . ." to
display the "Select fill background color" dialog box, where you can
select colors from the Persuasion color grid .

For more information about color and graduated fills in general, see
Chapter 5, "Using Color."



Effect
Line style 1
Line pattern 1
Fill pattern

	

1

Line color 1
Fill color 1
Shadow color 1
Line background 1
Fill background

	

1

Set colors . . .
Define colors. . .

NoneShadow

11111111~:~
11111111 UI 110 III ThHHP*H
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Adding shadows to objects
You can create plain, patterned, or colored shadows for any object .

To create a shadow :

1 . Select the objects you want shadowed .

2. Choose "Shadow" from the Effect menu . Then, from its submenu, select

the pattern you want for your shadow .

A shadow was applied to the map of the continents from the Art of Persuasion
after ungrouping the graphic .

Note : You can control the distance shadows are offset from objects in
your presentation by using "Preferences . . ." from the File menu . To
learn more about shadow offset, see Chapter 1, "Persuasion Basics ."

To change shadow color :

1 . Select the shadowed object .

2. Choose "Shadow color" from the Effect menu, and then from its submenu,

select the color you want for your shadow . Or, choose "Other . . ." to display

and choose from the color grid .

If you have a patterned shadow, the color is applied to the fore-
ground. The background of a shadow is always white .
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Chapter d: Charting

Charts turn raw data, entered in data sheets or spreadsheets, into graph-
ics that are easy to understand and remember . Because it's important
that you deliver your message clearly and with maximum impact,
Persuasion provides extensive charting capabilities .

You can use a Persuasion AutoTemplate to define the formats of your
charts, or you can design your own . In this chapter, the word chart
refers generally to all the chart types listed on the "Chart formats"
submenu, including tables .
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Creating a chart
The process of creating a chart begins with analyzing your data, figur-
ing out what purpose you want it to serve, and then deciding what kind
of chart works best to accomplish the purpose . For example, if you
want to show how a particular value, say, your company's total sales,
has changed over time, you basically have three chart types to choose
from: a column chart, a line chart, or an area chart .

Once you have narrowed the field in this way, you'll probably be able
to see immediately the chart type you prefer . If not, you can easily plot
your data as one chart type, see what it looks like, and then plot it as
another type to help you decide .

To

Show the parts of one whole

Show how items rank and compare

	

Bar chart

Show how items change over time

	

Column chart
Line chart
Area chart

Use

Show the correlation between pairs of numbers

	

Scatter charts

Show ranges of values

	

High-low charts

Show specific data

	

Tables

Pie chart
Stacked bar chart
Stacked column chart

With Persuasion, you have an additional option : you can combine two
charts into one . You can plot your data as one kind of chart, specify
that one or more of its data series be plotted as a different chart type,
and then overlay that chart on the main chart . This is particularly useful
when you want to highlight or contrast certain data with other data .



First entry plotted
at 12:00

Choosing a chart format
Each chart type and how it can best be used are described on the fol-
lowing pages . You can use the table in the previous section to narrow
the field and then refer to the following descriptions to find the chart
type that suits your message .

Pie charts
Pie charts take a simple, noncritical look at the percentage composition
of one whole. Pie charts are especially good when quick general im-
pressions are important . Because each pie chart is one series, use mul-
tiple charts where necessary. (Persuasion will not plot more than one
series of data when you choose a pie chart format .)

Plot the most important data at the 12 :00 position by making it the first
entry in the data sheet .

1
2
3
4

1 2
Toky.°	:	1035
New York : 250
London 679
Buenos Ai

	

566

Passengers by City

New York

You can drag out a piece of the pie for emphasis .

Tokyo
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Bar charts
Simple bar charts (one data series) stress how similar items compare .
The ranking of each item can be clearly illustrated by the vertical order
of each category . The magnitude is easily seen in the horizontal reach
of the bars .

Grouped bar charts (multiple data series) show how groups of items
rank and compare with other groups .

1 2

	

131

1 1 2 1 3

Value labels

Class I and Class II Complaints by Destination
0

	

10

	

20

	

30

	

40

	

50

Istanbul

N. American

Mid-Eastern

Asian

London

Warsav

This grouped bar chart is flipped vertically to place the scale at
the top . (Use "Rotate/Flip" from the Draw menu .)

Stacked bar charts
Stacked bar charts show the contribution of parts to a whole . Don't use
a stacked bar chart to display negative numbers .

Aircraft Census by Route
BAe300

D 747

0

	

5 10 15 20 25 30 35 40

E Class II

® Class I

The grid is turned off, and the only tick marks shown are on the
value axis . (Achieve both effects by choosing "Grid/Tick
options . . ." from the "Axes" submenu .)

1 Class I

	

Class II
2 Istanbul :

	

45'

	

48
3 London

	

25

	

18
4 Warsaw

	

13:

	

5

1 747 BAe30Ci
2 Asian 28 : 8
3 Mid-Easte 7 25
4 N . Americ 4 15



Column charts
Column charts are commonly used to show how values change over
time. With column charts, you can display negative numbers .

1 L 2 ! 3 1

1
2
3

1

1990
1991

4
Manila

	

:Taipei
42

	

3

	

13
48

	

.56

	

13

Forecast (millions of dollars)

15

10

This column chart shows negative numbers .

Stacked column charts
Stacked column charts show how similar items relate to a whole . Don't
use stacked column charts to display negative numbers .

Freight

•

	

Passengers

Asian Growth potential
120

100-

1990

	

1991

Lines were drawn from one column segment
to its counterpart in the other column to
emphasize that segment's growth potential .

Seoul

Taipei

Manila
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-10

	

-5
3 1995 :

	

-2

	

8+
4 2000

	

13

	

15
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Line charts

Line charts can dramatically show changes over long periods of time .
The major strength of line charts is that many data points can be plot-
ted. Trends are revealed in the slope of the lines . Be careful with the
number of lines you use-it's confusing when there are too many
(more than three or four) or when they cross often .

12

10

4

2000 -

1500-

1000 -

Improvements in n-time Performance

- '80

	

'81

	

'82

	

83

	

84

	

35

	

86

	

87

	

'88

	

'89

The lines are different weights (styles), and tick marks are
not displayed . (Choose "Line style" from the Effect menu
and "Grid/Tick options . . ." from the "Axes" submenu .

Area charts
Area charts display data in continuous bands that stress accumulations
or changes in proportions . Use area charts to show trends over time and
to emphasize totals as well as fluctuations .

The x-axis values are expressed in equal time periods, and the y-axis
values are expressed in quantities or percentages . To enhance readabil-
ity, plot the most stable data series as the first area .

2	3	4 	Business Composition
Thousands of dollars j

'81 '82 '83 '84 '85 '85 '87 '88 '89 '90

This area chart shows depth and exhibits different
fill patterns .

® Other

Passer er

European

Freight.

American

Freight F'aaenaer other-
2 .1 ?00

	

150 50
3 '82. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3i ii i' 400 : 400

500 :'83 6 .79 150
5 '84

	

1035: 755 : 9 C 1

6 '85 4001

	

400 755
7 S6 Si iiis

	

1020 732
8 7 1156 crn .

9 '88 1233 544
10 '89 600 E029=:04
1 1 '90 r hl _I

	

134 438

1 2 I 3
1 Arrierican Eurepeari
2 '80. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3 b

. . . . . . . . . . . . . . . . . . .

3 '81 4 4
4 82 6 5
5 '83 S 4
6 84 4 : 3
7 ' :35 7 : 6
8 8 6 O

9 'E7 8 11]	:	
10 '8 ~, 11
11 39 -1 :
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Scatter charts

Scatter charts depict the correlation between two sets of numbers by

plotting the intersection of the variables . The first column of values

for each pair contains the x value, and the second column contains the

y value .

Performance Profile

A portion of the data sheet
for the chart on the right .

High-low charts

High-low charts display three values for each category . They are used

for data, such as the highest and lowest values of a stock compared to

its closing value . The middle value of the range is plotted as a line by

default, but you can eliminate the line (not the data points) by changing

the line style to "None" if a graph of the data is not meaningful .

High value

Low value

Value compared

This scatter chart plots many variable pairs for one category . Axis
labels are added using the text tool .

0 1 L J

RF !(x I(J)

Temperature Range in Centigrade

1 17

April

	

May

	

June

	

Juh

	

Auk

	

Sept.

Identical high and low symbols contrast with the middle
symbol representing the average temperature .
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Tables
Tables are used when specific numbers are more important than the
trend they represent or when you want to format multiple-column text .

Understanding the "Chart format" submenu
Your "Chart format" submenu can have up to three sections : the
placeholder format, defined chart formats, and standard chart types .
The number of sections in your "Chart format" submenu depends on
the slide master assigned to the current slide and whether you have
defined chart formats in your AutoTemplate . (Each Persuasion
AutoTemplate has at least two defined chart formats .)

Chart

[hart format
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L Scatter
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•

	

Table

Left-aligned text - -

Italic text for emphasis

Center-aligned text

- Patterned fill

Premium Comparison

The text you edit in the table is automatically changed in
the data sheet, but the formatting you do on the slide is
not transferred to the data sheet .

Placeholder format

Defined chart formats

i- Standard chart types
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Placeholder format
The placeholder format is defined by the chart placeholder on a slide
master, such as "Graphic 1" or "Graphic 2 ." The chart placeholder
defines not only the format and effects to be applied to the chart, but
also its size and its location on the slide. If your presentation has sev-
eral charts and you want to maintain consistency from slide to slide,
you should take advantage of using the placeholder formats . If neither
"Graphic i " nor "Graphic 2" has the type of chart placeholder you
need, first plot your chart using the placeholder to give you its size,
placement, and effects, and then choose the standard chart type you
want from the Chart menu . All the other chart characteristics will
be retained .

Defined chart formats
You can predefine chart formats using the "Define formats . . ." com-
mand from the Chart menu. When the Persuasion AutoTemplates were
created, a chart format was defined for each of the chart placeholders
on "Graphic 1" and "Graphic 2 ." By applying any of the defined chart
formats to a chart, you can immediately confer on that chart all the
characteristics contained in the definition . You will have to position
it on the slide and size it manually. (For more information, see
"Defining chart formats" later in this chapter .)

Standard chart types
The standard chart types are always available in the lower part of the
submenu, even when you start a presentation from scratch by choosing
Shift + "New ." If you have already plotted a chart and simply want to
change its type (not its other attributes), choose a standard chart type .
The color, fill patterns, type attributes, and line style in effect for these
standard chart types come from the placeholder format on the master
or from the named custom format, depending on which format was
chosen previously .
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Plotting a chart

You have a great deal of flexibility when you create charts in Persua-
sion . You can create either placeholder charts or independent charts,
just as you can create placeholder text or independent text.

•

	

A placeholder chart is formatted directly by the chart placeholder on
the slide master assigned to the slide . A chart placeholder dictates a
chart's size and placement on the slide, as well as its chart type and
attributes . The standard sizing and placement provided by a place-
holder give placeholder charts a clear advantage over independent
charts. Using a placeholder chart is the best way to ensure visual
consistency from slide to slide .

•

	

An independent chart is formatted by either the individual attributes
you apply to it from the Chart and Effect menus or by the defined
chart format you apply to it from the "Chart format" submenu . An
independent chart can be on any slide, whether a slide master with
a chart placeholder is assigned to that slide or not .

To create a placeholder chart or an independent chart :

1 . Go to the slide in Slide view (or select the slide in Outline view) where you

want the chart to go .

2 . If you want to create a placeholder chart, choose a slide master containing

a chart placeholder ("Graphic 1" or "Graphic 2" in the Persuasion

AutoTemplates) from the Master pop-up menu in the lower menu

bar of either Outline view or Slide view .

If you are creating an independent chart, skip Step 2 .

3 . Choose "Data sheet" from the File menu . Then choose "Work area" from

the submenu .

Persuasion opens your presentation's data sheet. If you have plotted
other charts and tables in the current presentation, the data for them
will be displayed in the data sheet .

4. Click an insertion point below or beside existing data, enter your data, and

then select it .

You can also import your data or open an external spreadsheet . See
"Working in the data sheet" in the following section for details .

File
New
Open . . .
Close
Data sheet 1 il/nrk elBo

. .
S<i ; Ex S Open enternal . . .
Save as . . .



5 . If you are creating an independent chart, choose "Chart format" from the

Chart menu . Then choose the standard or defined format you want from

the submenu .

Chart
Chart format
Overlay format . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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Numbers

. . . . . . .. . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Show depth
,Show axis
'Show plot frame
'Show legend
Show value labels

. . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Get data

Redraw chart
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Define formats . . .
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Bar
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Stacked bar
id Column

.i ." Stacked column

•

	

Line
Area

•

	

Scatter
III High-low

®Table
I

Placeholder format

Defined chart formats

Standard chart types

When you are on a slide to which "Graphic 1" or "Graphic 2" is assigned, you will
see the format for the chart placeholder listed in the top section of the submenu .

If you are creating a placeholder chart, skip Step 5 .

Make sure that the chart format you choose is appropriate to
your data.
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6 . Click the "Plot" button in the data sheet .

The data will be plotted on your target slide, formatted by the place-

holder on the slide master or by the format you chose from the
"Chart format" submenu

.

When you click on the slide, the data sheet window remains open

behind the presentation window . To view the data sheet again, click

any visible portion of the data sheet to bring it to the front, choose
"Get data" from the Chart menu, or select "Data sheet" from the

File menu .

If you are creating an independent chart, you will have to size and

position it on the slide after plotting it .

Note : If the data you selected in Step 4 is inappropriate for the chart

format you have chosen, Persuasion displays a message to that effect

and plots only the appropriate data . For example, if you are plotting

data in the pie chart format, and you selected more than one data

series, Persuasion only plots the first data series .

Working in the data sheet
Persuasion's data sheet looks and works like other electronic spread-

sheets with which you may already be familiar. Each presentation has

one data sheet, which can contain multiple sets of data for as many

charts as you have in your presentation .

2
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Series labels usually appear as the legend for your chart, and category
labels appear on the category axis (usually the horizontal axis) .
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Category axis	
Pacific Rim

Australia

Europe

North America

You can enter or access data to be plotted in three ways :

•

	

Enter the data from scratch into your presentation's data sheet .

•

	

Import a file saved in WKS (Lotus 1-2-3 1A) or ASCII (text-only)
format from another spreadsheet program .

•

	

Open an external spreadsheet to use a portion of its data without
importing the entire file .

Once you have entered or imported data, or opened an external spread-
sheet, you can choose to plot the data in one of Persuasion's 10 chart
and table formats .

Data series	

I
Categories -

i

. . .. . .. . .. .. .. . .. . .
r I

. . .. . . . . .. . .. . . . . . . . . . .. . . . . . . . . . . . . .. . .. . . . . . . . . . . . . . .. .. . .

Value axis	o% 2% 4% 6% 8% 10%12%14%16%18

This bar chart was plotted from the data in the data sheet shown in the previous illustration .

Here is the same data plotted as a table .

1
-

	

avU

- Major grid lines

∎ Current-

	

Legend
E Projected )

Column boundary

Data series
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Tip :

If you consistently have more
data than will fit in the columns
in the data sheet, click the
column boundary next to the
column number at the top, and
drag to widen it. (Persuasion
accepts all the data regardless
of the column width, but
widening the column allows
you to see it without selecting
each cell .) This reformat will
remain in effect until you close
the file .

142 ∎ Aldus Persuasion User Manual

Entering data from scratch
Entering data in Persuasion's data sheet is much like entering data in
any of the popular spreadsheet applications : simply open the data sheet
work area, click an insertion point in the cell where you want to start,
and type in the data . You can also select the group of cells you'll need
for your data so that you can press Return after each entry to move
down each column and to the top of the next one within the
selected area .

To enter data from scratch :

1 . In the data sheet, click an insertion point in a cell, or select the cells where

you want to enter data to limit cursor movement to that area .

2 . Enter your data :
.

Press

Tab or Right arrow

Shift + Tab or Left arrow

Return or Down arrow

Shift + Return or Up arrow

To do this

Move right one cell

Move left one cell

Move down one cell

Move up one cell

Note : Try to limit category labels to nine characters . If you enter more
than nine, they may overlap when you plot the data .



Importing data from a spreadsheet program

Persuasion accepts data from any spreadsheet program that can save
files in the WKS or ASCII text format . When importing an ASCII text
file, Persuasion puts the information it finds between tabs in separate
columns of the data sheet. Once you import the data, it is stored in the
data sheet work area and becomes a permanent part of your presentation .

To import to the data sheet :

1 . In the data sheet, click an insertion point where you want the upper-left

cell of the imported data to be placed .

Note : Click your insertion point beside or below any existing data in
your data sheet. Otherwise, the imported data may overwrite your
existing data .

2 . Choose "Import . . ." from the File menu .

A message appears reminding you to click your insertion point be-
side or below existing data. If you have done so, click "OK" to see
the "Import data sheet" dialog box . If not, click "Cancel" and repeat
Steps 1 and 2 .

Import data sheet

0 Slide 8 table data
0 Slide 9 chart data

OK

Cancel
. . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Desktop

Hard Urine

3 . In the list box, select the name of the file you want to import .

4 . Click "OK."

Persuasion brings the contents of the external file into your
data sheet .
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Plotting from an external spreadsheet
Persuasion also lets you open an external spreadsheet and view it in a
temporary work area . This method is ideal for plotting selected infor-
mation, such as sales totals, from large spreadsheets .

Note : The external spreadsheet must be saved in ASCII or WKS format .

To plot a chart from an external spreadsheet file :

1 . Choose "Data sheet" from the File menu, and then choose "Open exter-

nal" from the submenu .

2 . Choose the file you want to open from the list box .

3 . Click "OK."

You will see the file on the screen in the Persuasion data sheet for-
mat. This is a temporary data sheet, not the main data sheet for your
presentation . You cannot change information in it .

4 . Select the data you want to plot . Optionally, choose a chart format from the

"Chart format" submenu, and then click the "Plot" button .

Persuasion copies the selected data to your data sheet where you can
edit it.



First data series

Creating an overlay chart
Persuasion gives you the ability to combine two different chart types
for plotting a single set of data . This feature makes it easy to emphasize
certain data in comparison to other data .

For example, you might want to plot sales figures for the various divi-
sions of your company, but you particularly want to point out how the
Pacific Rim division is doing in comparison to the other three divisions .
Persuasion's overlay chart feature lets you plot one kind of chart show-
ing the sales for all the divisions except the Pacific Rim, and then plot
the Pacific Rim division sales in another format that is overlaid on the first .

January March April

1
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Racifia Rim

	

Nar#h America Europe	Australia,
January	:	06
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.07
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.03

The first data series is plotted as a line chart that overlays the remaining data
series that are plotted as a column chart .

In the "Chart overlay" dialog box, you can specify how many data
series to plot on the overlay chart . (A data series is a column in the
data sheet. However, note that you can switch rows and columns with
the "Rows are . . ." command from the Chart menu, and a series then
becomes a row .) The remaining data series are plotted on the primary
chart (the one in back) . If you specify three data series for the overlay
chart, Persuasion plots the first three data series on the overlay and the
remaining data series on the primary chart . Therefore, you should struc-
ture your data sheet so that data for the overlay chart is located to the left of
data for the primary chart.

$ Pacific Rim

North America

Europe

•

	

Australia

First data series
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To create an overlay chart :

1 . Open the data sheet, and select the total data to be plotted .

2 . Choose "Chart format" from the Chart menu, and choose a chart type for

the primary (back) chart from the pop-up menu .

3 . Choose "Overlay format . . ." from the Chart menu .

4 . In the "Chart overlay" dialog box, select a chart type for the overlay chart

from the "Overlay type" pop-up menu .

Chart overlay

Overlay type :

Plot the first

None

0 data series in c

OK

None

id Column
," Stacked column
b line

Chart types that cannot overlay the primary chart type are dimmed .

5. Specify the number of data series to plot on the overlay chart, and then

click "OK."

The default is one series .

6. Click "Plot ."

To add an overlay to an existing chart :

1 . Select the chart .

2. Choose "Overlay format . . ." from the Chart menu .

3 . In the "Chart overlay" dialog box, select a chart type for the overlay chart

from the "Overlay type" pop-up menu .

Chart types that are incompatible with the primary chart type
are dimmed .

4 . Specify the number of data series to plot on the overlay chart, and then

click "OK."

Persuasion replots the data into an overlay chart .



Defining chart formats
"Define formats . . ." lets you define custom chart or table formats to
apply to other charts or tables in your presentation .

To define year oven chart formats for later use :

1 . Select the chart or table with the format you want to define as a

custom format .

2. Choose "Define formats . . ." from the Chart menu .

Define chart form a ts

	

OK 1

Rename : Untitled format 1

® Untitled format 1
Rrea Format

!J Column Format 1
Cancel

. . . . . . . . . . . . . . . . .. . . . . . . . . .
[Remove

3 . Type a name for the custom chart or table format in the "Rename" box .

4 . Click "OK."

The defined chart format appears as an option on the "Chart format"
submenu. Apply the defined chart format to charts or tables just as you
would any of Persuasion's standard chart types .

To remtt~re defined chart formats from the "Chart format" sohrneno :

1 . Choose "Define formats . . ." from the Chart menu .

2 . Click to select the name of the custom format in the list box, and then

click "Remove ."

3. Click "OK."
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Editing the data sheet for a chart
Once you have viewed your chart, you may need to make changes or
corrections to the data. After you change the data in a data sheet, you
need to replot the chart.

Locating data in the data sheet
Although you can use the vertical and horizontal scroll bars to move
in the data sheet, there are more useful ways to locate the data you
want. You can use the arrows and toggle box in the upper-right corner
of the data sheet to locate sets of data and to specify a target chart for
replotting. You can also move from the chart on a slide to its data
in the data sheet using the "Get data" command from the Chart menu .

Moving through sets of plotted data
The arrows and toggle box in the upper-right corner of the data sheet
allow you to view sets of data on the data sheet . The area to the left of
the arrow icons identifies the chart type and location of the target chart
where the highlighted data is plotted . (If the target chart is italicized,
the current selection range is different from the one last plotted .)

To move between the currently selected data and all previously

plotted sets :

Click the arrow icons .

fril ` To toggle between the currently selected data and the
I''~I

	

previous selection :

Click the toggle box icon .

You can use these features to identify a set of data target charts (which
will be replaced when replotted) or to plot a different set of data with
an existing chart format . For more information on using existing data
sets to plot new charts, see "Replotting a chart" later in this chapter .



Identifying data associated with an existing chart
If you are working on a slide and need to change the data in its chart,
you can go directly to the relevant set of data in Persuasion's data sheet or
in an external data sheet using the "Get data" commands from the Chart menu .

To identify data for a chart from Slide view :

1 . Select the chart whose data you want to view .

2 . Choose one of the following from the Chart menu :

•

	

"Get data" to go to the Persuasion data sheet

•

	

"Get external data" to go to the external file

Persuasion displays the data sheet and selects the data used to create
the chart or table. You can then edit it for replotting .
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Locating the chart from its data
You can go to the chart that was plotted from a particular set of data by
using the "Show" button .

To locate a particular chart from its data :

1 . In the data sheet, click the toggle box or arrow icons in the upper-right

corner to select the data for the chart you want to locate . (You cannot drag-

select it.)

The area next to the arrow icons tells you its chart format and where
the selected data is plotted .
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You can find an existing chart by highlighting its data in
the data sheet using the arrow icons or the toggle box .

2. Click the "Show" button .

3 . To see the slide, click any visible part of the slide to bring the slide in front

of the data sheet or close the data sheet .
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Editing data in the data sheet

Editing in Persuasion's data sheet is like editing data in spreadsheet

programs on the Macintosh . First, you select the data you want to edit,

and then you choose from the commands on the Edit menu .

•

	

To select cells in the data sheet :

Choose one of the following techniques :

To select

A rectangular group of cells

	

Drag diagonally to include the cells you want .

One row or one column

	

Click the row or column number on the data

sheet .

Several rows and columns Click the row or column number and then drag

to include several rows or columns, Or, Shift +

click to extend the selection .

Do this

After you select data, you can :

•

	

add or delete a row or column .

•

	

cut, copy, or move data to other locations .

•

	

edit data in a specific cell .

•

	

To add or delete a row or column :

1 . Click the number at the beginning of the row or column to select the entire

row or column .

2 . Choose "Insert" or "Delete" from the Edit menu .

If you choose "Insert," an empty row or column is inserted above or

to the left of the selection respectively . If you choose "Delete," the

selection is deleted .
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To move or copy data to a new location :

1 . Select the data that you want to move or copy .

2. To move the data to a new location, choose "Cut" (Command + X) from the

Edit menu. To duplicate the data at a new location, choose "Copy" (Com-

mand + C) from the Edit menu .

3. Click the cell where you want to move or copy the data .

4. Choose "Paste" (Command + V) from the Edit menu .

To add, change, or delete data in a cell :

1 . Click the empty cell where you want to add, replace, or delete text .

2. Enter new information, type over existing information, or press Delete .

Rep/oiling a chart
After you have edited the data in a data set, you need to replot the chart .
You can use the "Replot" button any time a target chart is specified in
the top right message area of the data sheet . (If the target chart is itali-
cized, "Replot" is not available .)

If you modify the chart using commands from the Chart menu while
the data sheet is active and a target chart is specified, the changes will
not be put into effect until you use the "Replot" button . The same
changes made in Slide view go into effect instantly without replotting .

To replot a chart :

1 . Select the chart you want to replot in Slide view and choose "Get Data"

from the Chart menu . Or, in the data sheet, select the data you want to

replot by clicking the arrow icons .

You cannot drag-select the data and produce the same effect .

2. Edit the data, change the selection range, or make selections from the

"Chart" menu .

3 . Click the "Rep lot" button .

If the data you've selected for replotting is different than the original
data for the selected chart, a message notifies you of the change .



Plotting a new chart from existing data

You can use the data already in your data sheet to plot other charts-
you do not need to re-enter the data . For example, you may want to
use the same set of data for a chart with a different format, or you
may want to use only the totals in a complex set of data to plot a
summary chart .

To plot a new chart from existing data :

1 . Go to the slide for the new chart, and open the data sheet .

2 . In the data sheet, drag to select the set of data or the portion of a data set

that you want to plot .

r Plot I

	Sdles Presentdtiori :Work area	

2 3
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Platting data using the format of an existing chart
If you like the way you have customized the format of a chart, you can
apply that format directly to a new chart, rather than define it as a cus-
tom chart format .

To plot a set of data using the format of an existing chart :

1 . Go to the slide on which you want the chart to appear .

2 . In the data sheet, click the arrow icons until the highlighted data set has

the format you want listed next to the arrow icons . Or, if you previously

selected this set, use the toggle box icon to move directly to it .
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Stacked column chart or page 1 4
Current

	

Projected

Pacific Rim

	

3%

	

046:
TOTAL

	

746 :

	

14%

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . .

Costs

	

570

	

705

	

739
Margin	f	5700	0620	~. .1. $a .
Expenses	8O	ga	100 :
Net Profit

	

245 :

	

306'

	

504'

his Year
F:rv?nur

	

1140

3. Drag to select the new data you want to plot using the previous format .

(Enter it first, if necessary .)

Sales Presentation :Work area

Replot IIShow .Sty k ;'ak~u7ur cf r'f	 P 't~G1 I `n
14

The chart format information next to the arrow icons becomes italicized if it is not associated with
the currently selected data, but it does indicate the format for the new chart you are plotting .
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4 . Click the "Plot" button .

Persuasion plots the selected data to the target slide, using the chart
format from the other location .

5000

4000

3000

2000

1000

0
Revenue Costs Margin

The Year After

p Next Year

∎ This Year



Tin .
If you add enough text at a
large enough size to a label on
the vertical axis, it may wrap to
the next line and overwrite the
label below it . To correct the
problem, select the chart on
the slide, choose "Get data,"
and then click "Replot." The
label line lengths are extended
and no longer wrap .

Modifying your chart on the slide
You can change the format of a chart in a variety of ways on the slide
whether it is a placeholder or an independent chart . (Although you
typically make these changes after you plot your chart in Slide view,
you can make the changes using commands from the Chart menu
before you plot your chart from the data sheet .)

Editing chart labels and table data on the slide
Changes made in Slide view to chart labels or to table text and labels
flow back to the data sheet .

•

	

To edit labels on a chart :

1 . Select the text tool .

2 . Click where you want to insert text, double-click where you want to replace

text, or drag-select the text you want to change .

Edit as you would any text .

3 . Type the new label .

Pack R im. . .. . . . . . . . . . .. . . .. . .. . . . . .. .

Australia

Europe

North America

0% 2% 4% 6% 8% 10%12%14%16%18%

0% 2% 4% 6% 8% 10%12%14%16%18%
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To edit text or data in the table :

1 . Select the text tool .

2 . Click where you want to insert text, double-click where you want to

replace text, or drag-select the text you want to change .

Edit as you would any text .

3 . Type the new text or data .

When you select the pointer tool again, the table is
reformatted to accommodate the new text .

ThisYear NextYear TheYearAfter
The Year
Before

Revenue 1140 1568 1843

Costs 570 705 739

Margin 570 862 1106

ThisYear NextYear

~-
~The

The YearAfter
Year

Before
Revenue 1140 1568

.
r'	:

Costs 570 705 739

Margin 670 862 1108

ThisYear NextYear The YearAfterl .€

Revenue 1140 1568 1848

Costs 570 705 739

Margin 570 862 1108



Chart
Chart format
Overlag format id Graphic 1

•

	

Pie Format
!d Column Format

4' Pie
•

	

Bar
•

	

Stacked bar

!J!t Column
l! Stacked column

•

	

tine
•

	

Area
•

	

Scatter
III High-low
•

	

Table

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

RHes
Numbers

Show depth
(Show arris
./Show plot from
/Show legend
Show value lab

Get data

Redraw chart

Define formats

Changing the chart format
You can change the type of chart you have by selecting it and choosing
a different format from the "Chart format" submenu . If you change the
format in Slide view, your chart is reformatted immediately .

•

	

To change the format of your chart :

1 . Select the chart .

2 . Choose "Chart format" from the Chart menu, and then choose a new for-

mat from the submenu .

Your chart is replotted according to the change in chart format .
(If you make this change from the data sheet, you need to click
the "Replot" button for the chart to be replotted .)

For more information about chart formats, see "Choosing a chart
format" earlier in this chapter .

Changing the axes
Sometimes you may want to switch the axes on your chart . For ex-
ample, your labels may be too long to be readable on the category
(horizontal) axis, so you can make that axis vertical . You can also
make other changes to the axes, such as the format of tick marks .

•

	

To change options for chart axes :

1 . Select the chart .

18%

North America Europe Australia Pacific Rim

	. . . . . . . . .. .
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2 . Choose "Axes" from the Chart menu . Then choose an option from

the submenu :

Option

Switch axes

Grid/Tick options . . .

Value axis format . . .

	

Lets you change the plot range, tick mark spacing,
and scale of the value axis . (See the Value axis
format dialog box that follows this procedure .)

Pacific Rim

Australia

Europe

North America

0% 2% 4% 6% 8% 10% 12% 14% 16% 18%

"Switch axes" and "Grid/Tick options . . ." were used to change the chart shown in Step 1 into this one .

Category axis format . . .

Description

Turns a chart on its axes .

Lets you change the grid lines and tick marks on a
chart and turn them on or off . (See the Axis grid/
tick options dialog box that follows this procedure .)

Lets you change the plot range, tick mark spacing,
and scale of the category axis for scatter charts .
(See the Category axis format dialog box
that follows this procedure .)

Rows are series

	

Lets you choose rows as data series .

Rows are categories

	

Lets you choose rows as categories .

3 . If necessary, click "OK ."

Label options . . .

	

Lets you specify how much of your selected data
consists of labels (category and series) rather than
data . (See Setting label options following this
procedure .)

Note: The first four options are not applicable to pie charts .



Outside tick mark

Setting grid/tick options
You can control the display of major and minor grid lines and tick
marks without modifying the chart in any other way . If all the grid and
tick options are turned off, "Show plot frame" on the Chart menu can
be used to display the outside frame of the chart .

Rrris grid/tick options

Ualue axis :
® Show major grid

Show minor grid
Outside tick marks
Inside tick marks

The grid is an extension of the tick marks .

Pacific Ririn

Australia

Eura Pe

North America

0% 2%

Category arris :
Show major grid
Show minor grid
Outside tick marks

LI Inside tick marks

~~..~	~...

% 6% 8% 10% 12% 14% 16% 18%

Inside tick mark

OK

Cancel

Only effective for scatter charts

Major grid

Minor grid
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Setting the value axis format
You can modify the plot range of the value axis or change the spacing
of the tick marks in the "Value axis format" dialog box . Normally, the
plot range and tick mark spacing are automatically generated by the
numbers in your data sheet . If, for some reason, you care to extend or
alter the plot range or change the tick mark spacing, you can enter the
numbers you want here . You can also have values expressed logarith-
mically rather than in linear terms on the value axis .

Value aHis format

Plot range :

Maximum

Minimum

Tick mark spacing :
Major

Minor

Scale :

	

Linear

15

-10

5

1

® Auto

•

	

Auto

•

	

Auto

•

	

Auto

Logarithmic

OK

Cancel

Setting the category axis format
This command works the same as the "Value axis format . . ." command,
except it is only available for scatter charts .

Category arils format

Plot range :
Ma HImum

Minimum

6

a

Tick mark spacing :

Major

Minor

Scale : ® Linear

1

0 .2

N Auto

•

	

Auto

• Auto

• Auto

0 Logarithmic

OK

Cancel



Top row of data sheet used as labels -

Left column of data sheet used as labels

Setting label options
Usually Persuasion regards the left column and the top row of the
selected data in your data sheet as the labels for the two axes of your
chart. If, however, one or both of them consist of numbers (for ex-
ample, years), Persuasion will need clarification that you do indeed
want these values regarded as labels and not values for plotting . In
this case, the "Label options" dialog box automatically appears so that
you can indicate your preference .

Label options

labels in : Z Top row
----~ Left column

Hold Option keu down to get
this dialog when plotting .

OK

Cancel

An infrequent use for the "Label options" command is to create a pie
chart without labels . By selecting a single column of numerical values
in the data sheet, choosing "Pie" as a chart format, and clicking "Plot,"
you can cause the "Label options" dialog box to appear . (If you are
replotting data from an existing chart, click "Replot" while holding
down the Option key to get the "Label options" dialog box .) Make
sure neither box is checked, and click "OK" to plot the pie chart with-
out labels . Keep in mind that since you have no labels, you will
not have a legend either .
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Formatting numbers on axes or in a table
You can change the format of numbers in a chart without retyping them .

To format numbers displayed on a chart axis or in a table :

1 . Select the chart or table .

2 . Choose "Numbers" from the Chart menu, and then choose either "Value

axis . . ." or "Category axis . . ." from the submenu .

"Category axis . . ." is available only for scatter charts .

Value axis number

	

OK

Format : ® General
Fixed

	

'j Percent
0 Currency

Negative values :

Decimal places :

0 Scientific

123 0t1231

fl Commas0

Cancel



3 . Choose from the following formatting options displayed in either the

"Value axis number" or "Category axis number" dialog boxes :

Option

	

Description

General

	

Shows numbers as you entered them on the data
sheet . This is the default option .

Fixed

Currency

	

Places a currency sign before numbers on
your chart . Click "Currency," and then enter the
number of decimal places you want in the "Deci-
mal places" field (typically two) .

Scientific

	

Displays numbers in scientific notation .

Percent

	

Shows numbers as a percentage .

Negative values

Decimal places

Commas

	

Inserts a comma every three digits in numbers
of four digits or more .

4 . Click "OK."

Sets a fixed number of decimal places . Click
"Fixed," and then enter the number of decimal
places you want in the "Decimal places" field .

Shows negative numbers with a minus sign
or parentheses .

Displays numbers with the number of decimal
places you specify .
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Changing the chart symbols
On scatter, line, or high-low charts, you can specify the type of symbol
you want to represent the data point .

To change the symbols used to plot data on a line, scatter, or
high-low chart :

1 . On your chart, double-click the data series you want to change .

-r

Ameiiim12

n European
10

I}

3

	

81 '35

	

Sr'

	Data series selected
.a .

2 . Choose "Symbols" from the Chart menu, and then choose the symbol you

want from the submenu .

∎.∎

. .

,r U

∎

∎ . ∎ ,11

\ ∎∎



Showing various features of a chart
You can show or hide various features of a chart, such as its plot frame,
its legend, and its value labels. You can also give a chart a three-dimen-
sional look by choosing "Show depth ."

•

	

To show a chart's features :

With a chart selected, choose these commands from the Chart menu to

turn features on or off :

Command

Show depth

Show axis

Show plot frame

Show legend

Show value labels

When selected, shows the

Table or chart in three dimensions .

Axes, plot frame, labels, grid lines, and marks, if
tick and grid options are on .

Top and right side of plot frame . Toggles off if all
tick and grid options are off .

Chart legend .

Data values beside the bars in bar or stacked bar
charts, and above the columns in column or
stacked column charts .
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Enhancing your chart
Charts are graphic objects that you can move, resize, and enhance with
special effects . You can subselect parts of a chart to add special effects .
In fact, you can make most enhancements by subselecting, rather than
ungrouping a chart . You only need to ungroup a chart for unusual
enhancements .

Selecting and subselecting
You handle charts and tables as you would any other object on a slide ;
therefore, the rules described in Chapter 3 for selecting slide objects
apply to charts and tables as well . In addition, you can manipulate parts
of a chart or table by subselecting :

•

	

any graphical part of a data series, such as the top or side of a col-
umn that shows depth in a column chart .

•

	

labels, headings, legends, or legend items .

•

	

grid lines and axes .

Once subselected, a part may be enhanced using the Effect menu .

To select a chart or its parts :

Choose one of these options :

To

Select a chart

Select a subset of a selected chart

	

Double-click one object in the subset .

Select a subset of a subselection

	

Triple-click the object if you haven't
selected a subset or, if you have,
double-click the object .

Do this

Click within the chart .



Ungrouping and regrouping
You can ungroup your chart or table to manipulate parts of it that
cannot be subselected . For example, you may decide to move a single
column of a column chart . To do this you would ungroup the chart,
make the change, and then regroup .

Note : Before ungrouping, you should save your work . Any attribute
changes made to the chart while it is ungrouped will be lost .

Moving or resizing a chart
The rules described in Chapter 3 for moving and resizing objects also
apply to charts and tables .

•

	

To move a chart :

Select the chart, point anywhere inside it, and then drag it to a new

location .

•

	

To resize a chart :

Select the chart, point to a handle, and then drag to resize .

In addition, you can use modifier keys as you would to resize graph-
ics. Shift maintains proportions ; Option lets you resize from the
center of the object .

Tables cannot be resized in height, only in width

•

	

To move a legend or a piece of a pie chart :

Subselect the chart part, and then drag it to its new location .

Pacific Rim

North America

Australia

Europe
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If you add a lot of text to a table, or if the text does not flow as you
prefer, you can change the width of the table columns .

1 . Triple-click to select the individual boundary .

2 . Drag the boundary to where you want it .

The text in the column will flow to fill the new column width .

When you drag a column boundary to a new place,
the text rewraps in the new column width .

Current Projected

North America 11% 17%

Europe k

	

4% 14%

Australia 7% 13%

Pacific Rim
Ii

3% 8%

Current Projected

North
Ame rica

11% 17%

Europe R

	

4% 14%

Australia 7% 13%

Pacific Rim
U

3% 8%



Redrawing a chart
If your chart doesn't look right after you change its attributes or resize
it, try redrawing the chart .

To redraw a chart :

1 . Select the chart .

2. Choose "Redraw chart" from the Chart menu .

Applying special effects
Charts and tables are graphical objects . Therefore, you can enhance
charts and tables using the following special effects .

Line style, pattern, and color
You can define the line style, pattern, and color for all lines on a chart
or table, or any lines that you can subselect . Use the "Line style," "Line
pattern," and "Line color" commands from the Effect menu as de-
scribed in Chapter 3, "Working on Slides ."

$100

$80

$60

$40

$20

$0
This Year Next Year The Year After

- Stock x
K® . Stock Y

Stock Z
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Fill pattern
You can choose a fill pattern for anything you can subselect on a chart
or table . Use the "Fill pattern" command from the Effect menu as de-
scribed in Chapter 3, "Working on Slides ."

45 [I0

4[I00

?5 I] J

II IIIJ

	 500

1500

1000

50 LI

0

Shadow and shadow color
You can add a shadow to a table, but not to a chart . Use the "Shadow"
and "Shadow color" commands from the Effect menu as described in
Chapter 3, "Working on Slides ."

This (ear

This Year Next Year The Year After

Net r

	

r The`fearAfter

504



Text
You can change the font, size, style, alignment, and color of any text
you can subselect on charts and tables . Use the "Font," "Size," "Style,"
and "Color" commands from the Text menu as described in Chapter 3,
"Working on Slides ."

Graduated fill pattern
You can use graduated fills selectively to enhance charts and tables .

Graduated fills have been added to one of the data series in this stacked column
chart, to the rectangle below the chart, and to the slide background .
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Flip

You can flip charts vertically and horizontally . Use the "Rotate/Flip"
command from the Draw menu as described in Chapter 3, "Working
on Slides."

Slide layering
You can send anything that you can subselect to a separate slide layer .
For example, a bar chart with each bar assigned to a different layer will
build in a slide show bar by bar .

For more information about slide layering, see Chapter 3, "Working
on Slides."
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Chapter 5: Using Color

Color is so compelling that you'll probably use it for every presentation
you create with the exception of black-and-white overheads . Color
makes sense for on-screen presentations, for 35mm slides, and (if you
have a color printer) for color overheads .
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Understanding color in Persuasion
Persuasion lets you apply a wide range of colors to text, graphics, and
slide backgrounds . You have 200 colors to choose from on a Macintosh
Plus, Classic, or SE, and up to 16 .8 million colors to choose from on a
Macintosh II or LC and up .

If you print in color, you are limited to the colors that your Macintosh
and output device can produce . The Macintosh Plus, Classic, and SE
can produce only eight colors when printing to most color output
devices . But if you take a color presentation created on a Macintosh
with a black-and-white monitor and produce it on a Macintosh with a
color monitor, you can produce any of the 200 colors you may
have applied .

You'll use three features to apply color in Persuasion : the working set,
the color grid, and the custom colors you mix . While the working set
displays the 16 (or fewer) colors used most often in a presentation, the
color grid and the custom colors offer the full range of colors available
on your Macintosh .

7eciding on a medium and an output device
The form that your presentation takes, from flip charts to projected
35mm slides, influences how you'll produce your presentation . Be-
cause the colors produced in the final version of your presentation
depend on the capabilities of the output device, your chosen medium
influences how you'll actually use color .

Your options for medium and output include :

•

	

printing to paper and overhead transparencies on a color printer .

•

	

processing 35mm slides and overhead transparencies through a
Persuasion-compatible service bureau .

•

	

producing 35mm slides from a Persuasion-compatible film recorder
connected to your Macintosh .

•

	

presenting online slide shows on your color monitor or projected
onto a video projection screen .



In each case, you'll need to know what colors your output device is
capable of reproducing . Since a color monitor only gives you a close
approximation of how colors will look in your finished work, you may
want to be more exact .

To assist you in determining how the colors you see on your monitor
actually appear when they are produced, we have added a presentation
to the Persuasion disk set called "Colors ." Each of the 200 colors in
Persuasion's standard color grid is displayed over four different slides,
each with its own identifier . You can produce this on your output
device to see exactly how it interprets these colors .

Many factors can cause variations between displayed color and printed
or projected color:

•

	

Colors may appear brighter when projected from slides and
overheads, and darker when printed to paper .

•

	

The type of paper or film you use can affect the color of final output .

•

	

The environment in which you give your presentation, particularly
the light source, can change the look of color on paper .

Depending on the output device you print to, the Macintosh Plus,
Classic, and SE computers may only produce the standard QuickDraw
colors-black, white, red, green, blue, cyan, magenta, and yellow .
If you're using a 16-color monitor, check the manual for the output
device you're using to ensure that the final color output will suit
your needs .

You can create color presentations even on a black-and-white monitor,
but the colors you apply appear as black, white, and patterned shades
of gray. However, when you produce that presentation on a color
device-monitor, printer, film recorder-the color you applied
is reproduced .

When printing from a color monitor to a black-and-white printer,
the colors are converted to shades of gray based on the brightness and
saturation of the colors . Because different colors may convert to the
same shade of gray on the printout, consider changing colors to patterns
before printing in black and white, or use the "Proof print" option to
print black text and white fills .

For more information on producing a color presentation, see Chapter 7,
"Producing a Presentation ."
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Choosing a color scheme
Although color can easily enliven a presentation, it can also detract
when used indiscriminately . Defining a color scheme for your pre-
sentation is one way of controlling and using color effectively . A color
scheme in Persuasion is a set of up to 16 compatible colors that you
put in your working set to apply consistently throughout a presentation .

You have two primary ways of defining a color scheme ;

•

	

You can use one of the color Persuasion AutoTemplates, each of
which has its own color scheme .

•

	

You can create your own color scheme in your working set .

Using Persuasion's color AutoTemplates
The easiest way to create a color presentation is to let Persuasion create
it for you . By opening one of Persuasion's 43 color AutoTemplates,
you already have an attractive and colorful presentation under way .

To help you choose the most appropriate AutoTemplate for your pur-
poses, the Persuasion AutoTemplate Gallery Card provides representa-
tions of the 43 color AutoTemplates .



Color commands

Creating your own color scheme
You can define the colors in each presentation's working set by using
the "Define colors . . ." command. Persuasion provides a default working
set of eight colors, but at any time you can customize the working set,
adding up to eight more colors . Each of the color AutoTemplates has
16 customized colors in its working set .

If you consistently use the colors from the working set for the various
elements in your presentation, your presentation will be built around
the color scheme the working set provides .

The working set of colors in your scheme are available in three places :

•

	

The submenus of the color commands from the Effect menu
("Line color," "Fill color," "Shadow color," "Line background,"
and "Fill background")

Effect

Line style
Line pattern
Fill pattern
Shadow

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . .. . . . .. . . . . . . .

Line color
Fill color
Shadow color
line background

	

1
Fill background

	

1
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . .. . . . . . . . .

Set colors . . .
Define colors . . .

Effect
Line style
Line pattern
Fill pattern
Shadow

. . . . . . .. . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Line color

	

1

1
1
1
1

1
1
1
1

1
1

Fill color
Shadow color
Line background

	

1
Fill background

	

1
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Set colors . . .
Define colors . . .

1
1

White
Red

Elue

Yellow
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . .

Other . . .

White

IYW4

RS3

VT4
eu4

IGY8

Rc
. . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . .

Other. . .

Default working set from
a black-and-white Auto Template

Customized working set
from a color Auto Template
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•

	

The submenu of the "Color" command from the Text menu

•

	

The pop-up menus in the "Set colors" dialog box ("Set colors . . ."
from the Effect menu) and the "Color" pop-up menu in the "Text
format" dialog box ("Text format . . ." from the Text menu)

In each of these locations, the working set is the same, and in each
working set the color for the currently selected element is indicated by
a checkmark . If nothing is selected, a black diamond marks the default
color for that command .

Set colors

Tent :

Fill :

Line :

Shddow :

Fill background :

Line background : White

0

0

OK

Cancel

white

Red

Blue

Yellow
. . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . .

Other. . .

The working set defines the color scheme for your presentation .

- Color currently applied to lines

- The working set
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or:

Use color in a presentation sparingly
to highlight your most important
points or enhance your overall
message . Excessive use of color
can do more harm than good .

Generally, warm colors-reds,
yellows, oranges-tend to be more
exciting, while cool colors-blues,

Applying colors
You can apply color to almost anything you can select, except an EPS
graphic . The selected object or text block has several features to which
you can apply color : the background of a fill pattern, the shadow, the
line, and so forth .

Applying color from the working set and the color grid

The quickest way to apply color is to choose colors from the scheme
established in your working set . As you work with color, you may
want to apply colors not currently in the working set. To apply colors
from the larger color grid, choose "Other . . ." at the bottom of the
working set .

To add new colors to the working set, see "Editing the working set"
later in this chapter .

greens, violets-tend to be more
calming . Warm colors are usually better
used as accents, in small doses, while
cool colors can be used more freely .

Be sure you consider legibility when you

use color in text . For example, yellow
type on a white background is difficult
to read, while yellow type on a black

background is very easy to read .

For slide backgrounds, favor dark
colors and solid patterns .

Try to combine colors harmoniously
in radial and graduated fills . Two
tones of the same color (for
example, a light blue and a
dark blue) blend well .
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Effect
line style
line pattern
Fill pattern
Shadow

.. . . . . .. . . . . . . . . .. . . . . . .. . . . . . . . . .. . . . . . . . . . .. . . . . . . . .. . . . . . . .. . . . .. . . . .. . . . .. .
Line color 1
Fill color 1
Shadow color 1
Line background 1
Fill background

Set colors . . .
Define colors . . .

Five color
commands
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To apply a color from the working set :

1 . Select the objects and text blocks to which you want to apply a color .

2. Choose one of the color commands from the Effect menu, and then choose

a color from its submenu .

.
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Line background (white part of a line pattern)

Line color (foreground)

This is a rectangle filled with a pattern, bordered by a wide, patterned line, and given
dimension by a shadow . It contains a text block with its own line and fill pattern .

Fill color (foreground)

Fill background (white
part of a fill pattern)

Shadow color
(foreground)



Effect
Line style 1
Line pattern
Fill pattern
Shadow

1

1

Line color

	

1
Fill color
Shadow color
Line background

	

1
Fill background

	

1

Set colors . . .
Define colors . . .

1
1

Bl .ac:k:

(White

Red

Blue

Yello

. . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . .

Other . . .

Two-letter abbreviations for each color

Color grid

•

	

To apply a color from the color grid :

1 . Select the objects and text blocks to which you want to apply a color from

the color grid .

2 . Choose one of the color commands from the Effect menu that has the

working set as its submenu .

Or, in the "Set colors" dialog box, click the appropriate color box to
display the working set .

3 . Choose "Other . . ." from the working set submenu .

One of the "Select . . . color" dialog boxes appears, containing the
color grid . Notice that the four columns on the right are slightly
separated. These 40 custom colors can be edited on a Macintosh II
or higher, as explained in "Editing the custom colors" later in
this chapter.

Select fill color

GY RD OR YO YW LG ON AQ CY LB BU VT LA MG RS WI !AA BB CC DD
g noooooonnnnflcnnoao
8 nn onnnEfi [ ][ 	o
7 rlooonf~T	fluflfln

r
4

	

®

	

Li'

2

	

®®

OK

Cancel
. . .

Degrees of brightness in the color grid are numbered from 0 (darkest) to 9 (brightest) .

4. Click the color you want to apply . Or, double-click the color to apply it and

close the dialog box in one step .

5 . Click "OK."

Click "OK" in the "Set colors" dialog box, if necessary .

Custom colors
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€i . i l lfk S

Define formats . . .

V Black

eea

Other. . .

F Yellow

A checkmark indicates the color

currently applied to the selected text .
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4nnlvina color to tex
You can apply color to any text that you can select . You can select as
little as a single character using the text tool or up to several text blocks
using the pointer tool .

You apply color to text using these commands on the Text menu :

•

	

Use "Color" when color is the only text attribute you want
to change .

•

	

Use "Text format . . ." when you want to change other text attributes,
such as font, size, and style, along with color .

To color text usinathe "Color" command :

1 . Select the text to which you want to apply color . Or, click an insertion point

where text with the new color will be entered .

2 . Choose "Color" from the Text menu, and then choose a color from the

working set on the submenu . Or, choose "Other . . .," and then choose a

color from the color grid .

For choosing colors outside the working set, see "Applying color from
the working set and the color grid" prior to this section .

Text

Font 1
Size 1
Style 1
[:olor 1
Alignment 1

Twit format . . . ~&T
Line spacing . . .
Bullet marks
Show text ruler



To color text using the "Text format . . ." command :

1 . Select the text to which you want to apply a new set of text attributes .

Or, position an insertion point where text with the new attributes will

be entered .

2 . Choose "Text format . . ." from the Text menu .

Tent format

font:

Size:

Style : ®Plain
LI Bold

Enample :

18

Times

Color :

The quick brown fox . . .

Blue
fl Italic

	

Outline
0 Underline Li Shadow

OK

Cancel

The text in the sample box takes on the attributes you select in the
"Text format" dialog box .

3 . Choose a color from the "Color" pop-up menu of the working set,

or choose "Other . . ." to go to the color grid .

As necessary, make changes to the "Font," "Size," and
"Style" options .

4 . Click "OK ."

Sample box
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Tent format. . .

	

€T
line spacing . . .

'Bullet marks
'Show text ruler

Define formats . . .

Oa~~BoD
®aodi7m ; s
Superscript 4 H
Subscript 4?~&I
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Applying color to a text shadow
If you're using a Macintosh II and a color printer, you can create an
eye-catching effect by giving selected text a shadow, and then applying
one color to the text and another color to its shadow . (The Macintosh
Plus, Classic, and SE display and print the standard Macintosh
"Shadow" style, but not in color .)

You can control the distance that shadows are cast by choosing "Prefer-
ences . . ." from the File menu . For more information, see Chapter l,
"Persuasion Basics ."

To create a colored shadow for text :

1 . Select the text you want shadowed . Or, click an insertion point where you'll

be typing shadowed text .

2 . Choose "Style" from the Text menu, and then choose "Shadow" from

the submenu . Or, choose "Text format . . .," click to check "Shadow" for

"Style," and then click "OK ."

3 . Use the pointer tool to select the text block containing the shadowed text if

it is not already selected as a block .

4 . Choose "Shadow color" from the Effect menu, and then choose the color

you want to apply from the working set . Or, choose "Other . . ." to display

and choose from the color grid .

Text

Font
Size 1
Stgle
Color

1
1

Plain
'Bold

Alignment 1 Itolir
Underline 4~U



Effect
Line style

	

1
Line pattern

	

1
Fill pattern
Shadow 1

Line color 1
Fill color 1
Shadow color 1
Line background 1
Fill background

	

1

Set colors . . .
Define colors . . .

None

000

Horizontally graduated
fill pattern

Vertically graduated
fill pattern

Applying color to radial and graduated fills
In Persuasion, you can fill an object with a two-color radial or
graduated pattern .

P To apply a two-color radial or graduated fill pattern to objects :

1 . Select the object you want to enhance with a radial or graduated fill .

2 . Choose "Fill pattern" from the Effect menu . Then, from the submenu,

choose one of the patterns from the bottom row .

The pattern you choose is applied to the object . Persuasion blends
the fill color into the fill background color .

3. As necessary, choose "Fill color" (black in the pattern) and "Fill back-

ground" (white in the pattern) from the Effect menu, and then choose the

colors you want to apply from the working set . Or, choose "Other . . ." to

display and choose from the color grid .

For this pattern

Radial pattern

Horizontally graduated pattern

	

The color you want at the leftmost edge of
the graphic from "Fill color," and the color
you want at the rightmost edge from "Fill
background"

Vertically graduated pattern

	

The color you want at the top of the graphic
from "Fill color," and the color you want at
the bottom of the graphic from "Fill
background"

Choose

The color you want at the outer edge of the
graphic from "Fill color," and the color you
want at the center of the graphic from "Fill
background"
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Applying color by default
You can set color defaults so that color is automatically applied to
the text and graphics you create . To set presentation defaults, make
selections from menus using the pointer tool without anything selected .
You can also use the "Set colors . . ." command from the Effect menu
to set color defaults . The sample box in the "Set colors" dialog box
shows the line, fill, shadow, and background colors that you can
specify, as well as the current default patterns for lines, fills, and shad-
ows. You can also see current settings for patterns at the bottom of the
toolbox . For more information on presentation defaults, see Chapter l,
"Persuasion Basics ."

h Tnset mintdefaults with the "Set cninrs . . ." cnmmand

1 . Select the pointer tool, making sure all objects in the presentation

are deselected .

If an object is selected, the changes you make in the "Set colors"
dialog box apply only to it and do not establish a new default .

2 . Choose "Set colors . . ." from the Effect menu .

The check boxes indicate which defaults you have changed and
the new colors that will be set when you click "OK ." Clicking to
uncheck a box cancels the changes you've made to the default color
(although the color does not change back to the original until you
close and reopen the dialog box) .

Set colors cz OK[ : an cel

A check indicates a new default is selected ; clicking to remove
the checkmark cancels the new default .

Current default colors

sample box

Tent : White h

Fill :

ILine :

	

Yellow

Shadow : L n

Fill background : LIP hit e I
Line background :



Working set

Color grid

3 . Click the color boxes for each element you want to change, and then

choose the new color default for that element from the working set .

The color you choose appears in the color box .

4. Click "OK ."

Customizing colors
You can customize your working environment with regard to color in
two main ways :

•

	

By establishing your color scheme in the working set

•

	

By defining the custom colors

The working set of up to 16 colors contains the color scheme for your
presentation of frequently applied colors . The custom colors are colors
you can "mix" from the millions available in the Apple color picker
and are available in various dialog boxes next to Persuasion's standard
color grid .

You can customize the working set, including the addition of custom
colors, so that your presentation's color scheme reflects a particular
corporate identity .

Note : Any changes you make to the working set or to custom colors
changes the colors of existing objects .

Define colors

Color:

rnmmm
8nnnnnnnnnnnn
6	nnnn

nU l .L .

∎ y

	

//
/∎∎∎

Black

R.d

OK 1

Cancel

New

[Remove

Custom colors

Sample box
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Currently selected color from
working set

Location in color grid of selected color

192 ∎ Aldus Persuasion User Manual

Editing the working set
You can make changes to the working set by replacing a color, remov-
ing it, renaming it, or adding a new color. Select the working set color
that you want to edit from the "Color" pop-up menu in the "Define
colors" dialog box . The selected color is outlined in the color grid .

Define colors

Color : 6Y0
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0 •	 U..

Rename : 6Y0

OK

Cancel
. . . .. . . . . . . . . . . . . . . . . . . .. . . . . .
New

Remove

Replacing a color in the working set

You can replace any color in the working set with a custom color
or a color from the color grid . The working set immediately reflects
this change .

To replace the currently selected color in the working set :

Choose "Define colors . . ." from the Effect menu, click any color in the color

grid or in the custom colors, and then click "OK."

When you select a new color on the grid, Persuasion identifies the
color by the two-letter abbreviation and number that designates its
location on the grid (the color's hue and brightness) .



Removing a color from the working set
You may want to shorten your working set to a simpler color scheme
from the 16 colors you are allowed to have .

t To remove the currently selected color from the working set :

1 . Choose "Define colors . . ." from the Effect menu .

2. Select the color you want to remove .

3. Click the "Remove" button .

4 . Click "OK."

Renaming a color in the working set
If you want to change the color designation in the working set to some-
thing you find easier to work with, you can rename it. This can be espe-
cially useful for distinguishing custom colors from the 200 colors in the
color grid.

To rename a color :

1 . Choose "Define colors . . ." from the Effect menu .

2 . Choose the color you want to rename from the "Color" pop-up menu of the

working set .

3. In "Rename," type the new name .

Define colors

	

!

	

OK

Color : L Yellow Rename : flu reus
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. //

Cancel
.. . . . . . . . . . . . . . . . . . . .. . . . . .
New

[Remove

4. Click "OK," or click the "Color" box to change the name without leaving

the dialog box .

Chapter 5: Using Color ∎ 193



194 ∎ Aldus Persuasion User Manual

Adding a color to the working set

If the working set already contains 16 colors, you will not be able to

add to it. You can, however, remove colors to make room for new ones,

or you can simply replace colors in the working set as described above .

To add a color to the working set :

1 . Choose "Define colors . . ." from the Effect menu .

2. Click "New," and then click a color from the custom colors or the color grid

to add it to the working set .

The new color and its three-character name appear in the "Color"

box. The sample box to the right of the grid also displays the

new color.

If "New" is not available, you need to remove a color from the

working set, so you can add another .

3. To continue adding colors, repeat Step 2 .

4. Click "OK" when you've added all the colors you want to the working set .



Effect

Line style 1
Line pattern 1
Fill pattern

	

1
Shadow

	

1
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . .

Line Color

	

1
Fill color
Shadow color
Line background

Set colors . . .
Define colors . . .

1
1
1

Fill background

- Five color
corrirnands

Black

~'rrhite

Red;,. . .

Blue

Yelloi

Other. . .

Editing the custom colors
The four columns on the far right in any of the "Select . . . colors"
dialog boxes contain 40 colors that you can modify on a Macintosh II
or higher.

Note : Unlike changes in the working set, changing a custom color alters
the color of objects to which it has already been applied .

r To edit a Color using the Apple color picHer on a Macintosh II :

1 . Choose one of the following from the Effect menu :

•

	

Choose "Other . . ." from one of the working set submenus of the
five color commands .

•

	

Choose "Set colors . . .," and then choose "Other . . ." from one
of the working set submenus of the six color commands in the
dialog box .

•

	

Choose "Define colors . . .

2. Click on a custom color from the four columns on the right .

Select fill background color

i
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OK

Cancel

Edit . . .kJ

Custom colors
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3 . Click "Edit . . ." and do one or more of the following :

Pick a Color

Hue

Saturation

Brightness

Red

Green

Blue

39714

23337

56280

36239

43535

56280

+I

Cancel ,~ C( OK	?1

1 .5

•

	

To change the color's hue, hold down the mouse button as you
move the pointer around the color wheel, or point to the appropri-
ate arrow, and hold down the mouse button to increase or de-
crease the hue .

•

	

To change the color's saturation, hold down the mouse button as
you move the pointer toward or away from the center, or point to
the appropriate arrow, and hold down the mouse button to in-
crease or decrease the saturation .

•

	

To change the color's brightness, move the pointer up and down
in the scroll box to the right of the color wheel, or point to the
appropriate arrow, and hold down the mouse button to increase
or decrease the brightness .

As you adjust the color value, the edited color appears in the top half
of the sample box .

You can also enter color values directly . Double-click the value you
want to replace, and then type a new number . When you click else-
where, the new color value will appear in the sample box .



4. Click "OK."

The new color appears where you clicked in the custom colors .

5 . In the "Select color," "Define color," or "Set colors . . ." dialog box,

click "OK."

The modified color is now one of the custom colors . The new cus-
tom color is applied to any currently selected objects, as well as to
any objects that were previously assigned the custom color from
that location .

Importing color graphics
Using Persuasion's "Paste" and "Import . . ." commands, you can work
with color graphics created in other applications . Persuasion imports
color graphics saved in PICT II and Encapsulated PostScript (EPS)
formats with the following limitations :

•

	

You cannot change the colors imported with the graphic or edit the
graphic's individual parts . However, you can manipulate each im-
ported color graphic as a unit (for example, move or resize) .

•

	

Persuasion displays each imported color by converting it to the
closest matching color in the current presentation's set of custom
colors or the color grid . (You can edit the custom colors to match
those of the graphics you plan to import, so that Persuasion displays
the graphics' original colors .) When you print the presentation, the
graphics appear with their original colors, provided your output
device can reproduce them. For details, see "Editing the custom
colors" immediately preceding this section .

For more information on importing graphics, see Chapter 3, "Work-
ing on Slides ."

Note : You can apply color to imported, ungrouped black-and-white
PICT graphics created on a Macintosh Plus, Classic, or SE .
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Chapter 6: Creating Masters

Persuasion uses slide masters to control the look of the slides in your
presentation . Slide masters contain placeholders that specify where the
text will go, what font and type size it will be, and so on . Slide masters
can also contain graphics, which then appear on every slide .

You can work successfully with Persuasion and never create a master
yourself. As long as you start with one of Persuasion's AutoTemplates,
you can rely on its slide, handout, and notes masters to take care of
formatting the main parts of your presentation .

However, if you want a presentation with a distinctive look-or
even if you want a slightly modified version of one of Persuasion's
AutoTemplates-you need to know how to create masters . Learning
how to work with masters gives you creative control of your presenta-
tion. Saving the masters you create as an AutoTemplate lets you pro-
duce customized presentations for yourself or your organization .
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Creating an AutoTemplate

An AutoTemplate is a set of slide masters that you use as the basis for

presentations . Persuasion comes with 83 AutoTemplates in a variety of

designs and set up for different output devices .

If you find that an existing AutoTemplate does not meet your needs,

you can either alter it, or you can start from scratch and create an en-

tirely new AutoTemplate . You may want to modify an existing Auto-

Template, or you may only need to add a few slide masters to it . If you

want a unique AutoTemplate, however, you will want to start from

scratch in creating a new set of masters saved as an AutoTemplate .

The AutoTemplates packaged with Persuasion contain seven slide masters .

Aurora Kayaks
(Aurora
•

	

A New Kayaking Experience
Aurora Kayaks
•

	

Lightweight but tough
•

	

Midrange in price
•

	

A promising investment
i

	

Fabric Characteristics
Light

•

	

St rin•

	

pe,,, .
O The IJN
O Price F

L

	Inter

A presentation usually contains a set of slide masters, plus an outline and slides .



A quick way to start a
"new" Auto Template

You can get a head start on
creating a "new" AutoTemplate

by opening the default

AutoTemplate (choose "New"

from the File menu) . Unless

you specified otherwise during

installation, the default

AutoTemplate is one that has

a plain design, is set up for
black-and-white overheads,

and contains the usual seven

slide masters . Most of the

setup tasks are already

accomplished, so your task

is primarily one of modifying

what you find in the default

AutoTemplate. You need to

save it and name it (as in Step

6 in the procedure in "Starting

an AutoTemplate from

scratch," which follows. Then

you can proceed to add slide

masters or background

masters, or to modify the

ones you have, as explained in

"Modifying an AutoTemplate"

later in this chapter .

Save
Save as . . .

Import . . .
Rut oTemp1at
[Hp0rt . . .

Page setup .
Print . . .
Slide show . . .
Preferences . . .

Aurora I and II

New h.yak: s frurn Oceanus Corporation

Slide from the default AutoTemplate

Starting as AutoTemplate from scratch
Before you create an entirely new AutoTemplate, you'll need to decide
its purpose : will it be used to produce overheads, 35mm slides, or
on-screen presentations? You need to answer this question first for
two reasons :

•

	

Your presentation is targeted from the beginning to a particular
output device selected in the Choosey .

•

	

The shape of the "slide" that you'll work with is determined by the
output device .

For more information on setting up presentations or AutoTemplates,
see "Starting a presentation from scratch" in Chapter 1
"Persuasion Basics ."
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To set up and name a new AutoTemplate :

1 . In the Choosey, select the output device you will use to produce presenta-

tions based on the AutoTemplate you are about to create .

2 . Double-click the Persuasion icon in the Persuasion folder .

3. Hold down Shift, and choose "New" from the File menu .

You have opened a blank presentation containing only one blank
master and equipped with the original application defaults .

For information about Persuasion's initial defaults, see Appendix A .

4. Choose "Page setup . . ." from the File menu, and then click "OK" in the

"Page setup" dialog box to see the "Presentation setup" dialog box .

The "Page setup" dialog box is specific to the output device cur-
rently selected in the Choosey .

Fractional character spacing :
® On (better for printing) cj' Off (better for eHportl

Clicking "Page . . ." takes you back to the "Page setup" dialog box .

5. Select a slide shape, and then click "OK."

This setting defines the ratio of width to height of the slide shape .
The default setting is determined by the output device selected in
the Choosey .

Note: You must select the appropriate slide shape now before you do
any other work. If you change the slide shape later, the positions of
the text and graphics on each slide may need to be adjusted .

6. Choose "Save as . . ." from the File menu, and then type the name of your

new AutoTemplate in the text box .

It helps to include the word AutoTemplate or AT in the name so that
you can tell the nature of the file at a glance in a list box .

Presentation setup OK

Slide shape :

	

Overhead C' 35mm slide C' Screen

	

Cancel
0 Custom: 10 .14 by 7 .60 inches

Page . .
Outline margins in inches :

Left 1 .17 Right 1 .15

Top 0.97 Bottom 0 .96

Handouts: Q 1 0 2 Q 3 cij 4 C) 6 slides per page



7 . Click "AutoTemplate," and then click "OK."

By saving the file as an AutoTemplate, you have determined the
way it will open in the future . When you double-click to open a file
saved as an AutoTemplate, a copy of it opens, thus protecting the
original . Saving any file as an AutoTemplate (rather than as a pre-
sentation) protects it from inadvertent alteration . (You can always
specify that you want to open the original AutoTemplate if you
want to modify it.)

Creating slide masters
If you have created an AutoTemplate from scratch, you are now ready
to start creating slide masters .

To create the first slide master in a new AutoTemplate :

Choose "Go to master" from the View menu, and then choose "Master 1"

from the submenu .

A blank slide master appears, and you can begin creating masters . A
master can include elements such as placeholders, imported graph-
ics, drawn objects, and color and/or pattern backgrounds .

To add a slide master to an AutoTemplate :

1 . Choose "Go to master" from the View menu, and then choose "New . . ."

from the submenu. Or, in Master view, choose "New . . ." from the Master

pop-up menu in the lower menu bar .

2 . For "Master name," type the name of the new slide master .

New slide master

Master name :

Based on :

Master 2

Master 1

Orientation :

	

) C<„

	

® ;Izi£x

OK

Cancel
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Background masters

To go to the slide master
applied to the selected slide,
hold down the Option key while
you click the Slide view icon .
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3. For "Based on," choose the existing master that will serve as the basis for

the new master from the pop-up menu, or choose "None ."

If you choose "None," your new slide master will be a clean slate
without a background and without placeholders . In addition, the
"Orientation" option becomes available .

Note : If you create a new slide master based on a slide master with a
background master applied, the "Tall" and "Wide" options in the
"New slide master" dialog box are dimmed .

I New slide mast

Master name :

Based on :

Orientation :

None
r Bact:yraund
Title L o(kgrnund
Title
Terrt 1
TeHt 2
Graphic 1
Org Chart
Graphic. 2
Master 1

C: an cel

4. For "Orientation," select either "Tall" or "Wide ."

5. Click "OK."

Either a copy of the master that the new one is based on appears, and
you'll need to delete the placeholders you do not want before adding
the appropriate ones; or, if you specified "None," a blank slide master
appears . For information on adding placeholders, see "Adding place-
holders" later in this chapter .

Slide masters



None
Buckgrnund

/ Tide berkgrnund
Assign background roaster to slide master

Controlling the background of a slide master
No matter what you based your slide master on, you can change its
background by either assigning a different background master or by
creating a background on the slide master itself .

A background master provides a way to have a consistent graphic back-
ground for your slides without having to create it separately for each
slide master.

For information on creating background masters, see the next section,
"Designing background masters ."

To apply or remove a background master :

1 . Go to the slide master .

2. Choose a background from the Background pop-up menu in the lower menu

bar, or choose "None" to remove a previously applied background master .

The names of background masters are italicized on the Master pop-
up menus to distinguish them from names of slide masters .

t To create a background on the slide master itself :

1 . Go to the slide master whose background you want to create .

2. Choose "Slide background fill . . ." from the Master menu .

Set slide background fill

® Use fill from background master

Pattern :

Color 1 :

Color 2 :

Black

White

OK

Cancel

If your new master is based on "None," no background for it exists, and
"Use fill from background master" will also be dimmed, not checked .
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Colors black part of pattern

Colors white part of pattern
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3 . For a solid background, choose the color you want from the "Color 1" pop-

up menu . For a patterned background, choose the fill pattern you want from

the "Pattern" pop-up menu, and then choose its colors from the "Color 1"

and "Color 2" pop-up menus .

Once you choose a new fill pattern or color, "Use fill from back-
ground master" is no longer checked . To reassign the background
master, click to check "Use fill from background master ." To assign
a different background master, see the procedure immediately prior
to this one .

Set slide background fill

Use fill from background master

Pattern:

-Color 1 :

Color 2 :

Graduated fills

4 . Click "OK."

For more information on creating a background, see "Designing back-
ground masters," later in this chapter .

Note : If you have a background master assigned, you need to change the
orientation at the background level by selecting or deselecting "Tall
orientation ."

OK

Cancel



ng which fill
is dsn

What happens when your slide
master has a fill, and you apply a
background master that has a
different fill? Persuasion lets you
control which fill takes precedence
by using the "Slide background
fill" command from the Master
menu . If "Use fill from background
master" is checked, your slide
master will use the fill from
whatever background master is
currently applied, even if the slide
master has its own fill .

Master I witii /ts car tr
background lilt

Background master

applirriSlide with Master
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Designing background masters
A background master is a standard background that can be applied to
any or all slide masters . In a sense, the background master is a master
for slide masters . The background master can contain imported graph-
ics, drawn objects, and text, and can be filled with a pattern or color .
Your Persuasion presentation can have any number of background
masters, which you can apply to individual slide masters .

A background master can be applied to one or more slide masters .

l°ay6ac.F,a9lr~=-T,~oyears•

/e~~~cefio/her
Sa6/~/e acefio/dei

Tit/e~~ace~o%ei
Bay/er/,v~~ce/ro/dei



All presentations-even when you start from scratch-contain at least
one background master (unless you specifically delete it) . Your first
step, then, if you are starting from scratch, is to enhance the blank
background master . After that, you can create additional background
masters if you choose .

To modify an existing background master:

1 . Choose "Go to master" from the View menu, and then choose "Back-

ground" from the submenu to modify an existing background master .

The names of background masters are italicized in the menus to
distinguish them from slide masters .

2. Choose "Slide background fill . . ." from the Master menu .

3 .

Set slide huckground fill

';J :

Pattern :

[:olor 1 :

[:olor 2 :

6Y2

White

OK

[:dnCeI

Create your background by selecting the following options :

"Pattern"

	

Applies the background pattern . Note that the top
four rows on the pattern submenu will print as
shades of gray on a PostScript output device and
as intensities of a color on a QuickDraw color
output device .

"Color 1" Applies color to the foreground of the slide mas-
ter . For non-solid patterns, the color you choose
here corresponds to the part that appears black in
the "Pattern" pop-up menu .

"Color 2" Applies color to the background of the slide mas-
ter . For non-solid patterns, the color you choose
here corresponds to the part that appears white in
the "Pattern" pop-up menu .

4. Click "OK."
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Tip ;

A quick way to move from any
view to the background master
for a selected slide is to hold
down both the Option and
Command keys while clicking
the Slide view icon in the
upper-right corner of the
window .
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5. Add design elements or text using the Persuasion tools or by importing text

or graphics .

Keep in mind that this is the backdrop for your slides, so it's advis-
able to keep it relatively simple and open .

•

	

To create additional background masters :

1 . Choose "Go to master" from the View menu, and then choose "New back-

ground. . ." from the submenu. Or, from Master view, choose "New

background . . ." from the "Go to slide master" pop-up menu .

New background master

Master name :

Based on :

Background 2

None

Orientation : Q Tall ® Wide

OK

Cancel

2. Type a name for the new background master .

3. To use an existing background master, use the "Based on" pop-up menu to

select which background master you want to use .

If you base one background master on another, all the elements from
the existing background master will appear on the new one . These
elements are copies of the originals, so you can edit or delete them
without affecting the original background master .

4. Click an "Orientation" for the background master .

The orientation you give the background master is passed on to the
slide masters to which it is applied, overriding their orientation set-
ting if it is different .

5 . Click "OK."
If not based on another background master, a blank background
appears . Otherwise, a copy of the background master you are basing
this one on appears . Next, follow Steps 2 through 5 in the procedure
immediately before this one to complete the background master.



Controlling slue orientation

Applying a background master to a
slide master changes the slide
master's orientation to that of the
background master . Once a back-
ground master is applied, the
background master controls a slide
master's orientation just as it takes
precedence over a master's fill pattern .

In this situation, when you go to the
slide master, the "Tall orientation"
command on the Master menu is
dimmed, since orientation can be
changed only on that slide master's
background master . Similarly, if you
create a new slide master based on a
slide master that has a background
master applied, the "Tall" and "Wide"

options in the "New slide master"
dialog box are dimmed .

If a slide master has no background
master applied, the slide master will
use its own orientation, which can be
changed in Master view using the
"Tall orientation" command on the
Master menu .

Displaying slide backgrounds
Persuasion always displays the smoothest background fills possible
when running the slide show . You can display smooth backgrounds in
Slide view also, though it may affect performance .

If you are using a 24-bit monitor in 24-bit mode, Persuasion automati-
cally sends 24 bits of data to the screen, resulting in the display of very
smooth fills . But if you are using an 8-bit monitor, use the following
procedure to see smooth backgrounds displayed in Slide view .

To display smooth background fills in Slide view :

1 . Choose "Preferences . . ." from the File menu .

2 . Click to check "Fine background fill," and then click "OK."
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Renaming and removing slide masters
You can change the collection of slide masters in an AutoTemplate by
renaming or removing individual masters .

To rename or remove slide masters :

1 . In Master view, choose "Define masters . . ." from the Master menu .

2. Select the slide master or background master you want to remove or re-

name from the list box .

3. To rename the selected master, type the name you want in the "Rename"

edit box .

4. To delete the selected master, click the "Remove" button .

Any slide master you select will be removed even if it is assigned to
a slide . When a slide master that is assigned to a slide is removed,
the default slide master will be assigned in its place .

5. Click "OK."

You can also add new slide masters from the "Define masters" dialog
box by clicking the "New . . ." button to get the "New slide master"
dialog box . Then follow the procedure outlined in "Creating slide
masters" earlier in this chapter .



Adding placeholders
Placeholders act as markers that define the size, format, and location of
text and charts on your master. Information that flows into the place-
holder automatically assumes the assigned position and takes on the
characteristics that you specify .

Placeholders also create the dynamic link between your slides and
either the outline or the data sheet . Any change you make to the text
that flows into a title, body text, table, or chart placeholder is automati-
cally reflected in the appropriate part of the presentation . For example,
if you change a number in a table on your slide, the number also
changes in the data sheet. If you edit placeholder text on your slide,
the change appears in the outline .

There are nine types of placeholders :

•

	

Title

•

	

Subtitle

•

	

Body text

•

	

Chart

•

	

Table

•

	

Organization chart

•

	

Slide number

•

	

Slide copy

•

	

Notes text
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Master
Add title
Add subtitle
Add body teat
Add chart . . .
Add table . . .
Add org . chart . . .
Add page number. . .

sl€€ ?

. . . . . .. . . . .. . . . .. . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . .
~~~It ~1€3€' (3~€9€ ;E3~IE~Iti£31',, .

Slide background fill . . .
<ti r

	

itx

	

<1 i~ r
. . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . .. . . . . . . . . . . . . . . . . . . .. . . . .
Re-create from slide . . .
Define bullet marks . . .
Define masters . . .
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Title placeholder
The text attributes and location you give the title placeholder are auto-
matically transferred to slide titles on slides .

To add a title placeholder :

1 . With the slide master on the screen, choose "Add title" from the

Master menu .

Persuasion adds a title placeholder to the slide master .

a This is a Title Placeholder . a

The title placeholder is initially set to be centered, Helvetica, 36-point type .

2. If necessary, reposition and modify the placeholder .

To

Reposition

Change the width

Do this

Drag to the new location .

Grab a side handle and drag to the
desired width .

Change font, size, style,

	

Use commands from the Text menu .
or text color

Add a fill pattern, shadow,

	

Use commands from the Effect menu .
or text block color

Note : Placeholders must be added using the "Add . . ." commands on the
Master menu. They can not be added by copying and pasting them from
other locations .



Subtitle placeholder
Like Persuasion's other placeholders, a subtitle placeholder is dynami-
cally linked to the outline, and text can flow in either direction . For
subtitle text to flow automatically from the outline to the slide, you
must have a subtitle heading for the slide in the outline . For information
about creating a subtitle in the outline, see Chapter 2, "Outlining ."

To add a subtitle placeholder :

1 . With the slide master on the screen, choose "Add subtitle" from the
Master menu.

A

	

si

	

t .

This is a Subtitle Placeholder .

	

r

The subtitle placeholder is initially set to be centered, Helvetica, 24-point type .

2. Position the placeholder where you want the subtitle text to appear on

the slide .

3 . Format the placeholder text in the same way you formatted the title

placeholder .
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Level 1 default :
24-point Helvetica bold

Levels 2 and 3 defaults :
18-point Helvetica

Levels 4. 5, and 6 defaults :
14-point Helvetica
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Body text place/wider
In addition to formatting the text placeholder as you do the title and
subtitle placeholders, you can change a text placeholder's size by
removing individual paragraphs from it . You can also change its
bullet styles .

To add a body text placeholder :

1 . With the slide master on the screen, choose "Add body text" from the

Master menu .

•

	

This is a Body Text placeholder,
•

	

Change font for each level .

Anchor and resize the box .
•

	

Set tabs, indents and alignment
•

	

Slides will follow . . .
	 i n kind .

The body text placeholder is initially set to different type specifications at each level .

2. If necessary, reposition or modify the placeholder in the same way that you

formatted the title placeholder by resizing or using commands from the

Text and Effect menus .

3 . Use the text tool to edit the placeholder text by cutting or clearing one or

more levels .

You can undo these actions only by using the "Undo" command ; text
that has been cut cannot be pasted back into the text block . You can
delete the placeholder by adding a new one .



Level 1 selected----

You can change a bullet symbol and its color only on a slide master,

where you specify bullet attributes by level . For example, all Level 1

bullets could be red stars from the ITC Zapf Dingbats® font . All Level

2 (subordinate) bullets could be blue and use the standard Helvetica

round bullet .

To define the symbol and color of bullets for a body text

placeholder :

1 . With the body text placeholder on the screen, choose "Define bullet

marks . . ." from the Master menu .

Define bullet marks

Font :

[:010 r :

Apply to all bullets

Bullets :
	Level 1

level 2 •

	

Level 5

Level 3 •

	

Level 6

Zapf Dingbats

White I

Level 4

COKJ

[:anceI

2. In the "Define bullet marks" dialog box, select the bullet level whose font

or color you want to change .

If you want the font and color changes to apply to all bullet levels,

check "Apply to all bullets ."

3. Select the font for the bullet symbol from the "Font" pop-up menu, and

then type the appropriate key combination to produce the symbol you want .

Use the Key Caps desk accessory to identify key combinations to

get the bullet symbols you want in a particular font . (Refer to your

Macintosh documentation for further information) .

4. Select the color you want to apply from the "Color" pop-up menu .

5 . Repeat Steps 2, 3, and 4 for each level until all bullet symbols

are specified .

6 . Click "OK ."

The font and color you selected are applied to the bullet symbols

you typed for each selected level .
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Tip :

To delete the bullets for an
individual level, select the level

in the "Define bullet marks"

dialog box, and then press the

Delete key . If you delete bullets

in this way, choosing "Bullet

marks" from the Text menu

does not display them .
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You can turn off the display of bullets in a text placeholder, while re-
taining the definition for them .

To turn off the display of bullets in a body text placeholder :

1 . On the slide master, select the text placeholder .

2. Choose "Bullet marks" from the Text menu .

On a slide, you can display the bullets that are turned off in a place-
holder by choosing "Bullet marks" from the Text menu . The bullets
that appear are defined by the "Define bullet marks" command for that
placeholder.



Master

Add chart . . .
Add table . . .

Add page number. . .

Anchor placeholder . . .
Build layers . . .
Slide background fill . . .
Tall orientation

Re-create from slide . . .
Define bullet marks . . .
Define masters . . .

Chart and table placeholders
After you add a chart or table placeholder, you can modify it in all the
ways that you can modify a chart on a slide . You can resize it, move
it, change its fill patterns and colors, alter its line thickness, give it a
shadow, specify the text characteristics for its labels, and so forth .
If you have already defined a chart format that you like, you can
apply it to the chart placeholder.

To add a chart placeholder :

1 . With the slide master on the screen, choose "Add chart . . ." from the

Master menu .

Note : When you have "Pie" selected as the chart type that will be
plotted, the "Add pie placeholder" dialog box will appear .

Rdd chart placeholder

Default number of categories :

Default number of series :

1

3

OK

Cancel

2. Enter the number of categories and series that you want .

The numbers you specify determine how large the placeholder
should be to save adequate room for the chart, but they do not limit
the number of categories or series you may have in your data sheet .

Categories usually appear as rows in your data sheet ; their labels
appear on the horizontal axis of the chart . Series usually appear
as columns in your data sheet with their labels taken from the
column headings .
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3 . Click "OK."

4. If you want, change the chart type by choosing "Chart format" from the

Chart menu, and then select a chart or table format from the submenu .

For more information about recommended uses for different chart
formats, see Chapter 4, "Charting ."

Chart
Chart format
Due

/5ho
/Silo
./Sho
/ Sho
Silo

Def

LO 1

lGraphic . H

( Pie Format
[!4 Column Format Ii

( Pie
[

	

Bar
[ Stacked bar
L!4 [:olumn
[ Stacked column

Line
Area

[

Lii High-low
Table

LO 2

L10

E L20

Li L30

- Placeho/der format

- Defined chart formats

Standard chart types



5 . If you want, reposition, resize, or modify the placeholder .

To

Reposition

Resize

Add special effects

	

Use commands from the Effect menu .

Change the font and style

	

Subselect the labels, and then use
of labels or text

	

commands from the Text menu .

Apply a defined chart format

	

Choose "Chart format" from the Chart
menu, and then choose the name of he
defined chart format from the subme u

t To add a table placeholder:

1 . Choose "Add table . . ." from the Master menu .

This command is provided as a shortcut . You can also create a table
placeholder by choosing "Add chart . . ." from the Master menu,
and choosing "Table" for its "Chart format" to achieve the same
purpose .

Do this

Add table placeholder

Default number of rows :

Default number of columns :

4

4

OK

Cancel

Drag to the new location .

Grab a handle and drag . To maintain pro-
portions, hold down Shift while you drag .

2 . Enter the number of rows and columns you want .

The numbers specify how large the placeholder should be to save
adequate room for the table . The actual table you plot can have any
number of rows and columns in the data sheet .
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Outer boundary of placeholder-

Maximum box size for this level-
(unless forced larger by excess text)
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3. Click "OK ."

You can reposition or modify the table placeholder using the same
techniques described for the chart placeholder prior to this procedure .

Organization chart placeh older
The handles you see when you select an organization chart placeholder
on a slide master indicate the maximum outer boundaries of any organi-
zation chart based on that placeholder . The size of any individual box
in the organization chart placeholder indicates the maximum box size
for that level . The vertical and horizontal spacing between boxes in the
placeholder indicates the maximum spacing for organization charts
based on that placeholder .

L10 L20 L3['

L01 1 .1 2 .1

L02 1 .2 2 .2 ~ .~

L03 1 .3 2 .3 3 .3



Master
l£I£i 1 fle

~l£l£i S€113€~~~>

Add bodg terrt
Add chart . . .
Add table . . .
Add org. chart . . .
Add page number. . .

l£l£i r £ £z~

	

~ f€

i

	

£ I €>

	

ial€ € :£x

	

£ l£I£x ,, .

Slide background fill . . .
<l!£

	

i£z

	

i<1i£>
. . . . . . . . .. . . . . . . . . . .. . . . .. . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . .

Re-create from slide . . .
Define bullet marks . . .
Define masters . . .

When you enter data into the outline and create an organization
chart based on a placeholder, the new organization chart uses the larg-
est possible dimensions for the outer boundary, the boxes, and the spac-
ing without exceeding the maximums (unless the quantity of text is so
great that exceeding the maximum dimensions is unavoidable) . If nec-
essary, when fitting the boxes into the outer boundary established by
the placeholder, Persuasion may make the boxes and spacing smaller
than those on its placeholder . However, the boxes and spacing will not
be made larger than the dimensions on the placeholder unless the text
quantity forces them to be .

To add an organization chart placeholder :

1 . Choose "Add org. chart . . ." from the Master menu .

2. Fill in the default number of levels and boxes you want, and select a for-

mat for the lowest level .

For best results, choose settings that are as close as possible to the
actual number of levels and headings in the outline .

Note : Levels chosen here do not limit the number of levels for the
organization chart .

Add org . chart placeholder

Default number of levels :

Default number of botres :

3

5

Set lowest level as : `List
Boxed list

j Separate bones

OK

Cancel

The numbers you enter as defaults control the dimensions of your organization
chart placeholder, its boxes, and the spacing between levels .

3. Click "OK."
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Add title
Add subtitle
Add body tent
Add chart . . .
Add table . . .
Add org. chart . . .
Add page number. . .
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Slide background fill . . .
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Re-create from slide . . .
Define bullet marks . . .
Define masters . . .
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4. Resize the organization chart placeholder on the slide master by dragging

a handle .

You can resize the outer boundary of the placeholder by dragging its
handles. For optimum results, try to size the placeholder to the pre-
cise size you need for your organization chart .

5. Position the organization chart on the slide master, and enhance it using

the commands from the Effect and the Text menus .

For information about working with organization charts, see "Adding
an organization chart" under "Assigning masters in Outline view" in
Chapter 2 .

Slide number placeholder
If you've ever dropped a stack of overheads, then had to put them back
in order, you will appreciate Persuasion's slide number placeholder . A
slide number placeholder can be added to a slide master and a notes
master, but not to a background master .

To add a slide number placeholder to a slide master :

1 . With the slide master on the screen, choose the "Add page number . . ."

command from the Master menu .

2. Position the placeholder where you want the page number to appear on

the slide .

mXXi

3. Format the placeholder text using the commands from the Text menu . Or,

add fills, colors, patterns, and shadows to the slide number using com-

mands from the Effect menu .

The appropriate number appears on the slide when you switch to
Slide view, Slide Sorter view, Notes view, or when you print the
presentation .



The text is anchored "Center" and "Left,"

The same text is anchored "Bottom" and "Left ."

Anchoring placeholders

When you anchor a placeholder, you are indicating how a title, subtitle,

text, or organization chart placeholder will control the placement of

text within the placeholder's boundaries on a slide. Placeholder text

on a slide expands out from the anchor position . For example, if a text

placeholder is positioned above a graphic on a slide, you can specify

that when text is added to the slide, the text block will expand upward

from the bottom of the placeholder, thus ensuring that text won't flow

over the graphic .

Keep in mind that placeholder anchoring is different from text align-

ment. For anchoring, the frame of reference is the placeholder box ;

for alignment, it's the text block itself. For example, you can have

left-aligned body text anchored at the lower-right corner of the

placeholder box .

After text is added, it expands so that it remains centered vertically,

to the right of the graphic .

After text is added, it expands up and away from the graphic,
instead of flowing down over it .
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To anchor a placeholder :

1 . Using the pointer tool, select a title, subtitle, text, or organization chart

placeholder on a slide master .

2. Choose "Anchor placeholder . . ." from the Master menu .

Rnchor content to placeholder

	

OK

a (! Center

C) Dottom
Left

	

Center

	

C) Right

Cancel

3. Select a horizontal setting ("Left," "Center," or "Right") and a vertical

setting ("Top," "Center," or "Bottom") to anchor the text within the

placeholder .

As you select the vertical and horizontal anchoring options, the sample box
shows you where text will be positioned within the placeholder boundaries .

4. Click "OK."

The placeholder will show the effect of anchoring, and the text will
flow into it from the outline .



Adding other text and graphics
Persuasion lets you draw or import graphics and add text to your slide
master. The objects you add to the master appear on every slide to
which the master is assigned. If you want to add something that will
appear on every slide in the presentation-a logo, for example-you
can add it to the main background master, rather than each individual
slide master. But when you want to customize your text-type slides,
for example, in a different way than you want to treat your chart-type
slides, consider making those changes on the appropriate slide
masters to ensure uniformity .

You add objects to slide masters the same way you add them to slides .
Use the text and drawing tools to create objects and the Text and Effect
menus to enhance them. For more information about adding text and
graphics to slides, see Chapter 3, "Working on Slides ."
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Modifying an AutoTemplate
An AutoTemplate is a collection of slide masters . Aside from altering
existing slide masters, you can modify an AutoTemplate by :

•

	

creating new slide masters .

•

	

importing slide masters .

•

	

re-creating masters from a slide .

Creating a new master
Most of the time when you use Persuasion, you will begin a presen-
tation by opening a copy of an AutoTemplate . Each of Persuasion's
AutoTemplates is a collection of seven slide masters that may or may
not be adequate for your particular needs . Once you have a set of exist-
ing masters with their design and defaults established, it is quite simple
to build variations on them to suit your needs .



® To add a master to an AutoTempiate :

1 . Choose "Go to master" from the View menu, and then choose "New . . ."
from the submenu. Or, in Master view, choose "New . . ." from the Master

pop-up menu in the lower menu bar .

New slide master

Master name :

Based an :

Orientation : (

	

> ll

Master 1

Terrt 1

1€s€€~~:>

OK

Cancel

2. For "Master name," type the name of the new slide master .

3 . For "Based on," choose the existing master that will serve as the basis for

the new master from the pop-up menu, or choose "None ."

4. For "Orientation," select either "Tall" or "Wide ."

Note : If you create a new slide master based on a slide master with a
background master applied, the "Tall" and "Wide" options in the
"New slide master" dialog box are dimmed .

5. Click "OK."

Unless you chose "None," a copy of the master that the new one is
based on appears . You'll need to delete the placeholders you do not
want before adding the appropriate ones . For information on adding
placeholders, see "Adding placeholders" earlier in this chapter .
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Print . . .
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Slide show . . .
Preferences . . .

Quit
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Importing masters
You can import the slide masters, the working set of colors, and
defined text and chart formats from another Persuasion presentation
or AutoTemplate .

To import the masters from another AutoTemplate :

1 . Choose "AutoTemplates . . ." from the File menu .

2 . In the "Select AutoTemplate" dialog box, select the presentation or Auto-

Template whose masters you want to import into the current presentation .

Select RutoTemplate

35mm

0 s01
• s02
• s03
• s04
•

	

s05
0 s06
0 s07
•

	

s0s
• s09
• st0
•

	

s11

4

OK

Cancel
. . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . .. . . . . . . .

F .let t

Desktop J

o Hard Driue

Masters : ® Replace Q Append

	

®Show thumbnail

Thumbnail of a slide
master in selected
Auto Template

A thumbnail version of a master from the AutoTemplate appears at
the lower-right corner of the dialog box . If not, click to check "Show
thumbnail." The master selected for the thumbnail is the one that
appears at the top of the Master pop-up menu in the selected pre-
sentation or AutoTemplate .

Note: In some rare circumstances, there may be insufficient memory
available to save a thumbnail version with the presentation . If the
presentation is later opened and saved in Persuasion when memory
is sufficient, a thumbnail version will be saved with the file .

File
New 8~N
Open . . . 8B0
Close
Data sheet 1



3 . To replace the masters, chart formats, and colors (working set and custom

colors) in the current presentation, click "Replace ." To add the imported

masters to those in the current presentation, click "Append ."

See the following chart for descriptions of the actions that occur
depending upon whether "Replace" or "Append" is selected .

4. Click "OK" to import the new masters . Click "Cancel" to stop the operation

and return to the current presentation .

If the imported masters are a different size from those in the current
presentation, the "Adjust graphics" dialog box will appear . You can
use this dialog box to have Persuasion automatically resize your
presentation . For information on how to adjust graphics, see
Chapter l, "Persuasion Basics ."
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The following chart describes the actions that occur depending upon whether "Replace" or "Append"
is selected .

Slide masters
Background masters

Notes masters

Defined text formats

Colors

Chart formats
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If you choose "Replace"

If an imported master has the same
name as one in the current presenta-
tion, the imported master will replace

the current one .

All slides based on replaced masters
will be re-created .

If an imported text format has the
same name as one in the current pres-
entation, the imported text format will

replace the one in the

current presentation .

The working set with its color names
from the imported presentation will
completely replace those in the current
presentation .

The 40 editable custom colors in the
selected AutoTemplate will replace

those in the current presentation . Each
imported color replaces the color that
was located in the same position in the
custom color grid .

Objects using an old color will be
changed to the new color that now
occupies that location in the grid .

The chart formats in the selected
presentation will replace those in the

current presentation . Existing charts
using formats that have been replaced
will remain unchanged .

Charts originally based on a placeholder
will be replotted based on the new
placeholders on the replaced masters .

If you choose "Append"

All masters will be added to those in the
current presentation .

If an imported master has the same name
as one in the current presentation, the
name of the imported master will be
modified so it can be distinguished from
the master in the current presentation .

The imported text formats will be added
to those in the current presentation . If an
imported text format has the same name
as one in the current presentation, the

name of the imported text format will be

modified so it can be distinguished
from the text format in the current
presentation .

Colors and color names are not imported .

All chart formats will be added to those
in the current presentation .



Re-creating masters from a slide
In Master view, you can revise an existing master using a slide as a
model. Let's say, for example, that you created a detailed slide, then
decided that you would like to use those same elements on a master .
You can create a blank master, then use the "Choose master elements"
dialog box (described later in this section) to specify which elements of
your slide you want to place on the master . Or, you can add elements
from a slide to those on an existing master .

Any graphic element on the slide can be placed as a static object on
the master or ignored (not used on the master) . Text on the slide can be
converted to placeholders or static text on the master, or ignored . Static
elements on the master will appear on every slide to which the master
is assigned .

Re-creating masters from a slide does not create a new master . Instead,
it completely re-creates an existing slide master . If the existing master
is not blank, this process adds the elements you select from the slide to
those already existing on the master .
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Master
Add title
Add subtitle
Add body teat
Add chart . . .
Add table . . .
Add org. chart . . .

. . . . .. . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . .

Slide background fill . . .
Tall orientation

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Re-create from slide
Define bullet marks . . .
Define masters . . .

Slide pop-up menu
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To re-create an existing master :

1 . Create a new, blank master or go to the master that you want to re-create .

2. Choose "Re-create from slide . . ." from the Master menu .

Choose master elements

?Ydi:i:~ :!M,

	

:

1 .~

	

. . ..! .!~H .~R°	~'

	

.: .. .~ . : . . .t	y:!::E`: .58,. •
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Slide 5 	D Create master from this slide

Slide uses created master

Help

Q^ K H

Cancel
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I
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:i

The sample box shows a slide from the current presentation minus its background master .

3. Select the slide from the Slide pop-up menu in the lower-left corner to

display in the sample box the slide whose elements you want to use on

the master .

4. Check "Create master from this slide ."

5 . In the sample box, select the text that you want to use as a model for the

title placeholder, and then click "Title ." Repeat for each of the other

place holders .

There can be only one placeholder of each type on the master . Each
placeholder on the master will be placed in the same location as the
text you selected on the slide . The placeholder will have the same
text attributes (font, size, and so forth) as the text you selected .

Note : Persuasion initially designates every element on the slide as a
static object, so unless you specifically change an element to some
other status, it will be moved to the new master as a static object .

6. If there is an element on the slide that you do not want to appear on your

new master, select the element, then click "Ignore ."

To see only those elements you have designated to appear on your
master, check "Hide ignored items .

Sample box



Newly created master applied --

Slide that new master is created from

7 . To see what status is assigned to which element, click a "Show" button .

The "Show" button for a given element type is available if there is
at least one element of that type on the slide . Clicking the "Show"
button for a particular element type selects any elements of that type
in the sample box. This feature allows you to see the status you have
assigned to a particular element . All elements start out as static
objects ; therefore, until at least one element has been assigned a
different status (e .g ., subtitle), only the "Static" "Show" button
is available .

8. If you want to change the slides that the re-created master is applied to,

start at the beginning of the pop-up menu and go through each slide,

checking "Slide uses created master" for every slide to which you want

to apply the new master .

Choose master elements

Slide l
Slide 2
Slide 3
Slide 4
Slide 5

-Slide 6
Slide I

Create master from this slide

Slide 9

	

Slide uses created master

Help

(1 > ,€ .,€ f2 i,

S

Cancel

0 >i €S< €€F€?€3 $'~i €<>.'€€ S

l

SI';€3€~ ;

All slide names are in italic unless the slide was used to create a master
(underlined, normal type) or uses the new master itself (normal type) .

9. When you have finished choosing elements for the master, click "OK"

to re-create the master. To cancel without re-creating the master,

click "Cancel ."

If you click "OK," Persuasion re-creates the master, using the ele-
ments you specified . Body text elements will be added to the outline
as well as placed on the appropriate slides, and static objects will be
removed from the slide and placed on the master .
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Defining slide builds on the master

You define a slide build on the master so that you don't have to do so
on each individual slide . For example, you can automatically assign
boxes in an organization chart placeholder, bulleted items in a body
text placeholder, or columns in a chart placeholder to different layers .
Assigning such a master to a slide creates layers on the slide . Then
during a slide show, the delay between each layer will emphasize
each point .

To define slide builds on a master :

1 . Go to the slide master .

2 . Use the pointer tool to select the text, chart, or organization chart place-

holder
for which you want to define layers .

3. Choose "Build layers . . ." from the Master menu .

Build chart layers

Build : c None
•

	

By series
•

	

By categories

OK

Cancel

Build teHt layers

Build : (i None
C) 1 (fewest number of layers)
C1 2
'3
•

	

4
•

	

5
•

	

6 (greatest number of layers)

OK

Cancel

Org . Chart

0 Build layers for org. charts

OK

Cancel

The dialog box that appears is specific to the type of placeholder you selected .



4. Select how the layers will be created, or return everything to one layer by

choosing "None ."

Note: The organization chart dialog box does not have a "None"

option .

For

	

You can choose

Body text

	

By outline levels, or none

Charts

	

By categories, series, or none

Organization charts

	

By levels

5. Click "OK ."

Use the File menu's "Slide show" command to set the delay between

each layer. For more information about running a slide show or printing

builds, see Chapter 7, "Producing a Presentation ."

Creating notes and handout masters

By setting up the notes and handout masters, you can prepare note

pages for yourself and handouts for your audience . Referring to

speaker notes as you show your overheads or slides can be a big help,

especially with longer presentations . Handouts, which contain min-

iatures of your slides, help your audience to follow your presentation

and to remember it afterward .

Each AutoTemplate that comes with Persuasion includes predesigned

notes and handout masters .

Creating the notes master

Each slide has a speaker notes page that is formatted by the notes mas-

ter. You create the text of your speaker notes in the outline as you cre-

ate your presentation-or you can create notes using the text tool on

each notes page . The notes master typically contains a slide title place-

holder, a notes text placeholder, and a slide miniature . Notes text, like

slide text, can be independent or governed by the notes text place-

holder. For more information on creating speaker notes, see Chapter 2,
"Outlining

."
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To create a speaker notes master :

1 . Choose "Notes master" from the View menu, or hold down Option while

you click the Notes view icon .

2. Choose "Add title" from the Master menu .

A title placeholder appears on the master . As with any slide master,
you can choose "Anchor placeholder . . ." from the Master menu to
anchor the title within the placeholder . You can also format the title
placeholder using any of the commands on the Text menu, resize it
by dragging a side handle, or add effects from the Effect menu .

3. Choose "Add slide copy" from the Master menu .

A miniature of a slide appears on the master . If you want, use
the pointer tool to select the slide miniature and drag it to a new
location .

4. Choose "Add notes text" from the Master menu .

A notes text placeholder appears on the Notes master that you can
reposition and resize by dragging a side handle . The notes text
placeholder will provide formatting information for notes text
added in the outline or to dynamic text added to the notes page .

This is a Title
Placehclder .

;lice title

•

	

Notes Text placeholder.
	 C ha n~ bnt to eac h lead .

Anchaendr iaethebac
S.k GM, irdrkn rd 1~Qxncrl

Sfd nvcI ldlav. . .
	 I nktd



5. Format the placeholder text by selecting the text by level using the text

tool and then choosing from the commands on the Text menu .

If you want to accommodate a large number of words, reduce the
type size to allow more text to fit on the page . If you type more text
into the outline than can fit on the notes page, the text will flow off
the bottom of the page .

6. Use the text tool to add any static elements to the notes master, such as

time, date, and the title of your presentation .

Defining the handout master
Persuasion's handouts show miniature versions of each slide in your
presentation . Handouts can help the audience to follow along during
your presentation .

The first step in creating handouts is to use the handout master to define
the number of slide miniatures that you want to appear on each
handout page .

To define the handout master layout :

1 . Choose "Page setup" from the File menu .

2. Click "OK" in the "Page setup" dialog box to display the "Presentation

setup" dialog box .

Fractional character spacing :

® On (better for printing] 0 Off (better for eeport)

Chapter 6: Creating Masters ∎ 241

Presentation setup OK
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Outline margins in inches :
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3 . In "Handouts," specify the number of slide miniatures you want to appear

on each page .

You can choose to display up to six slides per page . The default
is four .

4. Click "OK."

5. Choose "Handout master" from the View menu .

6 . Use the text tool to add any static elements to the handout master, such as

time, date, and the title of your presentation .

As with speaker notes, you can add graphic elements to your hand-
outs by using the drawing tools or by importing clip art .

Aurora Presentation

∎

+ti

Handout
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Chapter 7: Producing a Presentation

You've done it-you've created your presentation, and now you're
ready to produce it and view the final product . The step you took at the
beginning-choosing an output device in the Choosey-prepared you
for this moment. Now, you need to know how to produce your presen-
tation on that output device-you can print overheads on a color printer
or a black-and-white printer, send 35mm slides to a film recorder, or
save a presentation file to disk for production at a service bureau with
high-end equipment .

Preparing for production
Before you get started, it's a good idea to preview your presentation in
an on-screen slide show and to review your notes and handouts .

Using the slide show to preview your presentation
Persuasion's slide show lets you preview your presentation on the
screen before you print it . Looking at your presentation during the slide
show is particularly helpful for noting inconsistencies in the placement
of elements that are repeated from slide to slide .

To run the slide show :

1 . Choose "Slide show . . ." from the File menu .

Slide show

	

I

	

OK

Show :

	

~ All ij Current
Q From 1

	

to 9
Save

Cancel

Options :

	

Full screen ® Continuous cycle
Start Persuasion in slide show

Slide advance : Hutomatic

Delay between slides :

Delay between layers :
Default transition effects :

First layer:

Other layers :

2

1

{ Manual

seconds

seconds

None

None
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Sometimes when you preview

the slide show, you may see

slides that need rearranging .

Go to Slide Sorter view, and

then drag slides around to get

immediate visual feedback as

you reorder them .
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2 . For "Show," select "All" to show all the slides, select "Current" to show

the currently selected slide, or enter numbers in the "From" and "to"

boxes to show a range of slides .

3 . Click to check any or all of these "Options" :

Full screen

	

To see the slide show in a full-screen display . If

unchecked, the slide show appears in the

presentation window .

Continuous cycle To display the slides in a continuous loop that is,
upon reaching the last slide, the show starts from
the beginning again .

Start Persuasion

	

To automatically launch the slide show when you

in slide show

	

open a presentation file . For more information, see
"Automatic launch" later in this chapter .

4 . For "Slide advance," select "Automatic" to advance through the slides

and their layers at the time interval you set below, or select "Manual" to

advance using the mouse .

If you select "Manual," click to move from slide to slide and layer to
layer. If you want to see the previous slide or layer, double-click to
go back, and then click to continue . To stop the slide show, press
Command + . (period) .

5 . For "Delay between slides," enter the number of seconds delay (from 0 to

60) you want between slides during automatic advance .

6 . For "Delay between layers," enter the number of seconds delay (from

0 to 60) you want between each of the layers within a slide during

automatic advance .

7 . For "Default transition effects," select the effect you want between slides

("First layer") and the effect you want between all subsequent layers

("Other layers") from the pop-up menus .

For more information on transition effects, see `Setting transition
effects" later in this chapter .

8. Click "OK" to run the slide show and preview your presentation .



Creating speaker notes and handouts
Speaker notes can be a big help, especially when you give longer pre-
sentations. You can refer to the notes as you show your overheads or
slides, detailing facts and figures that do not fit on the slides them-
selves . Handouts that show miniatures of your slides can help your
audience follow along .

With Persuasion, both speaker notes and handouts are automa-
tically created as you put your presentation together . Each of the
AutoTemplates that come with Persuasion has a notes master and a
handout master already set up, so your handouts are created along with
your slides, and your notes pages are prepared as soon as you enter the
notes in the outline .

Viewing your speaker notes
A speaker notes page exists for each slide in your presentation . Each
speaker notes page typically includes :

•

	

a miniature picture of the slide .

•

	

a title .

•

	

notes that are transferred from the outline (or are typed directly on
the notes page) .

The speaker notes master handles the placement of the slide miniature,
the title, and the notes text, as well as design and formatting issues .
For more information on creating a notes master, see Chapter 6,
"Creating Masters ."
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To view and edit speaker notes :

1 . Choose the notes page number from the View menu, or click the Notes icon

in the upper-right corner to go to Notes view of the selected slide .

k ∎IIIII

	

I1UU 1U DI
Rurora Presentation

Notes

Lor ~p'u lubr it lII~, rocs I uir
. BLI?Jx{W eLI > !e1 nY YSLL . .
~ttsmud I1h Mgt u } t &lore m a
il (ui g .t wttt~J . tT wlsJ r>1n sL
Llvn .renU.n;gflsi i*1et1~tkw
t]lwcogrr uscgi Iobadis ill tt il4
e ri comuDLa o Ir tia~ .

2 . Select the text tool, click an insertion point in the existing notes text

(or the dummy text), and edit the notes on the page . Or, add independent

notes text elsewhere on the notes page (for example, as a label on the

slide miniature) .

If you have not added notes in the outline, you can add them on the
notes page by editing the dummy text. When you edit the dummy
text, the notes will also appear in your outline .

You can also import prepared notes by choosing "Import . . ." from
the File menu, selecting a file, and then clicking "OK ."

For more information on adding notes in the outline, see
Chapter 2, "Outlining ."

3 . Reposition any of the items on the notes page the title, the slide minia-

ture, or the notes text-by using the pointer tool to select the item you

want to move, and then dragging it into position .



Creating handouts for your audience
You cannot edit handouts the way you can view and edit speaker notes
or slides; you can only edit the handout master itself. Each handout has
room for up to six slide miniatures . You set the number of slides per
handout page in the "Presentation setup" dialog box . For more informa-
tion on creating a handout master, see Chapter 6, "Creating Masters ."

The handout master contains no placeholders, though you can write
or draw directly on it . Using the text tool, you can type headers and
footers on the handout master, such as a client name, your company
name, and the date .

To add headers or footers to your handouts :

1 . Choose "Handout master" from the View menu .

2 . Select the text tool .

3 . Click an insertion point where you want the header or footer to begin, and

then type .

. . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . .
Avrora: A New Kayaking ExperienceI

That's all there is to it. Now, each handout will have the header and
footer you've typed on the master .
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Producing a presentation
You are now ready for the final step in creating a presentation-pro-
ducing it. Persuasion gives you a wide range of choices for production :

•

	

Black-and-white or color overheads, using desktop printers, such as
the Apple LaserWriter Plus or the LaserWriter II SC

•

	

35mm slides, using desktop film recorders, such as Mirus Film-
Printer or Presentation Technologies Montage FR l, or an outside
slide service bureau

•

	

On-screen presentations, using your Macintosh screen alone or with
your Macintosh hooked up to a video display projector or video
production pad

Note: QuickDraw output devices reproduce EPS-format graphics as
their bitmapped screen representations . Since the resolution of a stan-
dard Macintosh monitor (72 dots per inch) is far lower than the resolu-
tions of most output devices, this may affect the quality of your visuals .
To improve the screen resolution, import the EPS-format graphic at
400%, and then scale it down in Persuasion .

Printing overheads and support materials
Printing can be as simple as choosing the "Print . . ." command and
clicking "OK ." For the most part, Persuasion handles the decisions
for you, using defaults and the design format specifications in the
AutoTemplates .

The "Print" dialog box is printer-specific and depends on the output
device you selected in the Choosey . For now, we'll assume that you are
using a laser printer to create overheads or support materials either in
black-and-white or color .

Color printing technologies include ink jet (e .g ., the Hewlett-Packard
DeskWriter Color Graphics) and thermal transfer (e .g ., the Tektronix
4693D Color Image Printer) . Ink-jet printing is generally limited to
resolutions of 90 to 180 dots per inch . Thermal transfer printing is more
expensive than ink-jet printing but offers resolutions of up to 300 dots
per inch. For color printing, see your printer manual for information on
the options in the "Print" dialog box .



You can also print in either black-and-white or color on a dot-matrix
printer though the results will not be the best for your presentations .
A color dot-matrix printer such as the Apple LQ ImageWriter II uses
several colors on a single ribbon . Probably the best role for any dot
matrix printer is to print proof copies .

Important: When you print directly to overhead transparencies, make
sure to use the transparency film recommended for the printer you
are using .

To print overheads, an outline, notes, or handouts :

1 . Choose "Print . . ." from the File menu .

LaserWriter "LaserWriter I I NTH"

Copies :

Cover Page :

Pages : ® All ':j :' From :

!~ No r ' First Page

	

Last Page

To :

Paper Source : Vii; Paper Cassette C) Manual Feed

Print :

	

Black B White

	

:: Color;'Grayscale

Destination :

	

Printer

Print choices :

	

Slides

Graphic options :

	

Builds

Outline options :

PostScript's File

Outline

	

Notes

	

Handouts

Background fill

	

Proof Print

Visible items only Q Current selection
Hide body teat

	

Q Hide notes
Level icons

	

0Headers

	

Footers

n Print

C:anc:eI

Help

Note : The dialog box that appears when you choose "Print . . ." from
the File menu depends on the output device selected .

2. In "Copies," enter the number of copies you want printed, and in "Pages,"

click "All" to print your entire presentation, or enter numbers in the

"From" and "To" boxes to print a range of slides, outline pages, and/or

notes pages .

3 . In "Cover page," click "No" to not print a cover page, click "First page" to

have the cover page print as the first page, or click "Last Page" to have the

cover page print as the last page .

The cover page lists the name of the author, the application, the title
of the presentation, the date and time the presentation was printed,
and the name of the printer. Printing page ranges or changes in ori-
entation generates additional cover pages .
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4 . In "Paper Source," click "Paper Cassette" to feed paper automatically

from a paper tray as you print, or click "Manual Feed" to feed the paper

into the printer by hand .

5 . If you are printing to a LaserWriter using driver version 6 .0 or greater,

in "Print," click "Black & White" to print in solid black and white . Click
"Color/Grayscale" to print grayscales on a black and white printer, or to
print in color if printing on a color printer .

6 . In "Destination," leave "Printer" selected .

7 . In "Print choices," click to check what you want to print :

Click to check

Slides

Outline

Notes

Handouts

8 . In "Graphic options," click to check how you want slides to print :

Click

Builds

Background fill

Proof Print

To print

A copy of the slides specified in "Pages .

The outline as specified under "Outline options
below .

A speaker notes page for each of the specified
slides .

Handouts containing slide miniatures of your
slides . (The number of slide miniatures printed per
page is set in the "Presentation setup" dialog box .)

„

To print

A copy of a slide for each of its additional slide
layers ; that is, Persuasion first prints Layer 1, then
Layers 1 and 2, and so forth .

Slides with their background fills (the default
setting) . For slightly faster printing, remove back-
ground fills by clicking to uncheck this box .

Slides with black text and white-filled objects for
proofing before final production, particularly
35mm color slides before imaging, and for print-
ing simplified speaker notes and handout minia-
tures . Exception : Imported EPS graphics and
charts retain their fills when printed under this
option .



9 . In "Outline options," click to check how you want your outline printed :

Click

Visible items only

To

Suppress printing of any collapsed items in
the outline .

Current selection

	

Print only the currently selected heading and
its subordinates .

Hide body text

	

Print an outline with no body text headings .
Printed with only slide titles and notes, the outline
makes an excellent script to use during your
presentation .

Hide notes

	

Print an outline with no notes text headings . Print-
ing an outline with both notes and body text hid-
den gives you a top-level summary of the slides in
your presentation .

Level icons

	

Print slide title markers (§) and slide text markers
(-) in the outline .

Headers or Footers

	

Print a header or footer on the outline pages . The
header is the presentation title ; the footer is the
page number .

10. Click "Print" to print your presentation

You can print your overheads on paper and use a copy machine to
transfer them to transparency film . Or, you can put transparency film
in the printer tray and print directly onto it ; however, be careful to
uncheck "Outline," "Notes," "Handouts" and "Proof Print" in the
"Print" dialog box to avoid printing those items on transparency film,

Important : When you print directly to transparency film, make sure to
use the film recommended in your printer manual . The wrong film may
damage your printer .

You've now used Persuasion to create and produce an overhead presen-
tation, complete with speaker notes, outline, and handouts . When you
create 35mm slides or show an on-screen presentation, you will use the
procedure above to print supporting materials, such as the outline (pos-
sibly as a presentation script), handouts, or speaker notes .
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Producing 35mm slides
Once you've organized and designed a presentation to your satisfac-
tion, you can produce 35mm slides with Persuasion-compatible service
bureaus and film recorders . Persuasion-compatible service bureaus
offer state-of-the-art film-recording systems for sharp images at photo-
graphic resolutions, and some also offer custom services . For more
information about using service bureaus, see the guides included in
your Persuasion software package ; outside the U.S. and Canada,
contact your Aldus dealer or distributor .

If you make slide presentations often, consider using an in-house film
recorder, such as the Mirus FilmPrinter . A film recorder connects to
your computer through a port and includes a software driver that you
install . Evaluate the film recorder you plan to use or purchase for com-
patibility with Persuasion . Some film recorders require a Macintosh II ;
others vary in the resolutions they can deliver and in their ability to
produce film formats larger than 35mm . Since each film recorder can
be different, you'll need to follow the instructions that come with your
film recorder to produce 35mm slides .

Note: To produce a presentation in 35mm format, the slide shape option
``35mm" must be selected in the "Presentation setup" dialog box . If you
created your slides with another slide shape selected, you'll have to
readjust objects on slides to conform to the new slide shape .



When you plan and produce your slides, consider the following
guidelines :

•

	

Read the documentation provided with the film recorder or by the
service bureau to determine slide shape before you create your pre-
sentation. The slide shape you specify in the "Presentation setup"
dialog box determines the height and width of your slides . If you
later convert overheads to slides, you may have to use the "Adjust
graphics" dialog box, which may not give you the exact results
you want .

•

	

Run a test slide on the film recorder or through the service bureau to
determine whether the colors displayed on your screen are the same
as the colors that will appear on the slide . The presentation "Colors"
that came in your Persuasion disk set is helpful for this purpose . By
producing it on the film recorder or slide service bureau that you
will be using, you can determine how the colors on your screen
will translate to the slide .

•

	

When you are ready for final production, be sure to uncheck the
"Background fill" option in the dialog box for the "Slide back-
ground . . ." command on the Master menu .

If you are producing your presentation at a slide service bureau,
you may need to print a PostScript file to disk, so you can send them
the disk .

To print a PostScript file to disk using the System 7 .0 printer driver:

1 . Choose "Print . . ." from the File menu .

2 . In "Destination," click "PostScript ® File ."

Level icons

	

:: Headers

	

o Footers

The "Print" button changes to "Save ."
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Print :
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Slides
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Proof Print
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Current selection
Hide body tent

	

Q Hide notes



256 ∎ Aldus Persuasion User Manual

3 . Click "Save" to save the presentation to disk .

4 . Type the name of the PostScript file, and then open the drive and the folder

you want to save it in .

To Service Bureau I
4

Save Disk File Hs :

My Presentation

Hard Drive

Drive

Save

Cancel

5 . Click "Save ."

You can now copy the PostScript file to a floppy disk for trans-
mittal, or you can send it via modem to your service bureau .



Producing on-screen presentations
You can make presentations to small groups on your Macintosh screen
or to larger groups with your Macintosh hooked up to a video display
projector or video projection pad . When you plan and produce your
on-screen presentations, consider the following guidelines :

•

	

Create a presentation using the "Screen" slide shape in the "Presen-
tation setup" dialog box for best results .

•

	

Modify one of Persuasion's AutoTemplates by changing the slide
shape to "Screen" in the "Presentation setup" dialog box and then
using the "Adjust graphics" dialog box to rearrange the graphic
objects and placeholders on the slide masters . The aspect ratios of
"Overhead" and "Screen" are about the same, roughly 2 :3, while the
aspect ratio of "35mm" is 3 :4. Thus, changing slide setup from over-
heads to screen involves fewer changes than from 35mm to screen .

•

	

Click "Full screen" in the "Slide show" dialog box .

•

	

Check to be sure you have the proper size screen fonts installed to
minimize jagged edges in text .

Setting transition effects
Transition effects are special graphic transitions between slides in a
presentation and between the first and subsequent layers of a single
slide . Transition effects can be assigned locally (to individual slides)
or globally (to the entire presentation) .
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Persuasion includes the following transition effects :

Effect

	

What it does

Wipe left The new slide enters from the right edge of the
window, pushing the preceding slide off-screen
to the left .

Wipe right

	

The new slide enters from the left edge of the
window, pushing the preceding slide off-screen
to the right .

Wipe up

	

The new slide enters from the bottom edge of the
window, pushing the preceding slide off the top of
the screen .

Wipe down

	

The new slide enters from the top edge of the
window, pushing the preceding slide off the
bottom of the screen .

To center

	

The new slide fills in the screen from the edges
to the center .

Open curtain "Curtains" draw away to the left and right, reveal-
ing the new slide from the center toward the edges
of the screen .

Close curtain

	

"Curtains" draw toward the center of the screen,
revealing the new slide from the edges toward
the center .

Blinds down

	

Horizontal "blinds" open to reveal the new slide .

Blinds right

	

Vertical "blinds" open to reveal the new slide .

Glitter right

	

A series of small squares cascades across the
screen from left to right, revealing the new slide .

Glitter down

	

A series of small squares cascades across
the screen from top to bottom, revealing the
new slide .

Glitter across

	

A series of small squares cascades diagonally
across the screen from top left to bottom right,
revealing the new slide .

Dissolve

	

Similar to glitter, but smaller squares that cover
the entire screen dissolve to reveal the new slide .

Random

	

Persuasion applies any transition effect at random
from the list of effects in the pop-up menu .



Slide 1

In the "Glitter across" transition effect, a
series of small squares cascades across
the screen, revealing the new slide .

Slide 2
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When you create a presentation, Persuasion automatically assigns
the "Default" effect to each slide . The effect you choose globally for
the entire presentation in the "Slide show" dialog box is applied to
all slides marked "Default ."

You can also assign any effect to an individual slide . Any slide with its
own effect applied is displayed with the local effect rather than with the
global effect.

You can use either a single transition effect for each slide, or use one
effect for the first layer of each slide and a second effect for each sub-
sequent layer .

•

	

To apply a global transition effect to the entire presentation :

1 . Choose "Slide show . . ." from the File menu .

Slide show

Show : ::i) RII C:: Current

C) From 1

	

to 10

OK

Sate

[:ancel

Options :

	

Full screen QI Continuous cycle

Start Persuasion in slide show

Slide adtance : ') Rutomatic

Delay between slides :

Delay between layers :

Default transition effects :

First layer :

Other layers :

Z

C) Manual

seconds

seconds

Wipe down

Glitter across I

2 . In the "Slide show" dialog box, choose "Default transition effects" from

the pop-up menus for "First layer" and "Other layers ."

The effect you choose for "First layer" is applied only to slides
whose setting is "Default ."

The effect you choose for "Other layers" is applied only to slides or
layers whose "Other layers" setting is "Default ."

Note : Only those slides whose transition effect is set to "Default"
will use the global effect .



t To apply a transition effect to an individual slide :

1 . In Outline view, click anywhere in a slide's title or text, or in Slide Sorter

view, select a slide .

2 . From the Transition pop-up menu at the bottom of the window, choose

an effect .

The selected effect will be assigned to the selected slide .

3. If you want the global effect specified in the "Slide show" dialog box to be

applied, choose "Default ."

4. If you want to apply one effect to the first layer and another effect to subse-

quent layers, select "Layers . . ."

Slide show effects

First layer :

Other layers :

Wipe right	I
Dissolve

Q^K 1

Cancel
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5 . Choose an effect from the "First layer" and "Other layers" pop-up menus .

Remember that when you choose "Default" for a layer transition, the
global transition effect for that layer from the "Slide show" dialog
box will be applied .

6 . Click "OK ."

Memory requirements for transition effects
Your computer must have sufficient memory to allow each slide to be
re-created off-screen before transition effects can work . If you are using
a Macintosh Plus or SE, Persuasion requires an additional 25K of
memory for transition effects. If you are using a Macintosh II, the
amount of additional memory Persuasion requires depends on the
mode your monitor is operating in :

Mode

1 bit

4 bit

8 bit

32 bit

Requires an additional

40K

155K

310K

1,2MB

If your system does not have sufficient memory for transition effects
to work, the slides in your slide show will be displayed one at a time .
If transition effects are not operating and you are not running under
MultiFinder, try reducing the complexity of your presentation (e .g ., by
deleting graphics) . If you are running under MultiFinder, increasing the
amount of memory allocated to Persuasion may enable transition ef-
fects to operate .

Note : If you have an automatic slide show running and the Caps Lock
key is down, the transition effects will be disabled .



File
New Folder

	

N
Open

	

#.0

Close W

Get Into

	

.

	

~€I
Duplicate

	

D

Page Setup . . .
Print Directory . . .

To increase the MultiFinder memory allocation :

1 . Close the presentation and quit Persuasion .

2 . Select the Persuasion application icon, and then choose "Get Info" from

the File menu .

Increasing the number for "Current size (K)" increases the amount of
memory allocated to Persuasion under MultiFinder .

3 . Add the memory required for transition effects (from the previous infor-

mation) to the amount of memory required for the application, and then

change the value in the "Application Memory Size (K)" text box to the

new amount .

4 . Close the window and restart Persuasion .

Automatic launch
You can save your slide show settings with the presentation, and then,
at the Finder level (the desktop), you can select one or more Persuasion
presentations and run them directly in the slide show . Launching di-
rectly into the slide show saves you from opening the presentation,
opening the "Slide show" dialog box, making your settings, and
finally starting the slide show .
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•

	

To prepare a presentation for automatic launch into slide show :

1 . Open the presentation, and then choose "Slide show . . ." from the

File menu .

Slide show

Show : (a) All C) Current

( From 1

	

to 9

Options :

	

Full screen

	

Continuous cycle

Start Persuasion in slide show

Slide advance : ® Automatic

Delay between slides :

Delay between layers :

Default transition effects :

First layer :

Other layers :

Z

1

Glitter across

OK

Save k

C) Manual

seconds

seconds

Blinds down

t
Cancel

2 . In the "Slide show" dialog box, select the settings that will determine how

your slide show runs .

For more information on slide show settings, see "Using the slide
show to preview your presentation" at the beginning of this chapter .
For information on setting transition effects, see "Setting transition
effects" earlier in this section .

3 . Check "Start Persuasion in slide show," and then click "Save ."

When you quit Persuasion and then double-click the icon for this
presentation, the slide show begins automatically .

If you save several presentations with the "Start Persuasion in slide
show" option checked, you can have Persuasion automatically go
through each slide show in sequence . The presentations will open in
the order that you selected them on the desktop if you are viewing by
icon. If you are viewing the presentations by name, they will open in
the order they appear. Be sure you select multiple files by holding
down the Shift key and clicking ; selecting multiple presentations
by dragging a selection rectangle around their icons causes them to
launch in an unpredictable order . Each presentation will use what-
ever "Slide advance" option ("Automatic" or "Manual") you set for
that presentation when you saved it .



If the first presentation was saved with the "Start Persuasion in slide
show" option checked, all the selected presentations on the desktop
will open automatically into slide show . If all the selected present-
ations were set to repeat the slide show continuously, Persuasion
will go through each slide show in sequence, then repeat the
last one continuously .

The only way you can automatically launch a presentation is by double-
clicking its file from the desktop . If you use the "Open . . ." command to
open a file that was saved to "Start Persuasion in slide show" as de-
scribed above, the presentation does not launch into the slide show,
but opens as any other file to the view in which it was last saved .

Running a slide show
Persuasion gives you several different ways to control your slide show
using keyboard commands and mouse clicks .

The following table shows keyboard and mouse commands that you
can use while running a slide show . Note that you can use any of the
keystrokes listed to accomplish the same action . You may be familiar
with some of these keystrokes and similar resulting actions from using
other popular programs, such as HyperCard, Microsoft PowerPoint, or
the Kodak DataShow . The third column lists the action that will occur
if you hold down the Shift key while using the keystrokes listed in the
first column .
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Keystroke Result Result of Shift + keystroke

Down arrow Backward by a layer . Backward to end of slide .

Right arrow

N

Command +3

Single click

Up arrow Forward by a slide . Forward by a layer .

Left arrow
P
Delete
Command + 2
Double-click

Command + H Last layer of first slide . First layer of first slide .

Command + 1

Command + left arrow

Command + 4 Last layer of last slide . First layer of last slide .

Command + right arrow

Slide number followed by Return Go to last layer of selected slide . Go to first layer of selected slide .

(accent grave key) Back to the slide on-screen before (same result)
going to a particular slide .

Space Pause or continue the auto-advance (same result)
Triple-click feature . Any other slide command

also continues after a pause .

Toggles mouse cursor on and off . Gives same result .
Toggles between automatic
and manual slide advance .

B Toggles blank screen on and off. (same result)

(comma)

(period) Toggles screen to black and back . (same result)

- (hyphen) Exit from slide show . (same result)



Jumping to a particular slide
One of the most useful features in the preceding table is the one that
takes you to a particular slide by typing its number and pressing Return .
When you go to a slide directly, the slide is displayed in its entirety
(without builds) . However, if you type its slide number and then hold
down the Shift key + Return, Persuasion displays only the first layer
of the selected slide .

The specified slide is created by Persuasion off-screen, so there is a
pause before the slide is displayed. When the slide is displayed, the
"First layer" transition effect is used .

After you go to a particular slide, that slide becomes the current context
for moving backward and forward . But the" key (accent grave) goes
back to the last slide displayed before you jumped to a particular slide .

Quitting the slide show
Pressing Command + . (period) stops the current slide show . If you
have launched only a single presentation, using this command will
return you to Persuasion . If you have launched multiple slide shows,
using this command will stop the current slide show and proceed to the
next. If you are already in the last of the slide shows, using this com-
mand will stop the slide show and exit to the Finder . If you have
launched multiple slide shows, you must go to the Finder to return
to Persuasion .

Command + Q stops the slide show and quits Persuasion .
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Appendix A: Default Settings

Whenever you open any presentation or AutoTemplate, Persuasion
starts with the menu and dialog box settings (presentation defaults)
last saved with that document . When you choose "New" to start a new
presentation, Persuasion opens with whatever was last saved in the
"Persuasion Prefs" file . ("Persuasion Prefs" contains the default
AutoTemplate you selected during installation.) You can press Shift
while choosing "New" to override whatever is in "Persuasion Prefs"
and open an empty presentation with Persuasion's initial application
defaults .

Appendix A lists these initial application default settings. The infor-
mation is divided into four sections : Menus, Views, Dialog boxes,
and Placeholders . International English and Canadian English settings
appear in parentheses following the U .S . settings . (This list also serves
as a checklist of settings you can save with individual presentations or
AutoTemplates .)

Menus
GA98, Ari3C>""gYd61.'.~A~"9i&.7P47tW'Sah'd :15 :~.^yy{;pji', f ,

	

. . .~ 4c,Y^s.73a:d5 v ;?L+'A.. "r : .`~1s~esG7~(Ydi

	

FSe.Cd7aN4'~',Yf ?.°'

	

.$iia~i f

Text menu (Outside of placeholders)

Item

	

Default setting

Font

Text size

Text style

Text color

Text alignment

	

Left

Line spacing

	

100%

Paragraph spacing

	

100%

Bullet marks

	

Off

Show text ruler

	

Off

Helvetica in text block, Geneva in outline

12 point

Plain

Black
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Chart menu

Item

Chart format

Overlay format

Overlay series

Grid/Tick options :
Value axis

	

tick marks

Scale

Plot range maximum

Plot range minimum

Show depth

Show axis

Show plot frame

Show legend

Show value labels

Effect menu

Item

Line style

Line pattern

Shadow

Fill pattern

Fill color

Default setting

Column

None

1

Grid/Tick options :

	

Show major grid and outside
Category axis

	

tick marks

Rows are . . .

	

Categories

Value axis number format

	

General

Decimal places

	

0 (General)

Commas

	

Off

Negative value format

	

-123

Label options

	

Determined by data

Show major grid and outside

Linear

Auto (determined by data)

Auto (determined by data)

Off

On

On

On

Off

Default setting

1 point, vertical and horizontal

Solid black

White

None

White



Effect menu, continued

Item

Line color

Shadow color

Fill background

Line background

Master menu

Item

Orientation

Slide background pattern

	

None

Slide background Color 1

	

Black

Slide background Color 2

	

White

Views

Outline view

Item

Master

Slide

Slides, Notes, and Master views

Item

Layer

Default setting

Black

Black

White

White

Default setting

Wide

Default setting

Master 1

Slide 1

Default setting

Orientation

	

Wide

Magnification

	

Fit in window

Master Master 1

Layer 1

Ignore (background)

	

Off (i .e ., background will print and export)
when printing or exporting
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._

	

'

Slide show

Item

Show

Options

Slide advance

	

Automatic

Transition effect,

	

None
first layer

Transition effect,

	

None
other layers

Delay between slides

Delay between layers

Dialog boxes

Print dialog box (LaserWriter)

Item

Copies

Pages

Cover page

Paper source

Print

Proof print

Background fill

Current selection

Headers

Footers

Visible items only

Level icons

Default setting

All

Continuous cycle

2 seconds

1 second

Default setting

1

All

No

Paper cassette

Outline, Notes, Slides, Handouts, Builds

Off

Off

On

Off

On



Page setup dialog box

Item

Paper

LaserWriter)

Default setting

US Letter (A4, Letter)

Reduce or Enlarge

	

100%

Orientation

	

Tall

Font Substitution

	

On

Text Smoothing

	

On

Graphics Smoothing

	

On

Faster Bitmap Printing

Slides per handout page

	

4

Fractional character spacing On

On

Presentation setup dialog box

Item

	

Default setting

Slide shape

	

Overhead

Outline margins

	

Conform to size of monitor
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Placeholders

Default setting

Precision pointer

Off

On

On

Off

Off

Small

0.125 down, 0 .125 right (3mm, 3mm)

Word processing

Off

On



Title placeholder, continued

Item

Heading level indent

Tabs

Anchor content position

Subtitle placeholder

Item

Font

Text size

Text style

Text color

Text alignment

Line spacing

Paragraph spacing

Bullet marks

Show text rulers

Text style

Text color

Text alignment

Line spacing

Paragraph spacing

Bullet marks

Show text rulers

Default setting

0 inch

1 .0 inch (20mm)

Center, center

Default setting

Helvetica

24 point

Plain

Black

Centered

100%

100%

Off

Off

Default setting

Helvetica

24 point, levels 1 and 2 ;18 point, levels
3 and 4 ;14 point, levels 5 and 6

Bold, level 1 ; Plain, levels 2 through 6

Black

Left

100%

120%

On

On

Body text placeho der

Item

Font

Text size
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Body text placeholder, continued

Item

	

Default setting

Heading level indent

	

0 inch

Tabs

Anchor content position

	

Center, Center

Chart placeholder

Item

Number of categories

	

1

Numberof series

	

3

Table placeholder

Item

Numberof rows

	

4

Numberof columns

	

4

Organization chart placeholder

Item

Numberof levels

	

3

Numberof boxes

	

5

0.5 inch (10mm)

Default setting

Default setting

Default setting

Lowest level

	

Separate boxes

Anchor content position

	

Center, Center



Appendix B: Command Summary

Outline styles . . .
Define formats . . . I

Other . . .

This appendix supersedes Appendix B in the Aldus Persuasion 1 .0
User Manual . Commands that are new or changed in Persuasion 2.0
are printed in color .

Persuasion has two types of menus, not all of which are available in
all views :

•

	

Pull-down menus at the top of the window, including the Apple,
File, Edit, View, Text, Outline, Chart, Draw, Effect, Master, and
Sorter menus

I File Edit tile w TeHt Chart Draw Effect Master
Outline

/Slide 1
Notes 1
Slide sorter

Slide master

	

1
Notes master
Handout master

Go to master 1

Layer 1

•

	

Pop-up menus at the bottom of the windo ncluding the Notes,
Slide, Layer, Background, Transition ., and Master menus

If a command is dimmed in a menu, it cannot be selected . Choosing a
command that is followed by an ellipsis ( . . .) opens a dialog box that
displays additional options. Choosing a command with an arrowhead
to its right displays a submenu that lists further options .
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Text
Font
Size

	

1 D
Style

	

1 fl0
Color

	

1 fl2
Alignment

	

1
1141

Apply format

	

1

Teet format . . .
Line spacing . . . X30

Bullet marks 9d

Show teet ruler
Reapply style B€ .8 d0

Moue left

	

~(
Moue right

	

8B]
00



About Persuasion . . .
Help . . .
Windows

	

1

Alarm Clock
Calculator

c Chooser
Control Panels
Key Caps

a9 Scrapbook

File
New

	

8~N
Open . . .

	

0
Close
Data sheet

Save
Save as . . .
Revert

Import . . .
AutoTemplates . . .
En port . . .

Page setup . . .
Print . . .

	

P
Slide show . . .
Preferences . . .

Quit

	

o

1
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Pull-down menus (main menu bar)

Apple menu (all views)

Command

About Persuasion . . .

What it does

Shows the version, release date, and copyright
notices for your copy of Persuasion, as well as the
program's serial number and the user name that

you specified during the installation process .

Help . . .

	

Opens Persuasion's context-sensitive online
reference system of information about commands
and procedures .

Windows

	

Lets you move among open Persuasion
documents .

File menu (all views)

Command

New

	

Opens a new presentation using settings stored in

"Persuasion Prefs ."

What it does

Open . . .

	

Opens an existing Persuasion document .

Close

	

Removes the current presentation from the screen .

Data sheet

	

Opens Persuasion's own data sheet or an external
text or WKS file .

Save

	

Saves any changes made since you last saved .

Save as . . .

	

Lets you save a presentation under a new name
or location, as an AutoTem plate, or as an
interchange file .

Revert

	

Reverts to the last-saved version of the file, dis-
carding changes made since the last save .

Import . . .

	

Copies text, graphics, spreadsheet data, or an
entire presentation from another program .

AutoTemplates . . .

	

Imports slide masters, background masters, the
notes master, defined text formats, colors, and
chart formats from an existing AutoTemplate or
other Persuasion presentation .

Export . . .

	

Saves your outline, slides, or data sheet in a file
format other programs can use .



Edit
Undo

	

Z
. . . . . . . . . . . . .. . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . .. . . .

Cut R
Copy C
Paste U
Clear

Select all

	

~BR
Duplicate

	

BBD

Editions

	

1

Find/Change . . . ~€5
Find again ~K6
Change ?
Change then find ~B8
Spelling . . .

	

9

Insert

	

8B1
Delete

	

K

Page setup . . .

	

Specifies the size and shape of slides, and sets

page and print specifications for your presentation .

Print . . .

	

Prints all or part of your presentation as specified

in the "Print" dialog box .

Sets options, including default transition effects,

for viewing an on-screen version of your presenta-

tion, and runs the slide show .

Sets options specific to a presentation, including

default slide master, drawing options, and shadow

offset .

Ends your Persuasion session and returns you to

the Macintosh desktop .

Slide show . . .

Preferences . . .

Quit

k]f.II

	

E'

	

:01

Edit menu (all views)

Command

Undo

Paste

What it does

Reverses the last action, including the last Undo .

Cut

	

Deletes selected items and moves them to the

Clipboard .

Copy

	

Copies selected items to the Clipboard,

original items in the document .

eaving the

Clear

Select all Selects all objects on the current slide, master,

or notes page if the pointer tool is selected, or

selects the objects created with the selected tool .

Places a copy of the Clipboard contents into a

document .

Deletes selected items from the document without

moving them to the Clipboard .

Duplicate

	

Copies selected items and pastes them slightly

offset from the originals ; contents in the Clipboard

are not affected .

Editions A System 7 .0 feature that lets you share a slide

with other applications or other Persuasion pre-

sentations by designating a slide as a published

edition . This command also lets you insert and

update information from edition files in EPS or

PICT format that have been published by other

applications .
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Edit
Undo

.. . . .. . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . .. . . .. . . . . . . . . . . .. . . .
Cut
Copy
Paste

	

U
Clear

Select all

	

R
Duplicate

	

8BD

Editions

	

1

Find/Change . . . 5
Find again 8Ei6
Change 8~7
Change then find 8&8
Spelling . . .

	

8~9

Insert

	

8B1
Delete

	

8€K

Uiew
Outline

'Slide 1
Notes 1
Slide sorter

Slide master

	

1
Notes master
Handout master

Go to slide

	

1
Go to master 1
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Find/Change . . .

	

Locates specified text in your outline, slides, and

notes, to replace it with other text you specify .

Find again

	

Searches for the next occurrence of the most
recently entered text in the "Find/Change"
dialog box .

Change

	

Replaces selected text with the text most recently
entered in the "Change to" box in the "Find/
Change" dialog box .

Change then find

	

Replaces selected text with the most recently
entered text in the "Change to" box in the "Find/

Change" dialog box and continues the search .

Spelling . . .

	

Compares words in all or part of a presentation

to words in Persuasion's main dictionary or
supplementary dictionary .

Insert

	

Creates a new row or column next to the selected
row or column in the data sheet .

Delete

	

Removes the contents of a selected row or column
from the data sheet .

View menu (all views)

Command

	

Takes you to

Outline

	

The Outline view of your presentation

Slide X

	

The slide you selected

Notes X

	

The notes page you selected

Slide sorter

	

Slide Sorter view

Slide master

	

The slide master or background master assigned
to the selected slide

Notes master

	

The Notes Master view

Handout master

	

The Handout Master view

Go to slide

	

An existing slide, or creates a new one

Go to master

	

An existing slide master or background master,
or creates a new one



Taut format . . . ~T
line spacing . . .
Bullet marks
Show tent ruler

Outline styles . . .
Define formats . . .

Text menu (all views)

Command

Font

Size

Style

Color

What it does

Changes the font of selected text .

Changes the size of selected text .

Changes the type style of selected text .

Changes the color of selected text .

Alignment

	

Applies one of four text alignments to paragraphs :
Align left, Align center, Align right, or Justify .*

Apply format

	

Applies a named set of text attributes to selected
text, as defined with the "Define formats . . ."
command .

Text format . . .

	

Creates and names a set of text attributes (font,
size, style, and color) that you can apply to text .

Line spacing . . .

	

Specifies the amount of space between lines of
text and paragraphs .*

Bullet marks

	

Displays typographic characters (as specified with
the "Define bullet marks . . ." command on the
Master menu) in front of the first line of each
paragraph of a selected text block .*

Show text ruler

	

Displays a ruler that shows tabs and indents for
selected text blocks .

Reapply style

	

Applies the text style defined with the "Outline
styles . . ." command to the selected headings .

Move left

	

Raises the heading level of selected text in Outline
or Slide view (shortcut : Command + ] ) .

Move right

	

Lowers the heading level of selected text in Outline
or Slide view (shortcut : Command + [ ) .

Outline styles . . .

	

Creates and edits text styles for outline headings .

Define formats . . . Renames, creates, edits, and removes named text
formats for slides, notes, and handouts . You can
apply defined formats to text by using the "Apply
format" command .

*Not applicable in Outline view .
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Terrt

Font

	

1
Size

	

1
Style

	

1
Color

	

1
Alignment

	

1
Rpply format

	

1

Reapply style ~.8

Moue left ~[
Moue right ]



Outline

Set heeding as
Promote subheads

New heading H
New heading left ~€I_
New heading right ~BR
Add notes M
Remove notes

Hide body text
Hide notes
Auto subtitles

Expand all
[Hpand subs
Enpand selection

	

€E
Collapse all
Show subs only
Collapse selection

	

K

284 ∎ Aldus Persuasion User Manual

Outline menu (Outline view)

Command

Set heading as

Promote subheads

New heading

New heading left

New heading right

Add notes

Remove notes

Hide body text

Hide notes

Auto subtitles

Expand all

Expand subs

Expand selection

What it does

Makes the selected heading a holder of slides,

a subtitle, body text, or a slide title .

Moves all subheads for the selected heading up

one level .

Inserts a new heading at the same level as the
currently selected heading in the outline .

Inserts a new heading one level higher than the
currently selected heading in the outline .

Inserts a new heading one level lower than the

currently selected heading in the outline .

Adds a main notes icon and a notes text icon
immediately subordinate to the selected slide title .

Removes all notes headings from the selected
slide titles .

Turns off the display of all body text headings in
the entire outline .

Turns off the display of all notes text headings in
the entire outline .

If the slide master has a subtitle placeholder,
automatically makes any headings created imme-
diately below the slide title heading (or its notes
icons, if it has notes) into a subtitle .

Displays all subordinate headings in the entire
outline at every level (shortcut : Option + double-
click the topmost heading in the outline) .

For the selected headings, displays all subordinate
headings at every level (shortcut : Option + double-
click the icon for a heading) .

Displays all immediately subordinate headings
of the selected slides, leaving all deeper levels of

subhead collapsed or displayed as they were when
the selected heading was collapsed (shortcut :
Double-click the icon for the heading) .



['hart

Chart format
Overlay format . . .

lives
Numbers
Symbols

Show depth
Show axis
Show plot frame
Show legend
Show value labels

Get data
Get external data
Redraw chart

Define formats . . .

Collapse all Hides all subheadings in the outline, displaying

only first-level headings (shortcut : Command +
double-click topmost heading in the outline) .

Show subs only

	

Displays only the immediately subordinate head-
ings of the selected headings, hiding all deeper
levels of subheads . This works regardless of
whether the selected headings are fully collapsed
or fully expanded . (shortcut : Command + double-
click the icon for a heading) .

Collapse selection

Chart menu (Slide view, Slide Master view)

Command

Numbers

Symbols

Show depth

Show axis

Show plot frame

Hides the subheadings of the selected headings
(shortcut: Double-click the icon for the heading) .

What it does

Chart format

	

Specifies the format of a chart or table, chosen
from a submenu .

Overlay format . . .

	

Specifies the number of data series to plot on the

overlay chart, and specifies the format for the
overlay chart, chosen from a submenu .

Axes

	

Changes the format of chart axes . A submenu
displays specific format options .

Changes the numbers format for charts .

Changes the marker symbol used to plot data on
line, scatter, and high-low charts .

When checked, displays charts and tables with a

three-dimensional effect .

When checked, displays the axes and grid lines

of a chart .

When checked, displays lines marking the top and
right boundaries of a chart's plot range .

Show legend

	

When checked, displays the legend for a chart .

Show value labels

	

When checked, displays value labels on a chart .

Get data

	

Opens the data sheet and selects the data plotted
in the selected chart or table (you can choose this
command to edit imported data used to plot a
chart or table) .
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Uraw

Actual size

	

1
,Fit in window

	

[U

Send 1
Rotate/Flip 1
Center on slide

	

1

Group 8~G
Ungroup U
Regroup

	

~BR

Align objects . . . :BI
Align to grid

	

H
Grid snap on

	

Y
. . . . . . . .. . . . . . . . . . . . . . . . . . . .. . . . .. . . . . . . . . . . . . . . .. . . .

Reshape arc
Round corners . : .
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Get external data

	

Opens the external text or WKS file that contains
the data you used to plot the selected chart
or table .

Redraw chart Fine-tunes a resized chart by drawing it again, or
regroups a chart without saving changes made to
the chart while it was ungrouped .

Define formats . . .

Command

Actual size

Fit in window

Draw menu (Slide view, Notes view, all Master views)

Send

Rotate/Flip Moves objects clockwise or counterclockwise in
90° increments, and inverts objects vertically or
horizontally .

Center on slide

Group

	

Joins selected objects so they are treated as

one unit .

Ungroup

Regroup

	

Undoes the most recent "Ungroup" command .

Align objects . . .

	

Lines up selected objects in relation to each other,
either vertically, horizontally, or both .

Align to grid

	

Lines up selected objects with the horizontal and
vertical lines of the invisible grid .

Saves the formatting of an enhanced chart or

table, so you can apply the format to other charts
by using the "Chart format" command .

What it does

Shows objects at the size they will print .

Shows the entire slide or slide master on
the screen .

Moves selected objects forward or backward in a
stack of overlapping objects on the same layer .

Positions selected parts at the vertical or horizon-

tal center of the slide .

Selects the individual objects of a chart, PICT
graphic, or grouped selection .

Grid snap on

	

When checked, aligns newly drawn objects with

the invisible grid created by the minor divisions on
the rulers .



Round corners . . .

Reshape arc/poly

	

If an arc is selected, lets you change the angle

of the arc by moving handles on either end of the
line ; if a polygon is selected, lets you reshape the
polygon by moving handles or lines and adding or
removing points .

Lets you control the width and height of corners
on objects drawn with the square-corner, round-
corner, and ellipse tools .

Command

Line style

Effect menu (Slide view, Notes view, all Master views)

Specifies

The thickness and type of horizontal and vertical
lines or borders

Line pattern

	

The pattern used in a line or border

Fill pattern

	

The pattern used to fill an object

Shadow

	

The pattern used to fill shadows

Line color

	

The color of a line or border

Fill color

	

The color used to fill an object

Shadow color

	

The color used to fill shadows

Line background

Fill background

Set colors . . .

Define colors . . .

The color of text and of graphic attributes

Colors you want to add, rename, or remove from
the color palette, or colors you want to edit on the
color grid

The color of a line's background (the white area
of nonsolid line patterns in the "Line pattern"
submenu)

The color of the fill background (the white
area of nonsolid fill patterns in the "Fill pattern"
submenu)
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Effect
line style 1
Line pattern 1
Fill pattern 1
Shadow 1

Line color 1
Fill color 1
Shadow color 1
Line background 1
Fill background 1

Set colors . . .
Define colors . . .



Master
Odd title
Odd subtitle
Add body tent
Odd chart . . .
Odd table . . .
Odd org . chart . . .
Odd page number . . .
Odd slide copy
Odd notes tent

Anchor placeholder . . .
Build layers . . .
Slide background fill . . .
Tall orientation

Re-create from slide . . .
Define bullet marks . . .
Define masters . . .
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Master menu

Command

Add title

Add subtitle

Add slide copy

Add notes text

Add body text

	

Adds a text placeholder to a slide master .

Add chart . . .

	

Adds a chart placeholder to a slide master .

Add table . . .

	

Adds a table placeholder to a slide master .

Add org . chart . . .

	

Adds an organization chart placeholder to a slide
master .

Add page number . . .

	

Adds a page number placeholder to a slide master
or to a notes master .

Anchor placeholder . . .

	

Specifies the direction in which titles, body text,
and organization charts flow into their
place holders .

Build layers . . .

	

Specifies whether levels of outline text, data
on charts, or levels of an organization chart are

displayed all at once or in stages during a
slide show .

Slide background fill . . .

Slide master, Notes master)

What it does

Adds a slide title placeholder to a slide master or

to a notes master .

Adds a subtitle placeholder to a slide master .

Adds a placeholder for miniatures of your slides to

the Notes master .

Adds a placeholder for notes text to the Notes

master .

Adds a pattern, color, or blend of colors to fill the
slide master .

Tall orientation

	

Sets up a slide master that is taller than it is wide .

Re-create from slide . . .

Define bullet marks . . .

Re-creates an existing slide master using elements
from a slide as a model .

Specifies the typographic characters that intro-
duce each heading level of slide text .

Define masters . . .

	

Lets you name or rename or remove an existing
slide master or create a new slide master .



Sorter
/Normal size
66% normal
33% normal
20% normal

[Hack 0 white

New

Go to slide

Set. . . I

2
3

1	o ,:r dr-, . iriq 1- '4 er I

Sorter menu (Slide Sorter view)

Command

	

Displays the slide miniatures

Normal size

	

In the standard slide sorter size

66% normal

33% normal

20% normal

Black & white

Pop-up menus (lower menu bar)
The pop-up menus also serve as status indicators. The text you see in
the menu bar changes to indicate the number of the slide, note, or layer
selected, as well as the name of the selected or assigned slide master .

Slide menu (Outline view, Slide view, Slide Sorter view)

Command

New

Slide X

Layer menu (Slide view)

Command

At 66% of their normal slide sorter size

At 33% of their normal slide sorter size

At 20% of their normal slide sorter size

In black and white so you can more quickly sort
slides or reassign masters

What it does

Creates a slide based on the default slide master .

Displays that slide .

What it does

Set . . .

	

Lets you specify the current drawing layer, and
specify which layers are active and visible .

Layer X

	

Specifies the current drawing layer, or assigns

selected objects to that layer .

Appendix B: Command Summary • 289



New . . .
Nevi background. . .

Background
Title
Text 1
Text 2
Graphic 1
Org Chart
Graphic 2

I:, r , f, .. 'hde rii3_f,Pr

Gallery . . .

None
Background

,Title
Teet 1
Tent 2
Graphic 1
Org Chart
Graphic 2

H__1]ri rii .it.?

	

ltd'

None
Beckgraund

Assign background master to slide master
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Go to master menu

Command

New . . .

New background . . .

Background X

Master X

Command

Gallery . . .

None

Background X

Master X

Command

None

Master view)

What it does

Creates a slide master .

Creates a background master .

Displays that background master.

Displays that slide master .

Master menu (Outline view, Slide view, Slide Sorter view)

What it does

Lets you view a miniature of each slide master and
apply one to the selected slides .

Leaves the selected slides without a master as-
signed to them .

Assigns only the background master to the se-
lected slide, so that no placeholders are available .

Background menu (Master view)

What it does

Assigns that master to the selected slides .

Leaves the selected master without a background
master assigned to it .

Background X

	

Assigns that background master to the selected
slide master .



A=_ qr trar1itior1 effect_ to _lid .

Go to rnite_

Wipe left
Wipe right
Wipe up
Wipe down
To center
Open curtain
Close curtain
Blinds down
Blinds right
Glitter right
Glitter down
Glitter across
Dissolve
Random
None

Lagers. . .
'Default

Transition menu (Slide Sorter view, Outline view)

Command

Effect name

Layers . . .

Default

Notes menu (Notes view

Command

	

What it does

Notes X

What it does

Assigns a transition effect to the selected slides .

Assigns one transition effect to the first layer and
a second transition effect to subsequent layers of
the selected slide .

Displays that note .

Applies the default global effect specified in the
"Slide show" dialog box to the slides .

Note : In the Notes Master and Handout Master views, a box in the
lower menu bar says "Notes Master" or "Handout," respectively,
to indicate which view you're in .
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Glossary

Active layer • Any drawing layer with contents you can select, as defined
using "Set . . ." from the Layer pop-up menu . See also Current layer,
Drawing layer, Visible layer .

Alignment (objects) • How objects line up . Selected objects can align
with the grid (choose "Align to grid") or with each other (choose
"Align objects . . ."). Objects automatically align to the grid when
"Grid snap on" is checked .

Alignment (text) • How text lines up in a text block : left (flush left,
ragged right), right (flush right, ragged left), centered (ragged on both
left and right sides), or justified (flush on both left and right sides) .

Anchor (placeholder) • Used to specify the directions in which titles,
subtitles, body text, and organization charts flow into their placehold-
ers . See also Placeholder .

Apple color picker . A color wheel available on the Macintosh II that
is used to edit the 40 custom colors in Persuasion's color grid .

Arc tool • The tool you use to draw arcs in any direction .

AutoTemplate • A set of slide masters providing a common design for
slides in a presentation .

Background master • A slide master that can be used as a backdrop for
other masters .

Balloon help • A System 7 .0 feature in which descriptive text appears
in balloons that pop up as you point to portions of the screen . You can
turn balloon help on or off with the "Show Balloons" and "Hide Bal-
loons" commands on the Help menu .

Body text • Text from the outline that appears on slides formatted by a
body text placeholder. See also Placeholder, Text block .

Category • The classification of a value in a chart . For example, in a
chart plotting a store's monthly sales volume, the months are the cat-
egories . See also Data series .

Category axis • The axis on which categories of each data series are
plotted . By default the category axis is the horizontal axis on all charts
except bar charts . See also Value axis .
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Clipboard • A place where Persuasion temporarily stores the text, graph-
ics, or a group selection you last cut or copied . (The Clipboard is a
feature common to all Macintosh applications .)

Color grid • Persuasion's arrangement of 200 colors, 160 of which are
fixed. You can change the other 40 colors. You can use the color grid
to apply colors or to customize the color palette . See also Color palette .

Color palette • A collection of frequently used colors, chosen from the
color grid, that you can apply from a submenu or pop-up menu . See
also Color grid .

Color scheme • A set of compatible colors applied consistently through-
out a presentation .

Current layer • The selected layer, as indicated in the left number of the
Layer pop-up menu on the lower menu bar . See also Active layer,
Drawing layer, Visible layer .

Data point • A point on a chart where a particular value is plotted . For
example, on a chart that shows the monthly sales of three stores, the
point that shows the July sales of store A is one data point .

Data series • All the data points for a particular category in a chart . For
example, on a chart that plots the monthly sales of three stores for one
year, the points indicating sales for store A belong to one data series .

Data sheet • A Persuasion window containing rows and columns similar
to those on a spreadsheet . It is used for entering or importing data that
can then be plotted to a chart or table .

Default • A current setting . Persuasion uses three levels of defaults :
tool-level (text and drawing attributes set for a selected tool),
presentation-level (settings saved with a presentation), and
application-level (settings applied to new presentations) . See
also Persuasion Prefs .

Default slide master • The slide master that is automatically assigned to
new slides in a presentation .

Desktop • The topmost level of your computer filing system . The desk-
top shows all the disks and volumes that are active on your Macintosh .
In System 7 .0, the "Open . . ." and "Save as . . ." dialog boxes have a
Desktop button, and "Desktop" appears on the drop-down list at the
top of the directory box .



0

,Q.

Diagonal-line tool • The tool you use to draw lines at any angle .

Drawing layer . One of up to 30 planes within a slide, onto which you
can place text and graphics . Layers can appear cumulatively during a
slide show . See also Active layer, Current layer, Visible layer .

Driver • A program used to run peripheral devices, such as printers,
film recorders, and slide processors, which you select with the Choosey
desk accessory .

Edition • A file containing material that can be inserted into other docu-
ments and updated whenever the original material changes . See also
Publisher, Subscriber .

Ellipse tool • The tool you use to draw circles or ovals .

Encapsulated PostScript (EPS) format • A format for a file written in the
PostScript language that has all the information necessary to print the
file on a PostScript device . See also Import, Export, Graphic .

Export • To save Persuasion outlines or slides in a file format that other
software applications can use . Outlines can be saved as text-only, Acta,
or MORE files. Slides can be saved as PICT, Scrapbook, or Slide Show
files . See also Import.

Fill background • The color that shows through a patterned fill . The fill
background color corresponds to the white areas of the pattern shown
in the fill palettes . See also Slide background .

Fill color • The color that is used to fill an object . The fill color corre-
sponds to the black areas of the pattern shown in the fill palettes .

Fill pattern • The pattern that is used to shade the area inside an object .

Film recorder • An output device used to photograph slides onto
35mm film .

Font • A complete set of characters for one typeface ; for example,
Helvetica .

Freeform tool • The tool you use to create any freeform shape .

Frame • See Plot frame .
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Graduated fill • A fill in which one color smoothly blends into another
color . See also Radial fill .

Graphic • Any line or shape created using Persuasion's drawing tools,
or any PICT, PICT II, or EPS document imported into your presenta-
tion from another application . See also Encapsulated PostScript
(EPS) format .

Grid • A series of invisible horizontal and vertical lines spaced accord-
ing to the minor divisions on the rulers and used to align objects . On
charts, the major and minor divisions on the axes . See also Grid lines .

Grid lines • On charts, solid and dotted lines extending from major and
minor divisions on an axis across the plot area . See also Grid .

Grid snap on • An automatic alignment of objects to the grid while you
manipulate or create objects . See also Grid, Grid lines .

Group • To combine selected objects into a unit so you can act on it as a
whole . See also Regroup, Ungroup .

Handouts • Pages containing slide miniatures for distribution to your
audience. Handouts are linked to the Handout master and can include
text, graphics, and up to six miniatures per page . See also Master
views .

Heading level • The position or rank of a heading in relation to other
headings in the outline . See also Subheading .

Holder of slides • An area in the outline used to label a group of slides
(like the label of a slide carousel) or to make comments . The text in the
holder of slides prints in the outline but not on slides .

Import • To bring data, outline text, and graphics created in other appli-
cations into a presentation . See also Export .

Interchange File format • A file format that allows you to transfer presen-
tations from Persuasion for the Macintosh to the Persuasion for Win-
dows. You can choose to save a presentation in Interchange File format
in the "Save as . . ." dialog box .

Keyboard shortcuts • A key combination or key and mouse combination
that you can use to perform certain tasks without selecting commands
from menus. The Aldus Persuasion AutoTemplate Guide lists most of
the Aldus Persuasion shortcuts .



Label • Text in a chart that identifies a part of the chart . Category
labels are written under the category axis ; series labels are written
in the legend .

Layer . See Active layer, Current layer, Drawing layer, Visible layer .

Level • See Heading level .

Line background • The color that shows through a patterned line or the
patterned border of an object . The line background color corresponds to
the white areas of the pattern shown in the line pattern palette . See also
Slide background .

Line color • A color that is used to shade a line or the border of an
object . The line color corresponds to the black areas of the pattern
shown in the line pattern palette .

Line pattern • The pattern that is used to shade a line or the border of
an object .

Line style 'The thickness of a line or the border of an object . Line style
can also be a single- or double-headed arrow .

Lower menu bar • The row of pop-up menus that appears at the bottom
of the presentation window in most views .

Magnifying glass icon • The icon in the toolbox that you can click to
increase the magnification of a slide up to 400% . See also Reduction
glass icon .

Major grid 'The chart grid lines that extend the major divisions of the
value and category axes across the plot area .

Master slide • See Slide master .

Master views • The three views (Slide Master view, Notes Master view,
and Handout Master view) in which you design the appearance of
slides, notes, and handouts . See also Handouts, Notes, Slide master .

Menu bar • The row of menu names that appears at the top of the
presentation window .

Minor grid • The chart grid lines that extend the minor divisions of the
value and category axes across the plot area .
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Notes page • A page containing a slide miniature, slide title, text, and
graphics that you can refer to during your presentation . Each slide has
a speaker notes page formatted by the Notes master.

Orientation • The relationship of slides, outlines, notes, and handouts
to the page: tall, where the pages are taller than they are wide, or wide,
where the pages are wider than they are tall .

Outline view • The view in which you type or import the text for your
slides . See also Heading level, Subheading .

Page break • The non-printing dotted lines that appear on slides to show
the separate pages your printer will produce to create a single enlarged
slide .

Page setup • A command on the File menu used to specify printer-spe-
cific options for producing your presentation and presentation-specific
options for slide shape, outline margins, and number of slide miniatures
per handout page .

Perpendicular-line tool • The tool you use to draw straight horizontal and
vertical lines .

Persuasion Prefs • A presentation, stored in the System Folder or Persua-
sion folder, whose settings are applied as defaults to all new presenta-
tions . See also Default.

PICT • A graphics format that Persuasion can import, edit, and export .
Exported Persuasion graphics created on a Macintosh Plus or SE are
PICT format graphics .

PICT II • A graphics format that Persuasion can import and export. Ex-
ported Persuasion graphics created on a Macintosh II are PICT II for-
mat graphics .

Placeholder • An object used on slide masters that reserves a place for
titles, subtitles, text, tables, charts, page numbers, or organization charts
on slides. Placeholders also contain formatting instructions, such as text
attributes . See also Anchor (placeholder) .



R

Plot • To create a chart or table from selected data in the data sheet .

Plot frame • The border around the graphics area of a chart .

Plot range • The range of numbers on the value axis . The data values
may be less than or greater than the plot range . For example, on a bar
chart with a plot range of 0% to 100%, a bar representing a value of
200% appears twice as tall as the value axis . See also Value axis .

Pointer tool • The tool used most often to select and manipulate text and
graphics . See also Precision pointer .

Pointing hand • The shape that the pointer assumes when you drag head-
ings to another position in the outline .

Polygon tool • The tool you use to draw many-sided shapes .

Precision pointer . A pointer with a crosshair at its tip . You can set the
pointer type in the "Preferences" dialog box . See also Pointer tool .

Preferences • A command on the File menu that you can use to control
the default slide master, type of pointer, ruler options, and text and
object shadow offsets .

Presentation Interchange Format (PRIF) • See Interchange File format .

Presentation setup • See Page setup .

Publisher . Text, data, or graphics that you publish in a special file
called an edition, which can be subscribed to by other documents and
updated when the originating file changes . This is a System 7 .0 feature .
See also Edition, Subscriber.

Radial fill • A fill pattern with concentric circles of graduated colors
or intensities . See also Graduated fill .

Range • See Plot range .
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Reduction glass icon • The icon in the toolbox that you can click to
reduce the magnification of a slide to one-fourth the size of "Fit in
window." See also Magnifying glass icon .

Regroup • To reinstate a previously defined group . You do not need
to select objects to regroup them . See also Group, Ungroup .

Round-corner tool • The tool that draws squares and rectangles with
round corners .

Ruler lines • Non-printing horizontal and vertical lines extending from
the major divisions in the rulers .

Rulers • The measuring tools that display increments in the current unit
of measure on the left and top sides of windows in most views . The
ruler settings can be customized in the "Preferences" dialog box . See
also Grid snap on, Text ruler.

Scale • On a chart, the series of numbered spaces marked by lines
or tick marks .

Scrapbook • A Macintosh desk accessory in which you can store text
and graphics you use frequently .

Shadow offset • The vertical and horizontal distance that shadows
are cast from text and graphics . You can set the shadow offset in
the "Preferences" dialog box .

Slide background • The pattern and color applied to the entire area of a
slide master . Objects appear on top of the slide background . See also
Fill background, Line background .

Slide copy • The slide miniature that appears on note pages and
on handouts .

Slide master • A model for slides containing the elements you want
repeated on those slides, such as placeholders that format information
from the outline or data sheet, background design, or other text and
graphic objects . See also AutoTemplate .

Slide show • To display slides in sequence on the Macintosh screen .

Slide Sorter view • The Persuasion view that displays miniatures of your
slides. You can rearrange and assign masters to slides in this view .



Slide title • Outline text that appears on slides and on notes pages as a
title, as formatted by the title placeholder on slide masters and the slide
title placeholder on the notes master . Setting a heading as a slide title in
the outline creates a new slide . See also Placeholder .

Slide view • The Persuasion view that displays representations of your
actual slides or overhead . You can add text and graphics directly to a
slide while in Slide view .

Speaker notes • See Notes .

Square-corner tool • The tool you use to draw squares or rectangles with
square corners .

Subheading • A heading indented below another heading on the outline .
See also Heading level .

Subordinate heading • See Subheading .

Subscriber • Inserted text, data, or graphics that can be updated when the
originating file changes . To create a subscriber, you open an edition file
in the "Subscribe to" dialog box . This is a System 7 .0 feature . See also
Edition, Publisher .

Subselection • A part or a group of parts that you select in an object by
double-clicking or triple-clicking (for example, the bars in a chart) .

Symbol 'The marker that is used to indicate a data point on a line chart,
scatter chart, or high-low chart . Symbols can be changed through the
"Symbols" submenu on the Chart menu .

Target chart • The chart that will be replotted with selected information
in the data sheet or will be used to format a new chart .

Text block • An object consisting of text created with the text tool .

Text format • A collection of text specifications (font, size, style, and
color) that can be saved, named, and applied to text in your presenta-
tion with the "Define formats . . ." and "Apply format" commands from
the Text menu .

Text ruler • A ruler that displays with selected text blocks when the
"Show text rulers" command is checked . You can use the text rulers
to set indents and tabs .
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Text tool • The tool you use to start a new text block and, within an
existing text block, to position an insertion point or select text .

Tick mark • On a chart, the lines placed at regular intervals on an axis to
show the major divisions of the axis scale . Tick marks can be hidden or
displayed.

Transition effect • The way in which a new slide or layer appears on
the screen during a slide show .

Ungroup • To select the individual parts of a chart or imported PICT
graphic, or to reverse a previous "Group" command . See also Group,
Regroup .

Value axis • The axis on a chart that plots the data values . By default,
the value axis is the vertical axis in most charts . See also Category axis .

Visible layer • Any drawing layer that can be seen . A visible layer can be
active or inactive . See also Active layer, Current layer, Drawing layer .

WKS • An external worksheet file format that Persuasion can import
to the data sheet . See also Data sheet .
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Index

3-D charts 167,285
"20% normal" command 61, 289

Adding (Continued)
placeholders 77-78,

Applying
attributes 283

"33% normal" command 61, 289
35mm slides

output devices 250
producing 254-256

215-226,288-291
shadows to objects 125
slide

masters to AutoTemplates

background masters 207
colors

automatically 190-191
by default 190-191

"66% normal" command 61, 289

A

"About Persuasion . . ." command 280
Acta 2 .01 file format 42
Active layer 120, 293

205, 231 from color grid 185
from working set 183-184
to background masters 211
to imported black-and-white
graphics 197

to line patterns 122
to radial/graduated fills 189

miniatures to notes master 240
number placeholder to slide
master 226

speaker notes 284
special effects to charts 223
text

"Actual size" command 91, 286
"Add body text" command 218, 288
"Add chart . . ." command

to slide masters 229
to slides 76

"Adjust graphics" dialog box 19,

to text 186-187
to text shadows 188

defined
221, 223, 288

"Add . . ." command 216
"Add notes" command 40, 284

233, 255 chart formats 223
text formats 86

font/color to bullets 219
Adjusting graphics 18
"Align objects . . ." command

"Add notes text" command 240, 288
"Add org . chart . . ." command

114,286
"Align objects" dialog box 115

patterns to background master 211
special effects to lines 121-122

225, 288 "Align to grid" command styles to speaker notes 66
"Add page number . . ." command 114, 116, 286 text

226, 288
"Add pie placeholder" dialog box 221
"Add slide copy" command 240, 288

Aligning
defined 293
multiple objects to grid 116

attributes 80-84
formats 84-86

transition effects 60, 260-262
"Add subtitle" command 217, 288
"Add table . . ." command 223, 288
"Add title" command 216, 240, 288

objects 112-117, 286, 293
text 293
text in charts 173

Arc 89, 287
Arc tool 89, 293
Area chart 130, 134

Adding
background masters 212
colors to working set 194
data to data sheet cell 152

to grid 115-116, 286 Arrow icons 155
Arrow keys 27,148
Arrowheads 121, 279
Art of Persuasion folder 92

"Alignment" command 82, 283
Anchor 44, 288
"Anchor placeholder . . ." command

graphics
to handouts 242

228, 240, 288 ASCII file format, importing 42,143
Aspect ratio 19, 257Anchoring placeholders 227-228, 240,

to slide masters 229 288, 293 Assign master to slide menu 58,
headers/footers to handouts 249
independent text blocks to slides

Appending imported masters 233-234
Apple color picker 191, 195, 293

74, 290
Assigning

78-79
imported masters to current
presentation 233-234

Apple LQ ImageWriter II 251
Apple menu 280
Application defaults 22, 28-29,

masters . See Slide master : assigning
objects to layers 118-120
transition effects 291

notes to outline 39-40 271-277 Attributes
organization charts 59-60 "Apply format" command 86, 283 applying 283

automatically assigning to slide
elements 238



Attributes (Continued)
chart attributes 138
layer attributes, changing
119-120

specifying object attributes 88
text attributes, changing 80-84
text tool attributes, resetting 30
tool attributes 22

"Auto subtitles" command 38, 284
Automatically

applying colors to objects
190-191

assigning attributes to slide
elements 238

launching slide show 246,
263-265

updating the subscriber 104
wrapping text 79

AutoTemplate
adding slide masters to 205, 231
chart format, defining 129
color AutoTemplates,
choosing 180, 181

creating 202-229
creating slide masters in 205
deciding purpose of 203
default 16, 271
defined 15, 202, 293
guide 180
importing

AutoTemplates 280
masters from other
AutoTemplates 232-234

modifying 230-237
naming 204-205
opening copy of 205
Persuasion AutoTemplates 230
reformatting 17-19
saving presentation as 20, 21,
204, 280

setting up new AutoTemplate
204-205

starting presentations from 15-16
"AutoTemplates . . ." command

232, 280
"Axes" command 160, 285
Axis

category axis 160, 162,293
displaying 167, 285
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Axis (Continued)
format, changing 285
switching 159
value axis 160, 162, 302

B

Backdrop, slide 212
Background

colors 183
consistent background for slide 207
creating on slides 207
fill background 124, 287, 295
fills 25, 213, 252
line background 287, 297
line pattern background 122
masters

adding 212
appending 234
applying 207
color, applying 211
defined 210
designing 210-213
displaying 290
modifying 211-212
no background on master 207
number of 210
orientation of 208, 212, 213
patterns, applying 211
removing 207
replacing 234
smooth backgrounds,
displaying 213

switching to 212
slide background 300
solid/patterned backgrounds 208

Background menu 290
"Background" slide master 207
"Background X" command 290
Balloon help 293
Bar chart

example 132
slide layering effects 174
usage 130,132

"Black & white" command 289
Black-and-white

imported PICT graphics, applying
color to 197

Black and white (Continued)
monitors 98, 178, 179
overheads 250
printer 179

"Blinds down" transition effect 258
"Blinds right" transition effect 258
Body text

adding to slides 76
defined 293
hiding 284
icon 38
placeholders 218, 277-278

"Bold" type style 81
Brightness, color 179, 196
"Build layers . . ." command 238, 288
Builds 252
Bullet

changing 219
color of 219
defined 288
defining 219
deleting 220
displaying 84, 220, 283
ford, changing 219
hiding 84, 220
not governed by text ruler 88
turning off display of 220

Bullet mark . See Bullet
"Bullet marks" command

84.220.283

C

Callous 76
Canadian English version 7-9, 271
Cancelling

publisher 103
selection 94
subscriber 104

Caps Lock key, disables transition
effects 262

Category
axis 140, 160, 162, 293
defined 293
label 140, 142
number of 221

"Category axis number"
dialog box 165

Cell . See Data sheet



"Center on slide" command
114, 116, 286

Centering objects on slides 114,
116, 286

"Change" command 282
"Change then find" command 282
Changing words 67-68
Chart . See also Object

3-D effects 167, 285
area chart 130, 134
attributes, determined by
placeholder 138

axes . See Axis
bar chart

example 132
slide layering effects 174
usage 130,132

callouts 76
categories . See Category
column chart

example 133
usage 130,133

combining two charts 130
consistency among slides 137, 138
creating 130-147
custom charts 147
data series 160
data sheet . See Data sheet
data values, displaying 167
defined 129
defined chart formats 137
depth, showing 167, 285
duplicating 106
enhancing 168-174

changing 157, 159
choosing 131
defined by AutoTemplates 129
defined chart formats 137
defining formats 147
importing from other
AutoTemplates 232

Chart (Continued)
formats (Continued)

incorrect format chosen 140
predefining 137
removing from "Chart format"
submenu 147

replacing in current
presentation 233-234

frame, displaying 161
graduated fill, applying 173
grid lines 160,161,167
high-low chart 130,135,166
identifying data for specific
chart 149

importing formats from
AutoTemplates 232

independent charts 138,140
labels

changing 223
editing on the slide 157-158
numbers, affect of 163
option definition 160
placement of 221
setting options 163
troubleshooting 159
value labels 167

layering, special effect 174
legend 140, 167, 285
line attributes, applying 171
line chart 130, 134, 166
locating from its data 150
modifying charts 99, 157-167
moving 169
number format, changing

moving slice of 169
subselecting slices 95
troubleshooting 140
usage 130,131
without labels 163

placeholder 137, 221-223, 278
placeholder chart 138
placement on slide 138
plot frame 161,167

Chart (Continued)
plot range 160, 162
plotting 138-140, 153-156
positioning 223
redrawing 99, 71, 286
replotting 152
resizing 169-170
rotating 174
scatter charts 130, 135, 160, 162
selecting/subselecting 93, 168
series, number of 221
sizing 138, 169-170, 223
slide layering, special effect 174
spelling, checking 68
special effects 168, 171-174, 223
stacked bar chart 130, 132
stacked column chart 133
standard chart types 137
static charts . See herein
independent charts

styles, changing 223
subselecting 95
symbols 166, 285, 301
table chart 130,136
target chart 301
text, changing 223
three-dimensional charts 167, 281
tick marks 160, 161, 162, 167
types . See also herein formats

applying 223
changing 137, 159
choosing 131
combining 145
determined by
placeholder 138

determining 130
standard types 137

ungrouping/regrouping 99, 169
value axis 160, 162
value labels 285
viewing data sheet 140

"Chart format" command
139, 146, 159, 222, 285

"Chart format" submenu
136, 138,147

Chart menu 137, 272-278, 285-291
"Chart overlay" dialog box 145,146
Checkerboard effect 107
Checking spelling 68-69
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features, displaying/hiding 167
fill pattern, applying 172
flipping 174

164-165
numbers, formatting 285
organization chart 59-60, 95, 99

fonts, changing 223 overlay chart 130,145-146, 285
formats . See also herein types

applying 223
pie chart

example 131



Clipboard 100,294
"Close" command 21, 280
"Close curtain" transition effect 258
Closing presentations 21, 280
"Collapse all" command 55, 285
"Collapse selection" command

55, 285
Collapsing

outline headings 53-56
speaker notes in outline 40
text/notes/subtitle headings 55

CollinsUK .lex file 68
Color

Apple color picker 191, 195, 293
applying 183-191

automatically 190-191
by default 190-191
to background masters 211
to imported black-and-white
graphics 197

to objects on black-and-white
monitors 98

to radial/graduated fills 189
automatically applying to objects
190-191

AutoTemplates, choosing
180,181

background colors 183
brightness 179,192,196
bullet color 219
color wheel . See Apple color picker
cool colors 183
custom colors

defined 178
editing 195-197
replacing in current
presentation 233-234

customizing 191-196
defining 287
determining actual output
appearance 179
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defined 178, 294
selecting 25
standard color grid 25, 179
two-letter color codes 192

hue 192,196
importing from other
AutoTemplates 232

line color 122, 287, 297
Macintosh colors 98
monitor 178, 179
number of available colors 178
outline text color 65
overheads 250
palette, defined 294
presentation medium, effect on
printers 178
printing

limitations 178
technologies 250
to black-and-white
printers 179

QuickDraw colors 179
replacing in current
presentation 233

saturation 179, 196
scheme

choosing 180-182
creating 181-197
defined 294

shadows 125, 172, 188, 287
standard color grid . See herein grid
testing colors 255
text color 183, 186-187, 283, 287
tips for using 183
title placeholder, color of 216
variations between displayed and
printed colors 179

warm colors 183
wheel 196

widening 142
selecting in data sheet 151
table columns 170, 223

Column chart 130, 133
Combining chart types 145
Command . See also specific command

arrowheads with commands 279
dimmed commands 279
ellipses ( . . .) in command
names 279

menu commands
Apple menu commands 280
Assign master to slide menu
commands 290

Chart menu commands
285-291

Draw menu commands
286-291

Color (Continued)
working set

accessing colors outside of 183
adding colors to 194
applying colors from 183
customizing 181
default working set 181
defined 178,191
editing 192-197
Effect menu, accessing
from 181

importing from other
AutoTemplates 232

removing colors from 193
renaming colors in 193
replacing colors in 192,
233-234

sample box 194
"Set colors" dialog box,
accessing from 182

Text menu, accessing from 182

178
using color scheme with 180

"Color" command 81, 173, 182,
186, 283

"Colors" presentation file 179
Column

data sheet columns
creating 282
deleting 282

"Choose master elements" Color (Continued)
dialog box 235

Choosey desk accessory 15
Circle, drawing 90
"Clear" command 43, 46,100, 281

devices 179
editing custom colors 195-197
effective use of 180
fill colors 124, 189, 287, 295

Clearing . See also Deleting
tabs from text ruler 87

Clip art 92, 242

graphics 197, 287
grid

applying color from 185
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Dashed lines 107,121

Data

arranged in charts 130

contrasting data in charts 130

external data 286

identifying data of specific

chart 149

importing into data sheet 143

locating chart from 150

plotting

new charts from existing

data 153-154

using format of existing

adding data in cells 152

categories 160

cells, selecting 151

changing data in cells 152

columns

creating new columns 282

selecting 151

widening 142

copying data in 152

data series 145

defined 294

deleting

data in cells 152

rows/columns 282

editing data in 148,151-152

entering data 141-142

importing data into 141, 143

linked dynamically to slides 215

locating data in 148-150

moving data in 152

moving through 142, 148

opening 280, 285

rows 151, 221, 282

scroll bars in 148

selecting cells/columns/rows 151

temporary data sheet 144

toggle box 148

viewing while creating charts 140

working in 140-144
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Command (Continued)

menu commands (Continued)

Edit menu commands

Creating (Continued)

color schemes 181-182

data sheet rows/columns 282

distinctive presentations 201281-283

File menu commands 280-283

Layer menu commands

handouts 247, 249

layers 238

notes master 239-241

outline

subtitles 38

headings 37

overlay charts 145-146

presentation scripts from outline

53, 54

presentations 16, 22, 33, 58,

271, 289

289-291

Master menu commands

288-291

Notes menu command 291

Outline menu commands

284-291

Slide menu commands 289

Sorter menu commands

289-291

Text menu commands 283

Transition menu

commands 291

View menu commands

repetitive effects 107

slide builds 118

slide masters 205-209,

230-231, 290

282-283

summary of commands 279-291

unable to select commands 279

speaker notes 247-248

text formats 85-86
"Currency" number format 165

Currency symbol 9

Current layer 294

Curve, drawing 89

Custom

charts 147

colors

defined 178

described 191

editing 195-197

Command key 108
"Commas" number format

Company

logo 92

structure, showing with

Org chart 59

Complex slides, managing

Consistency among slides

165

118

137,138

Constraining lines to 45° angles

chart 155

Data point 166, 294

Data series 145, 160, 294

Data sheet

accessing data in 141

88, 89

Context-sensitive Help 5-7, 280

Converting

EPS graphics to PICT format 100

overheads to slides 255
"Copy" command 100, 152, 281

Copying . See also Duplicating

data in data sheet 152

effect on EPS graphics 100

objects 100

replacing in current

presentation 233-234

font

	

81sizes

presentations, customizing 201
rulers 112

working set, customizing 181
"Cut" command

defined 281

deleting

objects 100

presentations to floppy disks 256

Corners, controlling width/height

of 287

outline headings 46

outline text 43

moving data in data sheet 152
"Create publisher

. . ." command 101

Creating

AutoTemplates 202-229

backgrounds on slide masters 207

charts 130-147

Cutting and pasting . See also "Cut"

command; "Paste" command

in outline, results of 41

objects 100

outline headings 46



271-277
Persuasion's initial defaults,
obtaining 271

settings 28-29
AutoTemplate 16, 271
Canadian English default
settings 9, 271

colors, applying 190-191
defined 294
International English default
settings 9, 271

master slide . See herein slide master
"New" command, effect of 271
presentation defaults 22, 23-28,

78, 271
slide master 23, 56, 57, 63, 294
temporary text tool defaults 77
tool defaults 22, 29
transition effects 246, 260, 291
working set 181

"Default" command 291
Default slide master pop-up menu 23
"Define bullet marks . . ." command

84, 219, 220, 288
"Define bullet marks" dialog box 219
"Define colors . . ." command

181,192-195, 287
"Define colors" dialog box 192
"Define formats . . ." command 85, 147,

283, 286
"Define masters . . ." command

214, 288
"Define masters" dialog box 214
"Define text formats" dialog box 85
Defining
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data sheet rows/columns 282
edition files 103
outline

headings 46
text 37, 43

slides 46
tabs from text rulers 87
text formats 85-86

Demoting outline headings 37, 88
Deselecting outline headings 45
Designing background masters

210-213
Desktop 294
Desktop film recorder . See Film

recorder
Desktop presentations program 3
Diagonal-line tool 89, 295
Dialog box . See also specific

dialog box
International/Canadian English
differences in 9

Dictionary 68, 69
Dimmed commands 279
Direction keys . See Arrow keys
Displaying

axes 285
background masters 290
balloon help 293
bullets 84, 220, 283
chart

features 167
legend 285
plot frame 161

grid lines 285
layers 288
outline, all levels of 55
plot frame 285
ruler lines 113

Displaying (Continued)
rulers 24, 113
slide masters 290
smooth slide backgrounds 213
speaker notes 291
subordinate outline headings 284
text rulers 78, 283
work at actual size 91

"Dissolve" transition effect 258
Distribution network 59
Document . See File ; Presentation
Dot-matrix printer 251
Double-spaced lines 83
Drag-selecting 94
Draw menu 286-291
Drawing

arcs 89
circles 90
complex objects 118
curves 89
ellipses 89-90
freeform lines/shapes 90
layer 289, 295
lines 89
objects 88-90
Option key, effect on drawing 90
polygons 90
rectangles 89-90
Shift key, effect on drawing 88
Shift + Option keys, effect on
drawing 90

squares 90
Drawing layer 289, 295
Driver, defined 295
Dummy placeholder text 77
"Duplicate" command 106, 107, 281
Duplicating . See also Copying

EPS graphics 106
objects 106
power-duplicating 107

Dynamic link 99, 215

E

Edit menu 281-283
Editing . See also Modifying

background masters 211-212
chart

labels on the slide 157
placeholders 221

"Data sheet" command
140, 144, 280

Defining (Continued)
handout master 241-242

Data values 167
Date

adding to Handout master 242
adding to Notes master 241

"Decimal places" number format
Default

application defaults
defined 22

165

slide builds on masters 238-239
table formats 147
text formats 84-86

Delay between layers 239
"Delete" command 151, 282
Deleting . See also Removing

bullets 220
colors from working set 193-194

initial default settings data from data sheet cell 152

chart formats 147
color schemes
colors 287

180-182



Editing (Continued)
colors

custom colors 195-197
working set colors 192-194

data sheets 148,151-152
imported graphics, limitations
of 197

outline headings 43
Persuasion files 100
speaker notes 248
subscriber 105
table

data on the slide 157
placeholders 221

text
formats 85-86
on slides 79

title placeholder 216
Edition file 101-103, 295
"Editions" command 281
"Editions" submenu 101, 102,103
Effect menu 181, 272, 273, 287-291

data in data sheet 141-142
text in outlines 36-42

EPS
file format

converting to PICT format 100
defined 295
importing EPS files 92,
197, 250

EPS (Continued)
graphics

duplicating 106
unable to apply color to 183
printing 252

Exiting . See Quitting
"Expand all" command 55, 284
"Expand selection" command

55, 284
"Expand subs" command 56, 284
Expanding

outline headings 55-56
outlines 53
speaker notes in outline 40

"Export . . ." command 70, 280
Exporting

defined 295
outlines 70
slides 70

External data 286
External spreadsheet 141, 144

to charts 172
background 124, 252, 287, 295
color 124, 189, 287, 295
controlling precedence of multiple
fills 209

graduated fill 123, 296
patterns 123, 287, 295
radial fill 299

"Fill background" command
124, 181, 189, 287

"Fill color" command
124, 181, 189, 287

"Fill pattern" command 98,123,172,
189, 287

Film recorder defined 295
fill patterns, problems with 123
output device option 178
producing slides on 250, 254-255

"Find again" command 282
"Find/Change . . ." command 67, 282
Finding text 67-68, 282
"Fit in window" command 91, 286
"Fixed" number format 165
Flipping

charts vertically/horizontally 174
objects 100, 286

Floppy disk, copying to 256
Font

bullet font, changing 219
changing 283

in charts 173,223
in outlines 65, 66
title placeholder fonts 216

defined 295
sizing custom fonts 81

"Font" command 81, 173, 283
Footer

handout footers 249
outline footers 253

Formatting
chart numbers 285
instructions, contained in
placeholders 34

notes text placeholder 241
numbers in charts 164-165
outlines 64-66
paragraphs 86-88
presentations 201
slides 57, 74
speaker notes 247
subtitle placeholders 217
text on slides 80-88
text placeholders 218
title placeholders 216, 240

Formatting charts . See Chart: formats
Frame, chart 161
Freeform lines/shapes 90
Freeform tool 90, 295

Index ∎ 309

"Effect name" command 291
Element . See also Object

automatically assigning
attributes to 238

hiding on master slides 236
independent elements 235

F

Faster screen display 25
File . See also Presentation

closing 280
"Colors" presentation file 179

scaling 19
Ellipse, drawing 89-90
Ellipse tool 89, 295
Ellipsis ( . . .), in command names 279
Encapsulated PostScript . See EPS
Enhancing

charts 168-174

edition file 101-103, 295
opening 280
"Persuasion Prefs" file 28, 298
saving 280
transferring from Macintosh
to PC 296

File menu 280-283
graphics 120-125
organization charts 226

Enlarging view 91
Entering

Fill . See also Pattern
adding to title placeholder 216
applying

color to 189



"Gallery . . ." command 74, 75, 290
"General" number format 165
"Get data" command

140, 148, 149, 285
"Get external data" command

149, 286
"Glitter across" transition effect 258
"Glitter down" transition effect 258
"Glitter right" transition effect 258
Global transition effects 260
"Go to master" command

205, 211, 212, 231, 282
"Go to slide" command 282
"Go to slide master" command 212
Go to slide master menu 290
Graduated fill

applying
color 189
to charts 173

defined 296
smoother fills, obtaining 123

Graphic 1 slide master 137
Graphic 2 slide master 137
Graphics . See also Object

adding
to handouts 242
to slide masters 229

adjusting 18
background for slides 207
colors

applying automatically
190-191

setting 287
defined 296
enhancing 120-125
EPS graphics . See EPS
importing 92, 98, 197, 229
labels 76
PICT graphics . See PICT file
format; PICT II file format

representation of outline 60
selecting 93

Grayscale, printing 252
Grid

aligning to 115-116, 286
color grid . See Color ; grid
defined 296
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Grid (Continued)
invisible grid 112, 113
lines 160, 161, 167, 285, 296
major grid 297
minor grid 297
snapping objects to 113, 116,
286, 296

"Grid snap on" command
113,116, 286, 296

"Group" command 95, 97, 286
Grouping

defined 296
groups of objects 96
independent objects 97
nested groups 96
objects 96-99,119

H

Handout
adding graphics to 242
clip art in 242
creating 249
defined 241, 296
headers/footers 249
number of slide miniatures
per page 241

printing 251-253
purpose of 239
slide master 249

Handout master 241-242, 247,
249, 282

"Handout master" command
242, 249, 282

promoting headings 88
subordinate headings .
displaying 284

Help 4, 5-7, 280, 293
"Help . . ." command 5, 280
"Hide Balloons" command 293
"Hide body text" command 54, 284
"Hide notes" command 284
"Hide notes text" command 54
Hiding

balloon help 293
body text 284
bullets 84, 220
chart features 167
elements on master slides 236
notes 284
outline text 54
rulers/ruler lines 113
speaker notes 54
subheadings 285

High-low chart 130, 135, 166
Holder of slides 35, 296
HP DeskWriter Color Graphics 250
Hue 192,196

I

Icon
body text icon 38
darkened icon 53
holder of slides icon 35
location of 54
magnifying glass icon 297
main notes icon 35, 40, 41
notes text icon 35, 40, 41, 284
outline icons 35, 53, 61
Persuasion icon 13 .204

spreadsheet data 143
text 280

Handout Master view 282,
Header

handout headers 249
outline headers 253

Heading, outline
demoting headings 88
hiding subheadings 285
inserting headings 284
levels

defined 296

291 question mark icons 39
slide text icon 35
slide title icon 35
subtitle icon 35, 38
using to expand/collapse
outlines 53

mport . . ." command . See also
Importing

importing
graphics 92,197, 280

moving 283
setting 284

outlines 42
speaker notes 248



Imported graphics . See also Importing
black-and-white PICT graphics,
applying color to 197

editing limitations of 197
EPS graphics 252
modifying 98
ungrouping 98

Importing
AutoTemplates 280
chart formats from other
AutoTemplates 232

clip art 92, 242
data into data sheet 141, 143, 280
defined 280, 296
edition files 101
EPS files 92,197, 250
graphics 92, 197, 229
outlines 36, 42
PICT graphics . See PICT file
format; PICT II file format

slide masters from other
AutoTemplates 232-234

speaker notes 248
spreadsheet data 280
text 280
working set colors from other
AutoTemplates 232

In-house film recorder 254 . See also
Film recorder

Indent
adjusting in text ruler 88
levels, outline 33
markers 86
setting 86

Independent .
charts 138,140
elements

adding to handout master 242
adding to notes master 241

notes text 248
objects 97, 235, 236
text 76, 79
text blocks, adding to slides
78-79

Ink-jet printer 250
"Insert" command 151, 282
Inserting

data sheet rows/columns 282
new headings 284
outline text 43

Insertion point
adding notes to outline 40
arrow key setting 27
entering outline text 37
imported outline usage 42
moving outline units, use of 37
setting arrow keys 27

Interchange File Format 280, 296
International English version 7-9, 271
Invisible

grid 112,113
layer 120

"Italic" type style 81

K

Keyboard shortcuts
changing views 27
defined 296
insertion point movement 27
slide show shortcuts 265-266

L

Label
chart labels 221, 223
defined 297
graphic labels 76
speaker notes labels 248
value labels 285

"Label options" command 163
"Label options" dialog box 163
Landscape orientation . See "Wide"

orientation
LaserWriter 250
LaserWriter II SC 250
Layer

active layer 120, 293
applying transition effects to 260
assigning

objects to 118-120
transition effects to 291

attributes, changing 119-120
creating 238
current layer 294
displaying 288
drawing layer 289, 295
grouping objects on different
layers 119

Layer (Continued)
invisible layer 120
moving objects to different layers
118-119

setting delay between layers 239
slide layering charts 174
visible layer 120, 302

Layer pop-up menu 118, 289-291
"Layer X" command 289
"Layers . . ." command 291
Learning Persuasion 4
Legend

chart legend 140, 167, 285
moving 169

Level
organization chart levels 59
outline heading levels

changing heading levels 48-50
collapsing most levels 55
controlling number of 55
defined 296
displaying all levels 55
indenting 33
moving 283
setting 284

text levels 86
Line

arrowheads, adding 121
attributes, applying to charts/tables
171

background 122, 181, 287, 297
color 122, 287, 297
constraining to 45° angles 88, 89
dashed lines 107, 121
drawing 89
multiple-segment lines 90
non-printing ruler lines,
displaying 24

patterns 122, 287, 297
ruler lines 24,113, 300
spacing 82, 283
special effects, applying 121-122
style 121, 171, 287, 297
weight 121

"Line background" command
122, 181, 287

Line chart 130, 134, 166

Index ∎ 311



"Line color" command

122, 171, 181, 287
"Line pattern" command

98, 122, 171, 287
"Line spacing

. . ." command 82, 283
"Line spacing" dialog box 82

Link . See Dynamic link

Logo 92, 229

Lower menu bar 289, 297

M

Macintosh

colors on 98, 178

transferring files from/to PC 296

Magnifying glass icon 297

Magnifying slides 91

Magnifying tool 91

Main menu bar 280

Main notes icon 35, 40, 41

Major grid 297

Major grid lines 161

Managing complex slides 118

Manipulating objects 93-111

Manual control of subscriber 104

Master menu 273, 288-291

Master slide . See Slide master

Master views

default settings 273

defined 297

Handout Master view 282, 291

Notes Master view 282, 291

Slide Master view 282, 297

switching to 282
"Master X" command 290

Measurement system 112

Medium

changing 14

choosing 16, 17

deciding upon 178-179

options for 178

reformatting to desired

medium 17-19

Memory

insufficient memory for master

thumbnails 232

requirements for transition effects

262-263
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Menu

pop-up menus
Assign master to slide menu 58,

74, 290

Background menu 290

described 279, 289

Go to slide master menu 290

Layer menu 118, 289-291

Notes menu 291

Slide menu 289

Transition menu 291

pull-down menus

Apple menu 280

Chart menu 137, 272-278,

285-291

described 279

Draw menu 286-291

Edit menu 281-283

Effect menu 272, 273

File menu 280-283

Master menu 273, 288-291

Outline menu 284-291

Sorter menu 289-291

Text menu 271-278, 283

View menu 282-283

Menu bar

defined 297

lower menu bar 289, 297

main menu bar 280

Miniature slides

in Slide Sorter view 60, 289

on handouts 241, 247, 249

on notes master 240

on slide masters 232, 290

on speaker notes 247

Minor grid 297

Minor grid lines 161

Mirus FilmPrinter 250, 254

Modem, transmitting through 256

Modifier keys 90,108

Modifying . See also Editing

AutoTemplates 230-237

charts 99, 157-167

imported graphics 98

Monitor

black-and-white monitors 98,

178, 179

color monitors 178, 179

MORE 1 .0, 1 .1, or l .lc file format 42

"Move left" command 49, 86, 283

"Move right" command 49, 86, 283

Moving

among

Persuasion documents 280

Persuasion views 282

charts 169

data in data sheet 152

heading levels 283

objects

entire objects 96

in 90° increments 286

in stacking order 117

to different layers 118-119

vertically/horizontally 96

outline headings 37, 47-48

Shift key, effect of 96

subtitles to new positions 39

through

data sheet 142, 148

sets of plotted data 148

slide show 265-266

title placeholders 216

MultiFinder memory allocation 263

212, 290
"New" command

creating

new AutoTemplates 204

presentations based on default

16, 22, 271, 289

defined 280
"New

. . ." command

adding masters to

AutoTemplates 231

creating slide masters 290

N

Naming. See also Renaming

AutoTemplates 204-205

presentations 20-21

slide masters 288

text formats 85-86
"Negative values" number format

165

Nested

groups of objects 96

slide titles 38

slides 51-52
`New background

. . ." command



"New heading" command 40, 284
"New heading left" command 284
"New heading right" command 284
"New slide master" dialog box

213, 214
"None" command 290
"None" slide master option 206
"Normal size" command 61, 289
Notes . See Speaker notes
Notes master

adding independent elements
to 241

creating 239-241
described 239
replacing/appending 234
slide miniatures, adding 240

"Notes master" command 240, 282
Notes Master view 282, 291
Notes menu 291
Notes text icon 35, 40, 41, 284
Notes text placeholder 239, 241
Notes view, default settings 273, 282
"Notes X" command 282
Number

chart
formats, changing 164-165
formats, listing 165
label troubleshooting 163
numbers, changing format
of 285

of background masters per
presentation 210

of chart categories 221
of chart series 221

Object (Continued)
aligning 112-117, 286, 293
assigning to layers 118-120
centering objects on slides
114,116

colors
applying 183-191
custom color, effect on 195

complex objects, drawing 118
copying 100, 106
cutting 100
defined 73, 93
drawing 88-90
duplicating 106
freezing in relation to one
another 96

grouping 96-99,119
independent objects 97, 235, 236
manipulating 93-111
moving

entire objects 96
in 90° increments 286
to different layers 118-119

organizing objects on slides 112
overlapping 117
pasting 100
rearranging on slide master 257
regrouping 99
reshaping 108
rotating/flipping 100, 286
scaling 19
selecting 93-94, 281
shadow offset 26
sizing 108

"Open curtain" transition effect 258
"Open external" command 144
Opening

AutoTemplate, copy of 205
data sheets 280, 285
existing presentations 15, 22, 280
new presentations 280

Option key
effect on drawing 90
resizing, use of 108
view reduction usage 91

"Org Chart" command 60
Org Chart master 59
Organization chart

adding to slides 59-60
enhancing 226
placeholder

adding 225-226
default settings 278
maximum box size 224
maximum outer boundaries 224
resizing 226

subselecting 95
ungrouping 99

Organizing objects on slides 112
Orientation

background master orientation
212, 213

changing for background
masters 208

defined 298
slide master orientation 231
slide orientation 206, 213, 231, 288
"Tall" orientation 206, 213,

Index ∎ 313

of fill patterns available 123 snapping to grid 113 231, 288
of indent markers available 86 specifying attributes for 88 "Wide" orientation 206, 213, 231
of line patterns available 122 stacking order 117 "Other text size" dialog box 81
of placeholders per slide subselecting 93, 95 Outline
master 236 typing text inside objects 79 adding notes to 39-40

of slide miniatures per handout ungrouping objects 97, 286 collapsing
page 241 Offset headings 53-56

Numbering slides 226 controlling duplication offset 107 using icons 53
"Numbers" command 285 shadow offset 26,125, 300 cutting/pasting, results of 41

On-screen presentation deleting text 37, 43
0 output devices 250 demoting headings 37

producing 257-266 deselecting headings 45
Object . See also Element; Graphics ; Online Help . See Help displaying all levels of 55

Text Online slide show . See Slide show
adding shadows to 125 "Open . . ." command 15, 22, 280



Outline (Continued)
editing headings 43
entering 36-42
expanding headings 53, 55
exporting 70
formatting 64-66
graphic representation of 60
headers/footers, printing 253
headings

applying styles to 65
changing heading levels
48-50

changing heading type 50-52
collapsing 55-56
creating 37
cutting and pasting 46
deleting with subordinates 46
deleting without
subordinates 46

demoting 37, 88
deselecting 45
editing 43
expanding 55-56
hidings subheadings 285
inserting 284
levels . See herein levels
moving 37,47-48
promoting 37, 49, 88
relationships retained 47
selecting 44-45
subordinate headings,
displaying 284

subtitle heading 217
transforming into slides 33
types of 35

hiding text/speaker notes 54
hierarchy . See herein levels
holder of slides, outline heading 35
icons 35, 53, 61
importing 36, 42
indents, retained during
importing 42

inserting text 43
levels

changing heading levels
48-50

collapsing most levels 55
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Outline (Continued)
levels (Continued)

controlling number of 5
defined 296
displaying all levels 55
indenting 33
moving 283
setting 284

linked dynamically to slides 215
modifying 43-52
note, outline heading 35
organizing 53
placeholder text 35
predefined text styles 64
printing 64, 251-253
promoting headings 37, 49, 88
rearranging 53
selecting headings 44-45
slide text, heading 34, 35, 76
slide title, heading . See Slide: title
speaker notes .
See also Speaker notes
collapsing 55
expanding/collapsing 40
hiding 54
removing 40
text styling 64
working with 41

spelling, checking 68
subordinate headings, deleting 46
subtitle headings 35, 38, 54, 55
text

collapsing 55
color 65
deleting 37, 43
formatting 64-66
hiding 54
inserting 43
predefined styles 64
sizing 65, 66
styles, applying 64-66
typing 33

typing 33, 36-41
view . See Outline view

"Outline" command 282
Outline menu 284-291
"Outline styles . . ." command

64, 65, 66, 283
Outline type style 81

Outline view
adding notes in 39-40
assigning masters in 58-60, 290
creating presentations in 33
default settings 273
defined 298
described 33-35
entering text in 36
speaker notes

entering 33
working with 41

switching to 282
typing text in 33

Output device . See also Printer
choosing 15
color printing limitations 178
deciding upon 178-179
film recorder . See Film recorder
listing 250
options for 178
QuickDraw output device 81
selecting 204
service bureau . See Slide
service bureau

video projection screen 178
Overheads

black-and-white overheads 250
color overheads 250
converting to slides 255
printing 250-253
transparencies 178

Overlapping objects 117
Overlay chart 130, 145-146, 285
"Overlay format . . ." command

146, 285

P
Page

breaking pages 25, 298
numbers, slide 226
setup 16, 17, 204, 241, 281, 298

"Page setup . . ." command
creating new AutoTemplate 204
defined 281
defining handout master 241
default settings 275
medium, choosing 16, 17
reformatting
presentations/AutoTemplates 17



"Page setup" dialog box 204
Palette 294 . See also Color: grid
Paper size 9
Paragraph

formatting 86-88
spacing 82

"Paste" command
defined 281
importing color graphics 197
inserting outline text 43
pasting

data in data sheet 152
objects 100
outline headings 46

Pasting
data in data sheet 152
in outline, results of 41
objects 100
outline headings 46

Pattern . See also Fill
applying patterns to background
master 211

fill patterns 287
line patterns 122, 287, 297

PC, transferring files to/from 296
"Percent" number format 165
Perpendicular-line tool 89, 298
Persuasion

AutoTemplate guide 180
dictionary 68, 69
documentation set 4
icon 13,204
learning Persuasion 4
moving among Persuasion
documents 280

quitting 22, 267, 281
serial number 280
starting 13
version of 280

"Persuasion dictionaries" folder 68
"Persuasion Prefs" file 22, 28,

Pie chart
example 131
subselecting slices 95
trouble-shooting 140
usage 130, 131
without labels 163

Placeholder
adding 77-78, 215-226, 288-291
anchoring 227-228, 288, 293
body text placeholder 277-278
chart 138-140
chart placeholder 137, 278
defined 34, 215, 298
maximum number per slide
master 236

notes text placeholder 239
organization chart placeholder
60, 278

rearranging on slide master 257
slide copy placeholder 300
slide master placeholders 206
subtitle placeholders 38, 217, 277
table placeholder 278
text 76-77, 79
text placeholder 34
title placeholder 240, 276
types of 215

Placeholder chart 138-140
Placeholder text 76-77, 79
"Plain" type style 81
"Plot" button 154, 156

charts 138-140, 153-156
defined 299
from external spreadsheets 144

Point, data 166, 294
Pointer

pointing hand 47, 299
precision pointer 24

Pointer tool 93, 299
Pointing hand, pointer 47, 299
Polygon 90, 109-110, 287
Polygon tool 90, 299
Pop-up menu . See Menu
Portrait orientation . See "Tall"

orientation
Positioning chart placeholders 223

PostScript file to disk 255
Power-duplicating 107
Precision pointer 299
Predefined

chart formats 137
outline text styles 64

"Preferences . . ." command
default slide master, changing 57
defined 281,299
displaying

rulers/ruler lines 113
smooth background fills 213

presentation defaults, setting 23
shadow distance, controlling 188

"Preferences" dialog box
default settings 276
setting presentation defaults in 23

Presentation . See also File
changing medium 14
closing 21, 280
color presentations . See Color
copying to floppy disk 256
creating 16, 22, 33, 58, 271, 289
customized presentations 201
default settings 22, 23-28, 78, 271
distinctive presentations,
creating 201

formatting 201
medium . See Medium
naming 20-21
opening 280
previewing presentations 245-246
producing . See Printing ; Producing
presentations

reformatting 17-19
renaming 20-21
saving

existing presentations 21, 280
new presentations 20-21
presentations as AutoTemplates

20, 21, 204, 280
reverting to last-saved
presentation 19, 21

setting options for 281
setup . See Page : setup
starting presentations 14-19
transferring from Macintosh
to PC 296

transmitting via modem 256

Index ∎ 315

Plot frame, chart 161, 167, 285, 299
Plot range, chart
Plotting

160, 162, 299

271, 298
PICT file format

converting from EPS format 100
defined 298
importing 92
substituting rectangle for 25
ungrouping 98

PICT II file format 92,197, 298
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Presentation Interchange Format
(PRIF) 299

Producing presentations (Continued)
preparing for production 245-249

"Re-create from slide . . ." command
236, 288

Presentation script, creating 53, 54
"Presentation setup" dialog box 19,

previewing the presentation Re-creating masters from slides
235-237, 288245-246

249, 254, 275 support materials, producing Rectangle 89-90,108, 111
Presentation Technologies Montage 250-253 "Redraw chart" command 99, 171, 286

FR 1 250 "Promote subheads" command Redrawing charts 99, 171,286
Previewing 49, 284 Reducing view 91

presentations 245-246
slides with different masters 74

Promoting outline headings 37, 49, Reduction tool 91
Reformatting88, 284

"Print . . ." command 250, 251, 255, 281 "Proof print" option 179, 252 AutoTemplates 17-30
"Print" dialog box 250, 274
Printer . See also Output device ;

Printing
Apple LaserWriter Plus 250
black-and-white printer 179
color printer 178
dot-matrix printer 251
ink-jet printer 250

Printing . See also Producing
presentations

Proofing
presentations 251, 252
slides 91

Proportions, maintaining during

presentations 17-30
slides 74

"Regroup" command 99, 286
Regrouping

charts 169
defined 300
objects 99

"Remove notes" command 40, 284
Removing . See also Deleting

background master 207

resizing 108,169
Proximity/Merriam-Webster

Linguibase 9
Publish capability 101-105, 299
"Publisher options . . ." command

102, 103
color

limitations of 178
presentations to black-and-white
printers 179

technologies 250
EPS files 252
grayscales 252
handouts 251-253
outlines

Publishing slides as separate,
linked files 101

Pull-down menu . See Menu

a
Question mark icons 39
QuickDraw colors 179
QuickDraw output device 81, 250

chart formats from "Chart format"
submenu 147

colors from working set 193-194
slide masters 214-215
speaker notes from outline 40, 284

Renaming. See also Naming
colors in working set 193
presentations 20-21
slide masters 214-215

entire outlines 251-253
formatting prior to printing 64
headers/footers 253

overheads 250-253
PostScript file to disk 255-256
proof copies 251, 252
speaker notes 251-253
thermal transfer printing 250

Problems . See Troubleshooting
Producing presentations . See also

Printing
35mm slides, producing 254-256
creating

'`Quit" command 22, 281
Quitting

Persuasion 22, 267, 281
slide show 267

R

Radial fill 189, 299

Repetitive effects, creating 107
Replacing

chart formats 233-234
colors

in current presentation
233-234

in working set 192
masters 233-234
text 282
words 67-68

"Replot" button 152, 159
Replotting charts 152, 159
Repositioning chart placeholders 223

"Random" transition effect 258
Range

of text, selecting 79, 94
of visible layers 120
plot range 160, 162, 299

handouts 249
speaker notes 247-248

on-screen presentations,
producing 257-266

overheads, producing 250-253

Ratio, aspect . See Aspect ratio
"Reapply style" command 66, 283
Reapplying styles 66
Rearranging

objects on slide masters 257
slides 60-62

Resetting
tabs 87
text tool attributes 30

"Reshape arc" command 109



data sheet rows 221, 151, 282
table rows 223

"Rows are . . ." command 145
Ruler

aligning objects with 113
custom rulers 112
defined 112,300
displaying 24, 113
hiding 113
lines 24, 113,300
text ruler

adjusting indents in 88
clearing tabs from 87
defined 301
different from Persuasion
rulers 112

displaying 78, 283
setting tabs in 87

Running slide shows 245-246,
265-266

S
Sample box 65, 236
Saturation, color 179, 196

"Select fill color" dialog box 124
Selecting

cancelling selection 94
cells in data sheet 151
charts 168
drag-selecting 94
objects 93-94, 281
outline headings 44-45
output device 204
range of text 94
slides in Slide Sorter view 60
standard color grid 25
subselecting . See Subselecting
text 79, 93, 94

"Send" command 117, 286
Serial number 280
Series, number of 221
Series label 140
Service bureau 123, 178, 254
"Set colors . . ." command

182, 190, 195, 287
"Set colors" dialog box 182, 185
"Set . . ." command 119, 289
"Set heading as" command

changing heading levels 50-51

"Set heading as" command (Continued)
creating

nested slides 52
subtitles 38

setting heading levels 46, 48, 284
"Set layer visibility" dialog box 120
Setting

arrows keys 27
category axis format 162
chart label options 163
colors 287
heading levels 46, 48, 284
indents 86
presentation defaults for text 78
presentation options 281
publisher options 102
slide show options 281
subscriber options 103
tabs 86, 87
transition effects 257-262
value axis format 162

Setting up new AutoTemplates
204-205

Settings, default . See Default
Shadow

adding
to objects 125
to title placeholder 216

applying to tables 172
color 125, 172, 188, 287
distance . See herein offset
offset 26, 81,125,188, 300
patterned shadows 125
text shadow 26, 188
type style 81

"Shadow color" command 125, 172,
181, 188, 287

"Shadow" command 125, 172,
188, 287

Shaping
arcs 110
objects 108
polygons 109-110
slides 204, 257

Sharing slides with other
presentations 281

Shift key
effect on drawing 88
maintaining proportions during
resizing, use of 108

Index ∎ 317

"Reshape arc/poly" command 287
"Reshape poly" command 109
Reshaping

arcs 110,287
objects 108
polygons 109-110

"Save as . . ." command 20, 204, 280
"Save" command 20, 280
Saving

presentations
as AutoTemplates 20, 21,
204, 280

Resizing . See Sizing existing presentations 21, 280
Reversing actions 218, 281
"Revert" command 21, 280
Reverting to last-saved

presentation 21, 280
"Rotate/Flip" command 100, 174, 286
Rotating

new presentations 20-21
reverting to last-saved
presentation 19, 21

Scale 300
Scaling objects/text sizes 19
Scatter chart 130, 135, 160,162

charts vertically/horizontally 174 Scientific notation 165
objects 100, 286 "Scientific" number format 165

Scrapbook 300
Screen

display, speeding up 25
resolution, improving 250

"Round corners . . ." command
111,287

Round-corner tool 89
Rounding corners of rectangles/squares

111,287 Scroll bars, data sheet usage 148
Rows

as categories
as data series

160
160

Searching/replacing text 67-68, 282
"Select all" command 93-94, 281
"Select AutoTemplate" dialog box 232



Shift key (Continued)
moving objects, usage with 96
selecting multiple objects 93

Shift + Option keys, effect on
drawing 90

"Show axis" command 167, 285
"Show Balloons" command 293
"Show" button 150, 237
"Show depth" command 167, 285
"Show legend" command 167, 285
"Show plot frame" command

161, 167, 285
"Show subs only" command 56, 285
"Show text ruler" command 78, 86,

112,283
"Show thumbnail" command 232
"Show value labels" command

167, 285
Showing . See Displaying
Single-spaced lines 83
"Size" command 81,173, 283
Sizing

chart placeholders 223
charts 138,169-170, 223
fonts 81,283
imported masters 233
maintaining proportions during 108
organization chart placeholder 226
slides 17, 18, 19
text

chart text 173
outline text 65, 66
placeholders 218
selected text 81, 283

title placeholders 216, 240
Slide

35mm slides
output devices 250
producing 254-256

backdrop 212
background 207, 300 . See also
Background: masters

builds 118, 238-239
centering objects on 116
chart consistency among 137, 138
converting from overheads 255
copy placeholder 300
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Slide (Continued)
defined 7
deleting 46
editing text on 79
exporting 70
formatting 57, 74
height 255
layering 174,238
linked dynamically to outline/data
sheet 215

magnification, changing 91
managing complex slides 118
master . See Slide master
merging with other presenta-
tions 281

miniatures . See Miniature slides
nesting slides 51-52
number placeholder 226
numbering slides 226
organizing objects on 112
orientation 206, 213
placeholder text, adding 77-78
proofing 91
publishing as a separate, linked
file 101

rearranging
ideas on 47
slides 60-62

re-creating masters from 235-237
reformatting 74
selecting in Slide Sorter view 60
service bureaus . See Slide
service bureau

shaping 204, 255, 257
sharing with other presenta-
tions 281

show . See Slide show
sizing 17, 18, 19

"Slide background fill . . ." command
207, 209, 211, 288

Slide master
adding to AutoTemplates
205, 231

assigning
described 56-60
in Outline view 58-60, 290
in Slide Sorter view 60, 63, 290
in Slide view 74-75, 290

background 207,288
background masters

adding 212
appending 234
applying 207
changing orientation for 208
color, applying 211
defined 210
designing 210-213
displaying 290
modifying 211-212
number of 210
orientation 208, 212, 213
patterns, applying 211
replacing 234
removing 207
smooth backgrounds,
displaying 213

switching to 212
creating 205-209, 230-231,
288, 290

default slide master 23, 56, 57,
63, 294

defined 33, 201, 297
defining slide builds on 238-239
displaying 290
graphics, adding 229
handout master 241-242, 247,

spelling, checking 68 249, 282
subordinate slide titles 51
text 34, 35, 76

hiding elements on 236
importing

titles
adding to masters 288

from other AutoTemplates
232-234

defined 33, 35, 301 graphics to 229
in speaker notes 247
nested titles 38
subordinate titles 51

view. See Slide view
viewing multiple slides at once 60

maximum number of placeholders
allowed 236

miniature slides on 232, 290
naming 288
not assigning a master 290

width 255 notes master . See Notes master



Slide master (Continued)
Org Chart master 59
placeholders on 206
previewing slides with different
masters 74

rearranging objects on 257
re-creating from slides 235-237
removing 214-215
renaming 214-215
replacing in current presentation
233-234

slide number placeholder,
adding 226

speaker notes master . See Notes
master

text. See Text
thumbnail versions of 232

"Slide master" command 282
Slide Master view 282, 297
Slide menu 289-291
Slide number placeholder 226
Slide service bureau 123, 178, 254
Slide show

as output option 178
automatically launching
246, 263-265

default settings 274
defined 300
delay between slides/layers 246
displaying slides in continuous
loop 246

full-screen display 246
jumping to specified slides 267
keyboard shortcuts 265-266
manually launching 264
previewing presentation with
245-246

quitting 267
running 245-246, 265-266
setting options for 281
starting 245

"Slide show . . ." command
245, 260, 264, 281

"Slide show" dialog box 263
Slide sorter . See Slide Sorter view
"Slide sorter" command 61, 282
Slide Sorter view

assigning masters in 60, 63, 290
defined 60, 300
increasing number of slides in 61

Slide Sorter view (Continued)
miniature slides in 60, 289
rearranging slides in 60-62
selecting slides in 60
shortcut key 60
sizing miniature slides 289
switching to 60, 282

Slide title 35, 76, 288
Slide view

assigning slide masters in
74-75, 290

default settings 273
defined 301
displaying smooth background
fills in 213

enhancing presentations in 33
switching to 282
working in 73

"Slide X" command 282, 289
Snapping objects to grid 113
Sorter menu 289-291
Speaker notes

adding 39-40, 284
creating 247-248
defined 298
design 247
displaying 291
editing 248
entering in Outline view 33
expanding/collapsing 40
formatting 247
hiding 54, 284
importing 248
independent notes text 248
labels for slide miniatures 248
miniature slides in 247
notes master . See Notes master
outline text styling 64
printing 251-253
purpose of 239
removing 40, 284
repositioning items on notes
page 248

slide master 247
spelling, checking 68
styles, applying 66
text 247
viewing 247-248
working with in Outline view
35,41

Special effects
adding to charts 171-174, 223
applying to lines 121-122

Spell checking 68-69, 282
"Spelling . . ." command 68, 282
Spreadsheet . See also Data sheet

external spreadsheet 141, 144
Square 90,111
Square-corner tool 89, 301
Stacked bar chart 130,132
Stacked column chart 133
Stacking order 117
Standard chart types 137
Standard color grid 25, 179 . See also

Color: grid
Starting

Persuasion 13
presentations

from default AutoTemplate
14,16

from existing AutoTemplates
14,15-16

from scratch 14,16
without AutoTemplates 16

slide show 245
Static. See Independent
Style

applying to speaker notes 66
chart styles 223
line styles 121, 287, 297
reapplying 66
text styles

changing 283
identifying frequently used
attributes 84

in charts 173
title placeholders, styling 216
type styles, listing 81

"Style" command 81,173,188,188,283
Subordinate headings, displaying 284
Subscribe capability 101,

103-105, 301
"Subscribe to . . ." command 103
"Subscriber options . . ." command 104
Subscript 64, 81
Subselecting . See also Selecting

charts 168
defined 301
objects 93, 95
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Subtitle
adding

placeholders to slide
masters 288

to slides 76
creating 38
dragging to new position 39
heading 217
icon 38
placeholders 38, 217, 277, 288

Superscript 64, 81
Switching

between views 282
to background master 212

Symbols, chart
changing 166,285
defined 301

"Symbols" command 166, 285
System 6.0.5 3
System 7 .0

balloon help 293
edition file 101-103
publish capability 101-105, 299
subscribe capability 101,

103-105, 301

T

Tab
clearing from text rulers 87
key 86
resetting 87
setting 86, 87
tabbed indents, outline 42

Table
3-D tables 167
columns 170, 223
duplicating 106
editing data on the slide 157-158
example 136
formats, defining 147
graduated fill, applying 173
line attributes, applying 171
moving 169
number format, changing 164
placeholders 221 .223-224, 278
resizing 169-170
rows 223
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Table (Continued)
selecting/subselecting 168
shadows, applying 172
special effects 171
spelling, checking 68
three-dimensional tables 167
usage 130,136

"Tall" orientation 206, 213, 231, 288
"Tall orientation" command 213, 288
Target chart 301
Tektronix Color Image Printer 250
Temporary

data sheets 144
text tool defaults 77
tool defaults 30

Terminating . See Quitting
Testing colors 255
Text . See also Object

adding to slides 76, 299
aligning . See Aligning
attributes, changing 80-84
blocks . See Text block
body text . See Body text
chart text, modifying 173, 223
color 183,186-187, 283, 287
editing on slides 79
external text 286
finding/changing text 67-68, 282
formats 84-86, 301
formatting on slides 80-88
hiding 284
independent text 76, 235
indenting 86-88
jagged edges, minimizing 257
levels 86
menu . See Text menu
notes text 247
outline text

applying styles to 64-66
collapsing 55
color 65
deleting 37, 43
formatting 64-66
hiding 54
inserting 43
predefined styles 64
sizing 65, 66
typing 33

placeholder text 76-77

Text (Continued)
placeholders 34 .
See also Body text : placeholders

range of text, selecting 79, 94
rulers

adjusting indents in 88
clearing tabs from 87
defined 301
different from Persuasion
rulers 112

displaying 78, 283
setting tabs in 87

searching/replacing text 67-68, 282
selecting text 79, 93, 94
shadows 26, 188
sizing 19, 283
slide master text, adding 229
slide text 34, 35, 76
spelling, checking 68-69, 282
styles

identifying frequently used
attributes 84

reapplying 66
tool . See Text tool
type style, changing 283
typing

in Outline view 33
inside objects 79

wrapping 79
Text block

defined 301
duplicating 106
independent text blocks 78-79
pasting 100
width, changing 79

"Text format . . ." command 182,
186-188, 283

Text menu 80-84, 182,
271-278, 283

Text-only format . See ASCII file format
Text tool 30, 77-78, 93, 302
Thermal transfer printing 250
Three-dimensional charts 167, 285
Thumbnail versions of masters 232
Tick marks 112, 160-162, 167, 302
Time, adding to masters 241, 242



Title
adding

to handout master 242
to Notes master 241

placeholders
adding 216
default settings 276, 277
defined 34
formatting 216, 240
modifying 216
resizing 240

slide title . See Slide : title
"Title background" slide master 207
"Title" slide master 207
"To center" transition effect 258
Toggle box icon 148
Tool

arc tool 89, 293
attributes 22
defaults 22, 29
diagonal-line tool 89, 295
ellipse tool 89, 295
freeform tool 90, 295
magnifying tool 91
perpendicular-line tool 89, 298
pointer tool 93, 299
polygon tool 90, 299
reduction tool 91
round-corner tool 89
square-corner tool 89, 301
text tool 77, 78, 93, 302

Transferring presentations
from/to PC 296

Transition effect . See also specific
transition effect

applying
global effects 260
in Slide Sorter view 60
to individual slides 261
to layers 260

assigning 291
default effects 246, 260, 291
defined 257
memory requirements for
262-263

setting 257-262
troubleshooting 262

Transition pop-up menu 261, 291
Transmitting through modem 256

Transparency film 253
Troubleshooting

chart formats 140
chart labels 159,163
fill patterns, film recorder
imaging 123

screen resolution, improving 250
slide sizing 18, 19
transition effects 262

Turning off bullets in text
placeholder 220

Type styles, listing 81
Typing

outlines 36-41
text

directly on slides 76
in Outline view 33
inside objects 79

U

"Underline" type style 81
"Undo" command 218, 281
Undoing actions 218, 281
"Ungroup" command 97, 286
Ungrouping

charts 99,169
defined 302
imported graphics 98
objects 97, 286
organization charts 99

V

Value axis 160, 162, 165, 302
"Value axis format" dialog box 162
"Value axis number" dialog box 165
Value labels 167, 285
Video

display projector 250
production pad 250
projection screen 178

View
changing, keyboard shortcuts
for 27

enlarging 91
Master views . See Master views
moving among views 282
Notes view 273, 282
Outline view . See Outline view

View (Continued)
reducing 91
Slide view . See Slide view
switching between views 27, 282
zooming in/out 91

View menu 282-283
Viewing

slides 60
speaker notes 247-249

Visible layer 120, 302

W

Websterlex file 68
"Wide" orientation 206, 213, 231
"Windows" command 280
Windows Metafile format 92
"Wipe down" transition effect 258
"Wipe left" transition effect 258
"Wipe right" transition effect 258
"Wipe up" transition effect 258
.WKS file format 143, 302
Words

searching/replacing 67-68, 282
spelling, checking 68-69

Working set
accessing colors outside of 183
adding colors to 194
applying colors from 183
customizing 181
default working set 181
defined 178, 191
editing 192-197
Effect menu, accessing from 181
importing from other
AutoTemplates 232

removing colors from 193
renaming colors in 193
replacing colors in 192, 233-234
sample box 194
"Set colors" dialog box, accessing
from 182

Text menu, accessing from 182
using color scheme with 180

Wrapping text 79

z

Zooming in/out 91
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